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Chapter 1: Introduction

Overview

HOBOware software is used for launching, reading out, and plotting data from HOBO®
data loggers and wireless HOBOnodes.

HOBOware Pro combines fast, easy logger launch and readout functions with powerful
data plotting capabilities, making it easier than ever for users to analyze data recorded
with HOBO data loggers and HOBO wireless data nodes.

An intuitive, graphical user interface allows users to select data parameters to display,
format graphs, perform analysis, and save projects for future use. One-click export of
data to Microsoft® Excel® or other ASCII-compatible programs is also available.

See Introduction to HOBOware Pro (page 9).

HOBOware Lite is entry-level software for HOBO USB loggers, offering easy logger
launch, readout, and data plotting.

See Introduction to HOBOware Lite (page 14).

Getting Started

If you are using HOBO data loggers, follow the instructions in the Getting Started Guide
to install the software, connect your logger, launch, and readout data. You can expect to
be comfortable with HOBOware fundamentals within a few minutes.

If you are using HOBO wireless data nodes, see the Wireless Data Node Setup Guide.
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Documentation Map

Refer to the sections outlined below, depending on what hardware you are using.

All Users

e Installation

e Reference

Data Loggers

If you are using HOBO data loggers (such as the U14 or H12 series), refer to the
following sections:

e Working with HOBO Data Loggers
e Using HOBOware to Plot and Analyze Data

Wireless HOBOnodes
If you are using wireless HOBOnodes, refer to the following sections.
e Managing a HOBO Data Node Network

e Using HOBOware to Plot and Analyze Data

Other Hardware

Refer to the Other Hardware section if you are using a HOBO U30 Station, a HOBO
Shuttle, or FlexSmart Modules/Analog Sensor Ports.

Notes

e This documentation is for both HOBOware Pro and HOBOware Lite, for
Windows® or Macintoshe. Any differences between the functionality are noted.

e Screen captures of windows in this document are English versions. If you have a
version of HOBOware in another language, see the software for the translated
windows.
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Introduction to HOBOware Pro

Overview

HOBOware Pro combines fast, easy logger launch and readout functions with powerful
data plotting capabilities, making it easier than ever for users to analyze data recorded
with HOBO data loggers and HOBOnode Wireless Sensors.

An intuitive, graphical user interface allows users to select data parameters to display,
format graphs, perform analysis, and save projects for future use. One-click export of
data to Microsoft® Excel or other ASCII-compatible programs is also available.

HOBOware Pro incorporates valuable capabilities such as scaling data to sensor units
and saving graphs so they can be recalled and used in the future. HOBOware Pro also
provides 21 CFR Part 11 compliance.

Optional tools for real-time data readout, alarms, and post processing of data provide
users with even greater insight into their data.

HOBONnode Manager

HOBOnode Manager is a component of HOBOware that is used for configuring wireless
HOBOnodes.

Upgrading to HOBOware Pro

To upgrade from HOBOware Lite to HOBOware Pro, call 1-800-564-4377 and ask for
Onset Customer Service.

Getting Started

To get up and running quickly, follow the instructions in the Getting Started Guide to
install the software, connect your logger, launch, and read out data. You can expect to
be comfortable with HOBOware fundamentals within a few minutes.

If you are using HOBO Data Node Wireless Sensors, see the HOBO Wireless Data Node
Setup Guide.

Devices

HOBOware Pro is compatible with the following HOBO data loggers:

e HOBO U-Series loggers

e HOBO Weather Stations

e HOBO Micro Stations

e HOBO Energy Logger Systems

o HOBO U-Shuttle and Waterproof Shuttle
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HOBO FlexSmart Modules
HOBO Data Nodes (Wireless Sensors)

Basic Features

Easy device setup/launch

Graphing and analysis with ability to view multiple data files on one graph
Filters to extract key series information such as minimum/maximum values.
Save Project Changes

Import and Export ASCII text data

Export to BoxCar format

21 CFR Part 11 Conformance

Secure mode enables compliance with 21 CFR Part 11, ensuring that current data
files match actual data originally recorded by HOBO data loggers.

Check Logger Status and view current readings

-10 -
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New HOBOware Features

The following new features are available in HOBOware 3.1.0:

The ability to undo and redo changes made to the plot display, including
zooming, panning, crosshair placement, graph and axis properties modifications,
and more.

A shortcut for switching between default US and SI unit types with a new toolbar
icon.

Support for new sensors when launching select U12 series data loggers.
Support for 64-Bit Windows operating systems.

Enhancements to the web update service, which now lists details about any
available software updates directly in HOBOware.

There are also several new features available within HOBOnode Manager (available in
HOBOware Pro only). These include:

A HOBOnode Viewer webpage, where you can view plots and data from your
HOBO data node network in a browser.

Data delivery, which allows you to automatically send data from your HOBO data
node network to others via email or FTP, or save it to a computer or network
drive.

The ability to create new network deployments.

A new low battery alarm that will trip when the batteries are low in data nodes
and routers.

Several new viewing preferences for real-time plots, including a month view,
limits to the number of sensors or days of data to display, and alarm threshold
markers.

The ability to deselect the sensor type of an external sensor channel within a
data node.

A visual indication on the status bar in the main HOBOware window that the
receiver from your data node wireless network is connected or disconnected.

Automatic calculation of dew point when plotting or exporting data that has
temperature and humidity values.

Automatic detection of the presence of the CABLE-TEMP/RH sensor in
appropriate data nodes.

-11 -
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Advanced HOBOware Pro Features

Setup Assistant

When you open HOBOware Pro for the first time, you are greeted by the HOBOware

Setup Assistant, a series of windows to help you quickly change some key preference
settings for device types and serial ports, units of measurement, and data assistants.
See HOBOware Pro Setup Assistant for more information.

Data Analysis

Analysis features can be used to extract key information from logged data. You can
create new data series, which can be graphed or exported. You can also filter data over
user-specified intervals that can be in seconds, minutes, hours or days. The Subset
Statistics tool (included with HOBOware Pro) calculates statistics over a user-defined
interval.

Plug-in Tools

Plug-in tools for HOBOware Pro provide additional functionality. For example, the Real-
Time Alarm Software monitors HOBO data loggers and notifies you when sensor and
logger conditions fall outside the limits you specify. For instructions on installing and
using plug-in tools, refer to the tool’s user guide (located on the CD or web page where
you downloaded the tool).

Time Saving Options

Launching

By default, HOBOware Pro displays the Launch window when you initiate a launch. If
you want to skip the launch window and launch the logger with the default settings,
choose Automatically launch. This is particularly useful if you want to launch many
loggers quickly without changing any settings.

For more information see Launch Time Saving Options.

Readout

This feature allows you to skip a number of default actions when reading out a logger
(such as being prompted to saving or the Plot Setup window).

For more information see Readout Time Saving Options.

Viewing Subset Statistics

The Subset Statistics feature allows you to select a range of data in a graph, and display
the maximum, minimum, average and standard deviation for the measurements in that
range.

-12 -



HOBOware User’s Guide

See Viewing Subset Statistics for more information.

Tools

The Alarm and Readout Tool

The Alarm and Readout Tool is designed to continuously monitor critical areas, and
allow you to receive instant notification if conditions exceed limits using this
enhancement to HOBOware Pro.

The Bulk Export Tool

The Bulk Export Tool makes it easy to export data from many logger data files at once.
This tool is a free add-on for HOBOware Pro.

Data Assistants

HOBOware Pro Data Assistants let you create new data series by combining data
recorded by the logger with additional data that you enter before you display the plot.
For example, the kWh Assistant converts logged pulse data from an energy transducer
to kWh, average kW, and energy cost.

All Data Assistants can be run from the Plot Setup window after you readout a logger or
open a datafile. With this method you need to run the Data Assistant each time you
read out the logger or open a datafile.

Some Data Assistants (Pulse Scaling, Linear Scaling, kWh) can also be run from the
Launch window, so that parameters are applied automatically each time you read out
the logger or open a data file. Once you have pre-defined a parameter set, the pre-set
parameters are also used when current readings are viewed in the Status window. This
feature is available for the HOBO U30, the HOBO H21 (Weather Station and Micro
Station) and the HOBO H22 (Energy Logger) loggers.

For more information see HOBOware Pro Data Assistants.

Export Data to Other Programs

e One-click export to Microsoft Excel® or other ASCII-compatible programs

o Bulk File Export Tool provides easy way of exporting many data files at once
e Exportin Onset Box Car Pro format

e International date and time formats

e Copy and paste graph images into other programs

-13 -
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Introduction to HOBOware Lite

Overview

HOBOware Lite is entry-level software for HOBO USB loggers, offering easy logger
launch, readout, and data plotting.

HOBOware Lite combines fast, easy logger launch and readout functions with powerful
data plotting capabilities, making it easier than ever for users to analyze data recorded
with HOBO loggers.

An intuitive, graphical user interface allows users to select data parameters to display,
format graphs, perform analysis, and save projects for future use. One-click export of
data to Microsofte Excel or other ASCII-compatible programs is also available.

Upgrading to HOBOware Pro

To upgrade from HOBOware Lite to HOBOware Pro, call 1-800-564-4377 and ask for
Onset Customer Service.

Loggers
HOBOware Lite is compatible with the following HOBO data loggers:

e HOBO U-Series loggers (except HOBO U30 Station)

Key Features

e Easy logger setup/launch

Graphing and analysis with ability to view multiple data files on one graph
o Filters to extract key series information such as minimum/maximum values
e Save Project Changes

e Export ASCII text data

e Check Logger Status and view current readings

File Types
The following files can be opened by HOBOware Lite:

e _hobo - including files created with Onset's GreenLine software and both
Macintosh and Windows -compatible versions of HOBOware Lite and HOBOware

Pro.
e _.hsec
e _hproj

-14 -
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Overview of the HOBOware
Interface

The illustration below shows the HOBOware Main Window, including a plot generated
from opening an existing data file.

31 HOBOware Pro g@@'

1. Main Menu File Device Edit Yiew ‘Window Help
SAEEl B =l ] |- @ @ [~
R BE58R-8 B-E-0ESHoR+0as &M~
EHEWE T ?
-5 24 Hour Reaom Profile.hobo I
_05: 2 2
3. Points Table # Time, GMT-05:00 Temp, ®°F | RH, %  Host Connected | End OF File
1 02/04/09 10:00:00 PM 58.282  46.39 ~
z 02/04/09 10:05:00 PM 55,109 46,884
3 02/04/09 10:10:00 PM 56.10%  47.105
4 02/04/03 10:15:00 PM 58.109  46.334 2
e anlnainn 1osnonom | £7 ono ac nea
Show All | | Hide Al
4. Details Pane Details
(-~ Series: Temp, °F o
- -~ Jeties: RH, e B4
%o Ewent Type: Host Conn| Eas
e Event Type: End OF Filg " @ Host Connected
Eas x .End Of File
R " .
205109 04:15:00 5. Plot
58 B
*
50 ; B
54 T T T T
B:00:00 Ph 12:00:00 Al 06:00:00 A 12:00:00 P 0B:00:00 Phi  12:00:00 At
< % | | 02/04/09 06:00:00 P GhT-05:00 02/08/09 12:00:00 A GMT-05:00
BV p— — Ready.
Views [=H=Rli
Dev: Mo device selected. .. Mo devices connected

7. Message Bar

1. Main Menu - From the Main Menu you can perform operations on a device or a
project.

2. Toolbar - The toolbar includes icons for performing operations on a device as
well as tool to manipulate a plot or graph. For more information see The Toolbar
Error! Bookmark not defined..

3. Points Table - Logger data presented in a tabular format. See The Points Table
20.

4. Details Pane - Information and statistics about the launch. See The Details Pane
on page 18.

5. Plot - A graphical representation of the sensor readings and events. See Overview
of a Plot on page 16.

6. Views - Use these icons to toggle between views when you have multiple plots
open.

7. Message Bar - Indicates devices connected as well as various actions in progress
(such as readout, launch).

-15 -
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Overview of a Plot

A plot is a visual representation of the series you selected to view when you opened the
plot.

To change default plot settings, see Plotting Preferences on page 218.
Title
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'
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wizs oTh?

o7izs
07N 12:00:00 AM GMT-04:00
X axis

Axes

1. Title

Title of the graph (default is the description entered at launch). Show or hide the
Title from the View menu.

To change the title properties, double-click the title or select the title and click
the Properties icon |§_|

The following options are available on the Title Properties window:

Name: Enter up to a 40-character title for the graph. By default, the name is the
description entered when launching the logger.

Location: Move the title to either the top or bottom of the graph. The default
location is the top of the graph.

Font: Select a font type, size, and appearance.
2. Axes

The graph can contain several value axes depending on the number of series
displayed.

Y axis

Also called the value axes; displays the values for all sensor series, such as
temperature in degrees Fahrenheit or Celsius, or battery level in Volts.

X axis
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Also called the time axes; displays the time ranges for the data.
Gridlines

Show or hide vertical and horizontal gridlines from the View menu.
Legend

The legend is the area that lists the keys for each series (line colors and marker
types). If the crosshair tool is in use, it also lists the date, time and point values
currently selected by the crosshair. Show or hide the Legend from the View
menu.

To change the legend properties, double-click the legend or select the legend and
click the Properties icon lﬁ—l

The following options are available on the Legend Properties window:

Name: Enter up to a 40-character title for the legend. There is no default name.

Location: Move the legend to either the left or right side of the graph. By default,
the legend appears on the right.

Show Border: Toggles whether a box is drawn around the legend. By default, a
border is shown.

For secure files (HOBOware Pro: .hsec and .dsec; HOBOware Lite: .hsec) a

padlock icon ] appears in the legend next to the names of the series that were
verified as original data.
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The Details Pane

For each series, event, and state, the Details Pane contains information and statistics,
including:

e Devices - Device Info such as the model and serial number.

e Deployment Info - Such as series name, launch description, and launch time.
(Does not apply to HOBO data nodes)

o Series Statistics - Such as number of samples, average reading, and sample time.

e Sensor information (for station-type loggers) - Including the sensor location,
serial number, and resolution

In HOBOware Pro, if you do not want plots to open with the sensor location shown in
the Points and Details panes, go to Preferences > Plotting > Points Table and Details
pane and disable the "Include sensor Location (if available) in points table and details
pane” option.

To display the Details pane in HOBOware Lite, choose Details Pane from the View
menu. Choose Details Pane again to hide the pane.

seres_terge_Exancie oo [

#  Time, GMT-05:00 Temp, ¢  RH, % @ End Of File
1 010410 08:51:44 AM 69643 34470 Logged
et et 1
| o) (oo
Detais

|
Details |
—I-l = = Sories: T .
Pane + Iirlélerfq:‘: |
I # g Depdoyment Infio
+ E Series Shatichics |
| |

# ~ Series: AH, %
- Event Type: End OF File

e 2’ Deployment information - Such as the launch description, deployment
number, start time and time zone, logging interval, and battery voltage at launch.

e Z Series statistics - Including the total sensor samples and events, time of the
first and last sample, and the maximum, minimum, average, and standard
deviation for each sensor series in the plot

e (I Audit trail information for secure files

To fully expand the details tree, click the Show All button. To fully collapse the tree,
click Hide All

Click a series node in the details tree to select the corresponding series on the graph
and corresponding column in the Points Table.

-18 -



HOBOware User’s Guide

To print the details tree, go to the File menu and choose Print Details. To export the
details tree to a text file, go to the File menu and choose Export Details.

To resize the pane, drag the divider between the Details pane and the graph.

You can hide the Details pane. From the View menu, choose Details Pane. Choose
Details Pane again to redisplay the Details pane.

NOTE: You can configure if the Details pane is shown by default with the Show the
details pane when plotting data option in Preferences > Plotting > Layout.

-19 -



HOBOware User’s Guide

The Points Table

The Points table lists logger data in a table. The Points table is linked to the graph: only
the data for the sensor measurements, states, and events displayed on the graph are
listed in the Points table.

121 HOBOware Pro

File Device Edit Wiew ‘Window Help

= = = [ = [ElU L ~a L 20 = L . e
BASE B B-B-0E382R+-0ar

# Time, GMT-05:00 Rain, in | Solar Radiation, Wfm* | Temp, °F = RH, % Batt, ¥
1 0204/09 10:56:00 P 0.6 13.271 Fz2.100 4.128
2 0z04/09 10:57:00 PM 0.000 0.6 13,208  7Fz.000 4,093
3 0z04)09 10:58:00 PM 0.000 0.6 13.145 72,200 4,128
4 0z04)09 10:59:00 PM 0.000 0.6 13.145 72,500 4.140
5 0z04/09 11:00:00 PM 0.000 0.6 13.082 72400 4,152
o] 0z/04/09 11:01:00 PM 0.000 0.6 13.01%  Yz.500 4,152
7 0z04/09 11:02:00 PM 0.000 0.6 13.01%  7Fz.400 4,158
&3 0Z/04/09 11:03:00 PM 0.000 0.6 12,956 72,600 4,155
9 0Z104/09 11:04:00 PM 0.000 0.6 13,019 72400 4,164

The data points are listed chronologically. All the measurements, state changes, and
events recorded by the logger at a given time are listed in a single row. Each series is
displayed in a column. You can resize the columns by clicking and dragging the dividers
between the column headers.

Use the arrow keys or scroll bars to move up, down, left, and right in the Points table.
Additionally, as you click the crosshair tool -i- in the graph, the corresponding point is
selected in the Points table; if you click a value or event cell in the Points table, the
crosshair will appear on the graph at the time corresponding to that cell.

To print the points, go to the File menu and choose Print Points (available only with
Java 1.5 or higher). To copy points, use the mouse to select the cells you want to copy,
then press Ctrl+Command-C to copy them to the clipboard.

Tip: You can export the data points to a text file for use in Microsoft® Excel® or other
programs.

To resize the pane, drag the divider between the Points table and the graph.
To hide the Points table, from the View menu, choose Points Table.

If you do not want the Points table to be displayed by default when you view data, go to
Preferences> Plotting > Layout and disable "Show the points table when plotting
data" option.

HOBOware Pro

If you do not want plots to open with the sensor location shown in the Points and
Details panes, disable the "Include sensor Location (if available) in points table and
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details pane" setting under Points Table & Details Pane on the Plotting Preference
pane.

HOBOware Lite

To display the Points table, choose Points Table from the View menu. Choose Points
Table again to hide the Points table.
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The Plot Setup Window

After you read out a logger or open a saved datafile, the Plot Setup window appears.
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1. Description - Enter text to describe the plot.

2. Select Series to Plot - Select the series you want to plot and the units, if
applicable.

3. Select Internal Logger Events to Plot - Select internal logger events to plot (only
available for some loggers).

4. Offset from GMT - Set the Time Zone Offset from GMT if required.
5. Data Assistants (HOBOware Pro Only)

HOBOware Pro Data Assistants let you create new data series by combining data
recorded by the logger with additional data.

NOTE: The following Data Assistants can also be run from the Launch window:
Pulse Scaling, Linear Scaling, kWh.

6. Plot Button - Click this button to plot the selected data on a graph.
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Installing HOBOware

You can install HOBOware from the Onset Web site or from the Installation CD.

The first time you install HOBOware it will be in Trial Mode. You will need to activate it
entering your license key, or continue to run it in Trial Mode until the trial expires. If
you are updating an existing version of HOBOware you will not need to activate
HOBOware. See Activating HOBOware (page 26).

Before You Begin
e README file

Refer to the HOBOware website at http://www.onsetcomp.com/HOBOware or
the README file on the installation CD for detailed information about the
hardware and software needed to run HOBOware. If you have additional
questions, please contact Onset Technical Support.

e License Key

When you purchase HOBOware, your email receipt will include a license key. If
you purchased HOBOware online, the license key is also displayed in the online
receipt. After you install HOBOware and run it for the first time you will be
prompted to enter the license key.

Installing HOBOware from the Onset Web Site

To download HOBOware from the Onset Web site, go to the following URL and follow
the instructions for downloading and installing HOBOware:

http://www.onsetcomp.com/products/software

When you install HOBOware form the web it will be in Trial mode until you enter your
License Key.

Installing HOBOware from the Installation CD

To install the software from the CD:

Windows
1. Insertthe CD in your computer’s CD-ROM drive.

The installation program should start automatically. If it does not, navigate to the CD
drive in My Computer or Windows® Explorer and double-click HOBOware_Setup.exe
to launch the HOBOware installer.

NOTE: HOBOware for Windows requires the Java Runtime Environment. If the correct
Java Runtime Environment version is not already installed on your computer, the
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HOBOware Setup program will ask if you want to install it now. (You must be logged in
as an administrator on your computer to install the Java Runtime Environment.) Click
Yes and follow the prompts. After Java Runtime Environment is installed, the
HOBOware installation will continue.

2. Follow the prompts to install HOBOware.

HOBOware should open automatically when the installation is complete. If it does not
open by itself, double-click the HOBOware icon on your desktop or Quick Launch menu.
Or, from the Start menu, select Programs > Onset Applications > HOBOware.

Mac

1. Insertthe CD in your computer’s CD-ROM drive.

2. Double-click the CD icon in the Finder and double-click the HOBOware.pkg to
launch the HOBOware installer.

3. When you reach the final screen of the installation program, click Restart.

4. After restarting, open HOBOware by double-clicking the HOBOware icon in your
computer’s Applications folder.

5. Proceed to the next task, Activating HOBOware.

Software Updates

If you have an Internet connection, HOBOware will periodically ask if you would like it
to check the Onset website for software updates. The default is to check once per week,
but you can configure HOBOware to check daily or monthly.

Go to Preferences > General > Startup > Check for HOBOware updates.
If you do not have an Internet connection, choose Never.

You may check for updates manually at any time by clicking Check for Updates from
the Help menu.

NOTE: If you are using HOBOnode Manager with HOBOnode Indoor Wireless Sensors,
you must stop device communication to upgrade HOBOware.

Upgrading to HOBOware Pro

To upgrade from HOBOware Lite to HOBOware Pro, call 1-800-564-4377 and ask for
Onset Customer Service.
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HOBOware Setup Assistant
(HOBOware Pro Only)

When you open HOBOware Pro for the first time, you are greeted by the HOBOware
Setup Assistant, a series of windows intended to help you quickly change some key
settings for device types and serial ports, units of measurement, and data assistants. To
run the Setup Assistant, click Start and follow the prompts to change some key
preferences.

NOTE: The Setup Assistant is optional. If you click Cancel, you will be able to use
HOBOware Pro with its default settings.

Setup Preferences

Device Types

Serial Port(s) to use:

e Support serial devices on COM1 (Windows)

e Support serial devices on the default serial port only (Mac)
The default is USB. If you enable Serial Devices you can select the port to use.

Unit System

e US (default)
e SI

Data Assistants

Select the installed Data Assistants you want to show when relevant data is present. All
loaded Data Assistants are checked by default. You can also load a new Data Assistant.

Running the Setup Assistant at a Later Time
To run the Setup Assistant at any time, go to:
Windows: File > Preferences > General
Mac: HOBOware > Preferences > General

and click the Setup Assistant button in the bottom right of the pane.
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Activating HOBOware

The first time you install HOBOware it will be in Trial Mode. You will need to activate it
entering your license key, or continue to run it in Trial Mode until the trial expires.

NOTE: If you are updating an existing version of HOBOware you will not need to
activate HOBOware.

Locating your License Key

When you purchase HOBOware your e-mail receipt will include a license key. If you
purchase HOBOware on-line, the license key is also displayed in the on-line receipt.

License Key Manager Window

The first time you open HOBOware the License Key Manager window will appear. Enter
your license key in the License Key text box to activate the Full Version of HOBOware.
This is the only time you will have to enter your License Key, even if you upgrade to

another version.
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Using a Trial Version of HOBOware

The first time you open HOBOware the License Key Manager window will appear. To
run a Trial Version, check I want to use HOBOware Pro Trial and click OK.
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The date your trial will expire appears at the top of the HOBOware window.

Each time you open a Trial Version the License Key Manager window appears. Check
I want to use HOBOware Pro Trial to continue using the Trial Version, or, if you have
purchased HOBOware, enter the license key in the License Key text box.
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Trial Expiration

When the trial expires you will be prompted to enter a license key before you can
continue using HOBOware.
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Working with HOBO Data Loggers

The illustration below shows the basic steps involved using HOBOware with a

HOBO data logger. It is assumed that you have connected the device to a computer
running HOBOware.

See Basic Setup Procedure for more information.

NOTE: If you are configuring HOBO data nodes, see Chapter 7.

1. Launch Logger
Go to Device > Launch on the Main Menu and the configure Launch Settings in the Launch window.

Launch Window

(Optional) Configure pre-set
3 parameters for the kWh, Pulse
‘= —® Scaling, and Linear Scaling Data
Assistants (HOBOware Pro only,
serial loggers only)

2. Readout data
Go to Device > Readout on the Main Menu. Save datafile when prompted.

3. Plot Data
Set plotting requirements and click the Plot button.

Plot Setup Dialog (Optional) Use Data Assistants

Flot
== (HOBOware Pro only) o

4. Analyze Data
Use HOBOware tools to analyze the plot.

Save Project

Project
P =™ * hproj
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Basic Setup Procedure

This topic provides details on the steps to use HOBOware.

1.

Launch Logger

To set up a logger to record data, you must specify several parameters and start
or launch the logger.

See Launching Procedure for more information.
Read out Data

After connecting the logger to a computer running HOBOware, you select Device
> Readout from the Main Menu to readout the data from the logger. For more
information, see Reading Out Data from a Logger.

After the logger is read out, HOBOware prompts you to save the datafile.
Although you can save a project file without saving the original datafile, Onset
strongly recommends saving datafiles so that you will always have access to the
original data that was read out from the logger.

Accept the default location and name, or enter a new name and click Save. By
default, the data is saved in the HOBOware folder located in your My Documents
folder (or Documents folder on a Mac). If you decline to save the datafile, the plot
is displayed with a name like "Untitled 1*" on the tab. The asterisk signifies that
the data has not been saved. To save the logger data as a datafile, from the File
menu, select Save Datafile. You can only save the data to a datafile once.

Plot Data

After you read out a logger, the Plot Setup window appears. Select and define the
series you want to plot, change the default define units and time zone if required,
and click Plot. The plot, which includes a graph, a Details Pane, and a Points
table, appears.

For more information, see Setting up a Plot 71.
Analyze Data

Use HOBOware tools to analyze the plot.
See Converting Units 96.

Save Project

A project file (.hproj) is a plot that you have customized using the various
features and tools of HOBOware. When you open a project file, the plot appears
as it did when you saved the project file, and contains all of the same data.

Changes that you make to the appearance or content of the plot are not retained
when you save the datafile. For example, if you have pasted series from another
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plot, created new axes and zoomed in, those changes will be lost unless you save
them in a project file.

To save your current data with a customized view of the plot, click the Save icon

LEIJ on the toolbar, or choose Save Project from the File menu. To open an
existing project file, choose Open Project from the File menu.
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Connecting Devices

HOBOware Pro can be used with the following devices:

e HOBO U-Series data loggers and shuttles communicate with the computer by
connecting to a USB port

e HOBO Weather Station *

e HOBO Micro Station *

e HOBO Energy Logger*

e HOBOnode Data Nodes (see Chapter 7)

* These loggers communicate with the computer by connecting to a serial port (or USB
port with Keyspan™ serial adapter)

HOBOware Lite can be used with most HOBO U-Series data loggers, which
communicate with the computer by connecting to a USB port.

You can connect most devices to the USB port by using an Onset-supplied USB interface
cable. Some loggers require an optic USB base station/coupler or serial cable
(HOBOware Pro only) to connect to the computer. Consult the manual that came with
your device for specific information about required base stations/couplers or cables.

e (Connecting a USB Device to HOBOware (page 32)
e Connecting a Base Station/Coupler to HOBOware (page 33)
e Connecting a Serial Device to HOBOware (page 34)

e Connecting Multiple Devices (page 35)

NOTE (Lite): For instructions on connecting HOBOware compatible shuttles or using
the HOBO Waterproof shuttle as a base station, refer to the shuttle's user guide.
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Connecting a USB Device

You can connect most devices to the USB port by using an Onset-supplied USB interface
cable.

Some loggers require an optic USB base station/coupler or serial cable (HOBOware Pro
only) to connect to the computer. Consult the manual that came with your device for
specific information about required base stations/couplers or cables.

NOTE (HOBOware Pro): For instructions on connecting shuttles, or using the HOBO
Waterproof Shuttle as a base station, refer to the shuttle’s user guide.

NOTE: If you are using a Base Station or Coupler, see Connecting a Base Station or
Coupler (page 33).

Steps
To connect a logger or shuttle to HOBOware using a USB cable:

1. Open HOBOware.

2. Plug the large end of the USB interface cable into a USB port on the computer.

3. Plug the small end of the USB interface cable into the port on the device. (Refer to
the diagram and instructions that came with the device if you need help finding
the port.)

When the device is recognized by HOBOware, the right side of the status bar at the
bottom of the HOBOware window will update to reflect the number of devices
connected. At this point, you can begin using the device.

NOTES (Windows Only):

o [fthe device has never been connected to this computer before, it may take some
time for the computer to detect the new hardware and report that it has
connected successfully. One or more messages will appear, indicating that new
hardware has been found. You may also hear a chime.

e Your computer may tell you to reboot before you can use the device. It is not
necessary to reboot.

Disconnecting a Device

To disconnect the device, simply unplug it from the USB cable. Wait for the status bar to
update the number of devices before continuing.
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Connecting a Base Station or
Coupler

Some loggers require an optic USB base station/coupler or serial cable to connect to
the computer. Consult the manual that came with your device for specific information
about required base stations/couplers or cables.

NOTES (Windows Only):
e [fyou are connecting a base station/coupler or logger that has never been
connected to this computer before, it may take some time for the computer to
detect the new hardware and report that it has connected successfully. One or

more messages will appear, indicating that new hardware has been found. You
may also hear a chime.

e You may be prompted to reboot you computer before you can use the logger. It
is not necessary to reboot.

Steps
To connect a logger to a base station/coupler:

1. Open HOBOware.

2. Plug the base station/coupler cable into a USB port on the computer.

Important: Make sure the base/station coupler is the correct model for the logger
you want to use. Consult the manual that came with the logger if you are not sure.

3. Attach the logger to the base station/coupler as described in the documentation
that came with your logger.

When the logger is recognized by HOBOware, the right side of the status bar at the
bottom of the HOBOware window will update to reflect the number of loggers
connected. At this point, you can begin using the logger.

To disconnect a logger, simply unplug it from the base station/coupler. Wait for the
status bar to update the number of devices before continuing.

To attach another logger via a base station/coupler, remove the logger, leaving the base
station/coupler connected. Then connect the next logger.
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Connecting a Serial Device
(HOBOware Pro Only)

To connect a device to a computer using a serial cable:

1.
2.

Open HOBOware Pro.

Plug the 9-pin end of the serial interface cable into a serial port on the computer
or Keyspan adapter.

Plug the other end of the serial interface cable into the communications port on
the device. (Refer to the diagram and instructions that came with the device if
you need help finding the port.)

Click the Select Device icon |_| on the toolbar to ensure that the device is listed
in the Select Device window. Click the button next to the device in the window,
then click OK.

Configure Serial Port Settings (Optional)

If you are using a serial port other than COM1 (PC) or Default (Macintosh), you
will need to set up HOBOware to look at another port.

To change the Serial Ports setting go to:
PC: File > Preferences > Communications
Mac: HOBOware Pro > Preferences > Communications

Note that checking multiple serial ports can take some time, even when no
devices are attached.

The status bar at the bottom of the HOBOware Pro window will update to reflect that
the device is connected and selected. At this point, you can begin using the device.

To disconnect the device, simply unplug it from the serial cable.
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Connecting Multiple Devices

Overview

If your computer has multiple USB and serial ports, you can connect multiple devices
and work with one at a time (HOBOware Lite can only be used for USB Ports). When
multiple devices are connected, the Select Device window opens every time you select
Launch, Readout, Stop, or Status from the Main Menu.

Click the button next to a device on the list to select it, then click OK. The selected
action will proceed.

To access the Select Device window at any time, click the Select Device icon on the
toolbar, or choose Select Device from the Device menu.

With HOBOware Pro, if you work with multiple U-Series devices frequently, you can set
the Default Action to Launch (Device menu) and enable Launch Time-Saving Options
to work more efficiently.

NOTE (HOBOware Pro): If serial devices are selected in Preferences, it may take some
time for HOBOware Pro to scan all of the serial ports. You can select the device you
want as soon as it is displayed. You do not have to wait for all of the ports to be
scanned.

Verifying Selected Device

If the Blink Device Light button is available, you can click it to verify that you have
selected the appropriate device. This briefly illuminates the light on the devices that
you have selected.

If the device does not have a light, or if the light is not visible when the devices is in the
base station/coupler, simply check the serial number (S/N) on your devices to make
sure that it matches the one that is selected in this window.

When the Select Device window is not open, you can check the status bar at the
bottom of the screen to quickly determine which device is selected. The left side of the
status bar indicates the model, description, and serial number of the device; the right
side indicates the total number of devices connected.

NOTE (HOBOware Pro): Serial devices that you have added or removed are not
reflected in the device count until you click the Select Device icon on the toolbar to
update the device list.
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Chapter 2: Launching

Launch Procedure

To set up a logger to record data, you must specify several parameters and launch
(start) the logger.

Before opening HOBOware, check the time on the computer and ensure that it is
correct. If it is not, update your computer's clock manually or synchronize it with an
online time server (if available).

To launch a logger:

1. Open HOBOware.
2. Connect the logger to the computer.
3. Click the Launch icon on the toolbar, or choose Launch from the Device menu.

4. Different messages may appear, depending on the state of the logger. Answer
each of the prompts accordingly:

A warning appears if the logger has already been launched. Click Yes to continue,
or click No to cancel.

For U-Series loggers only (other than the HOBO U30 Station), a warning appears
if the logger has collected data since its last readout. Click Yes to proceed to the
launch window, or click No to cancel the launch and read out the data first.

Because loggers are tested before shipping, there may be data in your logger the
first time you launch it. In this case, it is not necessary to read out the logger.
Click Yes to proceed.

The Launch window appears. See Launch Window for U-Series Loggers or Launch
Window for Station Loggers.

5. Configure the launch parameters.

6. To verify that the sensors are working correctly or to review settings from the
previous launch, click the Status button.

7. Click the Launch button.

NOTE: If the logger is a U-Series logger (other than the HOBO U30 Station) and
was already logging from a previous deployment, it will not stop logging the
previous deployment until you click the Launch button. Click Cancel if you want
to continue the previous deployment.

If the logger is a station-type logger and is currently logging, it will stop logging if
you click Yes to continue. Click No if you do not want to stop the logger.
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HOBOware displays the progress of the launch and warns you not to unplug the logger
while it is being configured. Once the logger begins logging, it will continue logging
until you stop it, the memory is full, or the battery runs out.
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Multiple Logging Intervals

Overview

Some loggers can be configured with multiple logging intervals, which allow you to
define separate intervals for different phases of the deployment.

If multiple logging intervals are available for your logger, you will see an Add New
Interval button on the Launch window for your logger.

Because internal logger events, such as coupler events, do take up some of the logger's
memory, the number of samples and end times are only estimates. Frequent events will
cause the logger to fill up sooner.

Steps
To configure multiple logging intervals:

1. Click the Add New Interval button until you have as many intervals as you want
(up to the number of intervals available for the logger).

2. Set the hours, minutes, and seconds for each interval, and the number of samples
you want the logger to record at each interval.

3. Use the Start and End times in the Duration column to help you decide how
many samples to record at each interval.

To delete an interval, click the Remove button next to the interval.
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Fast Logging Intervals

Some loggers can be configured with fast logging intervals, which allow you to log more
than once per second, up to 100 measurements per second (hertz). If fast logging
intervals are available for your logger, the Launch window for your logger will offer
Logging Interval choices of Normal and Fast.

To use fast logging intervals, click the Fast button. Then choose a logging frequency

from the Hertz drop-down list, or enter the logging interval in decimal form in the Sec
field.

NOTES

e Alogger cannot communicate with a computer or shuttle while it is logging at a
fast interval. Once it has started logging, if you connect it to a computer, base
station, or shuttle to check status or read it out, the logger will stop.

e Be aware that a fast logging interval typically means a very short Logging
Duration. Make sure the logger will run long enough to collect the data you
need. Disabling unnecessary channels will give you more time.

o Because fast logging deployments are so brief, the logger must be launched with
a trigger start. Follow the instructions that came with your logger for a trigger
(coupler or button) start. If the logger has a light, the light will flash quickly when
logging begins.

-39-



HOBOware User’s Guide

Launch Time-Saving Options
(HOBOware Pro Only)

Use the Launch Time-Saving Options to disable certain user interactions and save time
when performing some launch functions.

You access the Launch Time-Saving Options by going to File > Preferences > General
> Launch Time-Saving Options

When launching

Show Launch Screen (default)
HOBOware Pro displays the launch window when you initiate a launch.
Automatically Launch

Select this option if you want to skip the launch window and launch the logger
with the default settings. This is particularly useful if you want to launch many
loggers quickly without changing any settings. The default settings are
determined by the Fill launch window with contents of setting.

For HOBOware Pro Only: When used in conjunction with a Default Action of
Launch (accessed from the Device menu), this feature allows you to launch many
U-Series loggers in a row simply by plugging and unplugging individual loggers.

Fill launch window with contents of:

Current logger

Alogger's memory contains the most recent launch settings for that logger.
These settings normally become the defaults for the logger's next launch (the
option).

Previous launch

Select this option if you plan to launch several loggers of the same model with
similar settings. This will fill the launch window with the settings from the
previous logger that was launched.

This is particularly useful if you want to set up many loggers to start at the same
time and with the same logging interval. An indicator on the Launch window will
remind you when this preference is in use.

If the logger you are launching is a different model from the previous logger,
Previous launch does not apply. HOBOware Pro will use the settings in the
logger's memory, and those values will become the default for the next logger if it
is the same model.
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Default launch type
This option allows you to set the default launch mode.

NOTE: If you set the Fill launch window with contents of preference to Previous
launch, the Default launch type will be ignored in favor of the launch type from
the last launch.

e Previous Launch type (default)

The launch option will default to the option used for the logger's previous
launch.

Exception: if the previous launch was a Launch at interval start, the next
launch will default to a delayed start.

eLaunch now
e Launch at interval
eDelayed launch

o Triggered start

Important: If you choose Triggered start as the default launch type, and
then launch a logger that does not offer a trigger start option, the launch
option will default to Launch now.
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The Launch Window for Station

Logge

rs

This topic describes the Launch Window for the following station loggers:

e HOBO Weather Station (H21-001)
e HOBO Micro Station (H21-002)

e HOBO Energy Logger (H22)

e HOBO U30 Station (see Chapter 5)

For more

details see Launch Parameters for Station Loggers.
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1. Logger Information: Logger Type, Serial Number, Deployment Number, and
Battery Level.

2. Description: A description you enter for the launch.

3. Channels to Log: See Channel to Log Guidelines for Station Loggers.

4. Wrap Around When Full: You have the option to allow station-type loggers to
wrap and continue logging after the memory has filled up. The newly logged

info

rmation will overwrite the oldest logged information. Check this box if you
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want the logger to continue logging, overwriting the older data, instead of
stopping when full.

Logging Interval: How often the logger will record data from the sensors.

Sampling Interval: The sampling interval allows you to take multiple
measurements within the logging interval, then average them together to create
a single logged measurement.

Logging Duration: The approximate time it would take to fill the logger's memory
based on the logging interval and the currently connected and enabled sensors, if
applicable.

Launch Options: Select when to launch the logger.
Help Button: Click to launch the on-line help for the Launch Window.

Utilities (HOBOware Pro Only): Depending on the logger and sensors connected,
various utilities are available.

Data Assistants (HOBOware Pro Only)

HOBOware Pro Data Assistants let you create new data series by
combining data recorded by the logger with additional data. When you use
a Data Assistant from the Launch window, the parameter set is saved and
applied to data every time you read out a logger. The derived data is also
shown when you check the latest readings in the Status window.

You can use the following Data Assistants from the Launch window
(others can only be used from the Plot Setup window): Pulse Scaling,
Linear Scaling, and kWh. This feature is available for the HOBO U30, the
HOBO H21 (Weather Station and Micro Station) and the HOBO H22
(Energy Logger) loggers.

Click on the Data Assistants button to access the Data Assistants window.
Select the desired assistant and click the Create button to run the selected
assistant. After you enter values, click Save Parameter Set.

See HOBOware Pro Data Assistants for more information. See the assistant
on-line help or user guide for more information on a specific assistant.

Alarms

If alarms are available on the logger, the Alarms button will be active. Click the
Alarms button to access the Alarm Configuration window.

User Notes: You may enter up to 2000 characters of information about the
deployment. This text will be displayed in the Details pane after you read out the
logger and display the data.

Skip launch window next time: Check this box if you would like to bypass this
window the next time you launch a device.

Launch Button: Click to launch the device.
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Launch Parameters for Station
Loggers

This topic explains the elements in the Launch window for station loggers.

Field/Description

Logger Type

Logger model and description.

Serial Number

Serial number of the logger. Note that some external sensors also have serial numbers,
which are not listed here.

Deployment Number

Number of times (including this time) the logger has been launched. Each time you
start a new launch, the deployment number increases by one.

Description

Enter a description for the launch, up to 40 characters, in this field. This description is
used as the default file name when you read out and save the data recorded by the
logger. It is also the title of the graph.

Channels to Log

Review and configure the data channels, if any, you want the logger to record. If you do
not select any channels to log, the logger will record states and events only.

Only the sensors that are currently plugged in or built into the logger are listed. Sensors
are listed in ascending order by serial number, regardless of their position in the
logger. If you add or remove sensors, click the Refresh button to make sure your
changes are seen by the logger.

Although it is helpful to see the connected sensors when setting up the launch, it is not
required that you connect the sensors during launch set-up (though they do need to be
connected if you want to define locations or configure FlexSmart modules or Analog
Sensor Ports). You may set up the launch for a delayed or trigger start, then connect the
sensors later, before logging begins.

Double-click a sensor name (or click the Set Location button while a sensor name is
selected) to enter a location string, up to 30 characters, that provides useful
information about the sensor for this deployment.

For more information see Channels to Log Guidelines for Station Loggers on page 47.
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Wrap Around When Full

You have the option to allow station-type loggers to wrap and continue logging after
the memory has filled up. The newly logged information will overwrite the oldest
logged information. Check this box if you want the logger to continue logging,
overwriting the older data, instead of stopping when full.

User Notes

You may enter up to 2000 characters of information about the deployment. This text
will be displayed in the Details pane after you read out the logger and display the data.

Logging Interval

Choose the rate at which you want the logger to record data. The minimum logging
interval is one second and the maximum for most loggers is 18 hours, 12 minutes, and
15 seconds. The shorter the logging interval, the more quickly the memory fills and
battery power is consumed.

Some sensors (specifically, the FlexSmart TRMS modules) require a logging interval of
two seconds or greater. If you choose a faster logging interval, erroneous data will be
logged on these channels.

Sampling Interval

The sampling interval allows you to take multiple measurements within the logging
interval, then average them together to create a single logged measurement.

The sampling interval is optional, and is valid only for sensors with measurement
averaging. Refer to the sensor's user manual to determine whether measurement
averaging is available on the sensor. If you have at least one sensor that supports
measurement averaging, check the box to enable measurement averaging, then set the
sampling interval at less than or equal to the logging interval (up to four minutes).
Rapid sampling (faster than one minute) will reduce the logger's battery life.

If you do not have any sensors with measurement averaging, uncheck the box to
disable the sampling interval and avoid unnecessary strain on the logger's battery.

Logging Duration

Approximate time it would take to fill the logger's memory based on the logging
interval and the currently connected and enabled sensors, if applicable. This is a
theoretical estimate only; battery life will affect your deployment. In addition, if you
plan to connect additional sensors before logging begins (i.e. while awaiting a trigger or
delayed start), the estimate will not be correct.

If you add or remove sensors while viewing the Launch window, click the Refresh
button to get an updated Logging Duration.

Launch Options

The Launch Option defaults to the setting for the logger's previous launch. To have all
loggers default to the same launch option, see Launch Time-Saving Options 40
(HOBOware Pro only).

NOTE: For additional details on launching the HOBO U30 Station, see Chapter 5.
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Now: Logging begins as soon as you click the Launch button. If you do not have at
least one sensor attached, the logger will not launch.

At Interval: Logging will begin at an exact interval (for example 9:00:00 rather
than 8:47:00 when you choose a one-hour logging interval). The exact start time
depends on the logging interval you choose.

Delayed: Logging will begin at a date and time you specify.

Trigger: Logging will not start until you press the button on the logger and hold it
down, or perform some other action as described in the logger manual. If the
logger has a light, the light will flash quickly when logging begins. This is not
available for the U30 Station.

Save Settings: Logging will not start, but the launch settings will be saved so that
you do not have to re-enter them when you are ready t o launch at a later time.
The next time you view the Launch window for this logger, the settings you
entered will still be in place.

Skip launch window next time

Check this box if you would like to bypass the Launch Window the next time you
choose Launch from the Device menu or click the Launch icon. This will cause the next
logger to be launched with default settings, as determined by the Fill launch window
with contents of preference. To turn this setting off so that you can access the Launch
window again, go to Preferences > General > Launch Time-Saving Options and in
the When Launching drop-down list select "Show launch screen".

To always use the settings from the logger's memory, you can return to the default
setting by going to Preferences > General > Launch Time-Saving Options and
choose Fill launch window with contents of Current logger.
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Channels to Log Guidelines for
Station Loggers

This topic describes guidelines for the Channels to Log section in the Launch window
for Station loggers.

Some general information is given below, but you should always refer to the
documentation that came with your logger for detailed information about the channels
that are available to you.

Maximum Channels

Do not attach more than 15 channels of sensors. The logger cannot accommodate more
than 15 channels.

Battery Channel

In addition to logging up to 15 channels, the HOBO Energy Logger and HOBO U30
Station can record their internal battery channel. (Other sensors must be attached; the
logger cannot log battery alone.) The logger's battery voltage is recorded at each
interval.

Like the other data channels, logging the internal battery channel consumes some of
the logger's memory. Unless you are using excitation power or suspect abnormal
battery performance, you probably do not need to log the battery voltage in loggers
other than the HOBO U30 Station.

Excitation Power

Always enable the logger's internal battery channel when logging with excitation
power. This will enable you to determine whether and when excitation power was

turned off during a deployment.
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The Launch Window for U-Series
Loggers

The Launch Window for all U-Series loggers (except the U30 Station) is shown below.

See Launch Options for U-Series Loggers on page 49 for more information.
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1. Logger Information: Logger Type, Serial Number, Deployment Number, Battery
or Battery Level.

2. Description: Enter a description for the launch, up to 40 characters, in this field.
This description is used as the default file name when you read out and save the
data recorded by the logger. It is also the title of the graph

Channels to Log: See Channels to Log Guidelines for Station Loggers.
4. Logging Interval: The rate at which you want the logger to record data.

Logging Duration: Approximate time it would take to fill the logger memory
based on the logging interval and currently enabled sensors.

6. Launch Options: When to launch the logger.
7. Help Button: Click to open the on-line Help for the Launch window.

8. Skip launch window next time (HOBOware Pro only): Check this box if you would
like to bypass this window the next time you launch a device.

9. Launch Button: Click to launch the logger.

10. Utilities (not available on all loggers): Includes Scaling, Alarms.
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Launch Options for U-Series
Loggers

This topic describes the launch parameters you set in the Launch Window for U-Series
Loggers.

Logger Information

Logger Type: Logger model and description.

Serial Number: Note that some external sensors also have serial numbers, which are
not listed here.

Deployment Number: Number of times (including this time) the logger has been
launched. Each time you start a new launch the deployment number increases by one.

Battery or Battery Level: Condition of the battery when you opened the Launch
window. The indicator varies depending on the logger model. For example, some
loggers require you to specify whether the battery is alkaline or lithium. Consult the
logger documentation for specifics on battery capacity.

Description

Enter a description for the launch, up to 40 characters, in this field. This description is
used as the default file name when you read out and save the data recorded by the
logger. It is also the title of the graph

Channels to Log

See Channels to Log Guidelines for U-Series Loggers.

Logging Interval

Choose the rate at which you want the logger to record data. The minimum logging
interval is one second and the maximum for most loggers is 18 hours, 12 minutes, and
15 seconds. The shorter the logging interval, the more quickly the memory fills and
battery power is consumed. If you did not select any channels to log, this field will be
dimmed and unavailable.

Also see Multiple Logging Intervals and Fast Logging Intervals.

Logging Duration

Approximate time it would take to fill the logger memory based on the logging interval
and currently enabled sensors, if applicable. This is a theoretical estimate only; battery
life and frequent state and event logging will affect your deployment. If you are logging
only state changes and events, no estimation is possible.
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Launch Options

This indicates when to Launch the logger. The Launch Option defaults to the setting for
the logger's previous launch. To have all loggers default to the same launch option, see
Launch Time-Saving Options (HOBOware Pro only).

o Now: Logging begins as soon as you click the Launch button.

e AtlInterval: Logging will begin at an exact interval (for example 9:00:00 rather
than 8:47:00 when you choose a one-hour logging interval). The exact start time
depends on the logging interval you choose.

e Delayed: Logging will begin at a date and time you specify, up to approximately
six months from the present.

o Trigger: (Available only on certain loggers.) Logging will not start until you press
the button on the logger and hold it down for at least three seconds, or return the
logger to the coupler without the base station for at least three seconds (refer to
your logger manual for more information). If the logger has a light, the light will
flash quickly when logging begins.

Skip launch window next time (HOBOware Pro only)

Check this box if you would like to bypass the Launch Window the next time you
choose Launch from the Device menu or click the Launch icon. This will cause the next
logger to be launched with default settings, as determined by the Fill launch window
with contents of preference. To turn this setting off so that you can access the Launch
window again, go to Preferences > General > Launch Time-Saving Options and in
the When Launching drop-down list select "Show launch screen".

To always use the settings from the logger's memory, you can return to the default
setting by going to Preferences > General > Launch Time-Saving Options and
choose Fill launch window with contents of Current logger.
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Channels to Log Guidelines for
U-Series Loggers

This topic describes guidelines for the Channels to Log section in the Launch window
for Series loggers.

Some general information is given below, but you should always refer to the
documentation that came with your logger for detailed information about the channels
that are available to you.

Sensors

Select the data channels, if any, you want the logger to record.

Only the sensors that are currently plugged in or built into the logger are listed. If you
add or remove sensors, click the Refresh button to make sure your changes are seen by
the logger.

Although it is helpful to see the connected sensors when setting up the launch, it is not
required that you connect the sensors during launch set-up (though they do need to be
connected if you want to define locations or configure FlexSmart modules or Analog
Sensor Ports). You may set up the launch for a delayed or trigger start, then connect the
sensors later, before logging begins.

Important: Sensors that are connected after logging begins will not log any data.

RH/Pressure

Some loggers with RH or pressure sensors require that you also select the internal
temperature channel in order to log relative humidity or pressure. Refer to the manual
that came with your logger for additional information.

Dew Point

When both the internal temperature and RH channels are selected, dew point will be
calculated automatically.

External Channels

For loggers with external channels, you must select the part number of the sensor that
is attached to ensure data is accurate during logging. The sensor part number is listed
on the shrink tube on the sensor cable; make sure it matches the part number you
select.

If you select an external channel, but do not plug the sensor in, false data will be
recorded for that channel.
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Event & State Channels (not on all loggers)

If external events and/or states are available for your logger, you can enter names to
identify the event and state channels that are in use. You can also rename the Open and
Closed descriptions for each state, and enter increments and units for each event
channel.

Utilities
If applicable, select a channel and click on the Scaling or Alarms button in the Utilities
section to configure scaling or alarms.

Battery Channel

You can select the logger's internal battery channel. The logger's battery voltage is
recorded at each sample time.

Like the other data channels, logging the internal battery channel consumes some of
the logger's memory. Unless you suspect abnormal battery performance, you probably
do not need to log the battery voltage. A U-Series logger (other than a HOBO U30
Station) will record a bad battery event, even if it is not recording the battery channel.
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"Read Header Failed"™ Error

Occasionally, when trying to launch, check status, or read out a U-Series logger (other
than a HOBO U30 Station), HOBO Waterproof Shuttle, or HOBO U Shuttle, you may
receive the following error: "Read Header Failed."

These messages occur when a device's header cannot be read, usually because of a
communication error or corrupted header. Disconnect the device from the computer,
then reconnect it and try to launch, check status, or read out again.

If you receive the message again, the header has probably become corrupted. The most
common cause of header corruption is a communication problem during launch, such
as the USB cable coming loose or an optical logger slipping out of its base
station/coupler while the Launching Logger progress bar is displayed. In that case,
there is a possibility that valid data has been logged, but cannot be read out.

You can restore the header by launching the logger or shuttle. This will reset the
device's launch options to factory defaults. However, it will also cause any logged data
or offloaded data from a shuttle to be lost. If you receive a "Read Header Failed"
message and are unable to read out the logger or offload a shuttle, please contact the
vendor that sold you the device. It may be possible to retrieve the logged data.
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Repeating an Action on Multiple U-
Series Devices

NOTE: This feature is only available with HOBOware Pro.

If you have many U-Series devices, the Default Action option on the Device menu may
help you work more efficiently. The Default Action function can save you the most time
when you are launching many loggers, especially if the loggers are the same model and
will have similar launch settings.

NOTE: This feature is available only for U-Series devices.

Description

By default, HOBOware does not take any action when you connect a device. You can
change the Default Action to Launch, Readout, or Get Status and HOBOware Pro will
perform that action each time you connect a device.

For example, if you choose Readout and then you connect a logger, HOBOware Pro will
read out that logger immediately. You can then disconnect that logger, connect another
logger, and that logger will be read out automatically. If you connect a shuttle, the
shuttle's new files will be offloaded automatically.

The Default Action only works when a single device is plugged in.

Steps

1. Setthe Default Action to Launch.
2. Go to Preferences > General > Launch Time-Saving Options

3. Select the Fill launch window with contents of option.

Each time you connect a logger, the Launch window will open. If the logger is the same
model as the last logger launched, the Launch window will be populated with the
settings from the previous launch, and an indicator on the upper-right corner of the
Launch window will remind you that the Previous launch preference is in use.

Important Note for Windows: The first time you connect a device the Default Action
may not be triggered. After the device has been connected to the computer and
disconnected at least once, the Default Action should be triggered.
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Linear Scaling

Introduction

Linear scaling allows you to convert recorded logger data to some other measurement
by entering new values that correspond with the logged values. The conversion must
be based on a linear relationship. If the relationship is based on a curve, linear scaling
will not give accurate results.

For information about linear scaling of FlexSmart modules or Analog Sensor Ports
(HOBOware Pro only), see Chapter 5. For information about the Linear Scaling
Assistant (HOBOware Pro only), refer to the Linear Scaling Assistant User's Guide.

Steps

You access the Linear Scaling window from the Launch window.
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1. Select a channel name in the Channel list.
2. Click the Scale Channel box to activate scaling for that channel.

3. Enter a descriptive name for the new, scaled channel in the Scaled Channel
Name field.

4. In the Parameters section, enter the units name for the Scaled series, and enter
the scaled values in the Scaled column to correspond with the numbers in the
Raw column. These values are used to establish a linear relationship between
raw and scaled values.

The default values in the Raw column are based on the high and low values
supported by the input cable, but you may use different values, as long as those
values fall within the cable's range.

5. To setup linear scaling for another channel, repeat from step 3, or click OK if
done to the Launch window.
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The small icon = next to the input cable name will now be colored green to indicate
that linear scaling has been set up.

When you read out the logger, the new, scaled series will be listed in the Plot Setup
window along with any other channels you logged.
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Data Assistants Window

If you run a Data Assistant from the Launch window, you can create parameter sets,
which are applied automatically each time you read out the logger. Once you have pre-
defined a parameter set, the parameters are also used when current readings are
viewed in the Status window.

If you are not already in the Data Assistants window, click the Data Assistants button
on the Launch window.
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The Data Assistants box shows all Data Assistants available for the logger.

The Parameter Sets box shows all parameter sets that have been configured.

Help: Click this button to access the Help for this window.

B W b

Select a Data Assistant name and click Create to create a new parameter set (or
double-click the Data Assistant name).

5. To edit an existing parameter set, select it and click the Edit button (or double-
click the Parameter Set name).

6. To delete an existing parameter set, select it and click the Delete button.
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Configuring Alarms

Overview

HOBOware can be used to configure alarms for the following loggers:

e HOBO Temperature/Alarm Data Logger (model UA-001)
e HOBO U14 LCD Logger
e HOBO U30 Station

If alarms are available for your logger, you will see an Alarms button on the Launch
window. Click the button to access the Alarms window.

Built-in alarm indicators are triggered when data is logged above or below values that
you define. You can set up alarms to be triggered when the data has been above or
below an allowed value for a specified amount of time, or when the data has been
logged above or below an allowed value for a specified number of times throughout the
deployment.

For details on configuring alarms for the HOBO Temperature/Alarm Data Logger, see
The Alarms Window topic.

For details on configuring alarms for other loggers, see the logger's user manual.

Alarm and Readout Tool

If you have a HOBOware-compatible logger without built-in alarm capability, you can
use Onset's Alarm & Readout Tool to monitor loggers for alarm conditions. When
alarms are tripped, the software notifies you by e-mail, mobile phone text message, or

pager.
For more information, see:

http://www.onsetcomp.com/products/software/bhw-t-alrm
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The Alarms Window for the HOBO
Temperature/Alarm Logger

This topic documents the Alarms window for the HOBO Temperature/Alarm Data
Logger (model UA-001). For other loggers, see the logger's user manual for details
about alarms.

Description

Use the Alarm feature to flash a warning on the LCD if monitored sensor falls outside
user-selectable limits. If the reading measured by the logger falls outside the selected
high or low limit, the word Alert, an alert symbol, and the reading that went out of
limits will flash.

If you require remote or secondary notification of an alarm condition, you can connect
aremote audio alarm and/or an Automatic Dialer to the contact closure.

You access the Alarms window from the Launch window.

Also see Configuring Alarms 58.

Alarms Window

Channel: Tesperature 10K Thermistor (°F) @
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1. Channel
Indicates the channel.

2. Enable Alarms
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Select the check box for the High Alarm and/or the Low Alarm. Enter a value to
define the alarm threshold. You can enter a value in the box or use the sliders. (If
you enter values manually, the software may adjust them slightly to the nearest
values compatible with the logger.)

3. Samples
Enter the number of samples that are needed to trigger each alarm.
4. Alarm Mode

Cumulative - alarm will be triggered after a specific number of samples have
been logged above or below an allowed value, even if the samples are not logged
consecutively.

Consecutive - alarm will be triggered only when the value has been above or
below an allowed value for a specific amount of time. If the value goes back in
range before triggering the alarm, the count is reset.

5. OK- Click OK when done.
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Configuring Alarms for the HOBO
Temperature/Alarm Data

The following procedure is for configuring alarms for the HOBO Temperature/Alarm
Data Logger.

For U14 or U30 alarm configuration, see the logger's user manual.

Steps

To set up the alarms:

1.

From the Launch window, select a channel that can be configured with alarms (it

will have a small bell icon a next to it) and click the Alarms button to access
the Alarm window.

Select the High Alarm and/or Low Alarm. Use the sliders to set the values that
will trigger the high and low alarms, or enter the values manually. (If you enter
values manually, the software may adjust them slightly to the nearest values
compatible with the logger.)

In the Number of out-of-range samples logged before alarm raised fields,
enter the number of samples that are needed to trigger each alarm.

Select an alarm mode:

e Choose Cumulative if you want the alarm to be triggered after a specific
number of samples have been logged above or below an allowed value,
even if the samples are not logged consecutively.

e Choose Consecutive if you want the alarm to be triggered only when the
value has been above or below an allowed value for a specific amount of
time. If the value goes back in range before triggering the alarm, the count
is reset.

Click OK to return to the Launch window and proceed as usual. The small bell

icon -.-will now be colored green to indicate that the alarm has been set. Refer
to the logger's manual for information about how the logger responds when the
alarm is triggered.
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Checking Device Status

The Status window displays real-time information about the attached logger, including:

e state of the logger
e time logging will begin
e current readings

e logger memory used

You can check the status for a logger whether it is waiting for logging to begin, actively
logging (unless it is logging at a fast logging interval), or stopped.

NOTE (HOBOware Pro): When a Station logger is logging, HOBOware can only display
the last sample taken by the logger, at the last interval.

Important: Battery power is drained more rapidly while checking status. Keep this in
mind when frequently checking status during a deployment. You can significantly
reduce the demand on the battery by adjusting the Screen Refresh Interval to five
seconds or higher (not available on all loggers).

Steps
To check the status of a logger:

1. Connect the logger to the computer.
Gl
2. Click the Status icon on the toolbar, or choose Status from the Device menu.

You can also access the Status window by clicking the Status button on the
Launch window.
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This topic describes the elements in the Status window:
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Device Identification: Includes device type and serial number.

Current Readings: Shows current readings for attached sensors.

Device Details: Includes Battery Level, Memory Used, Current Status, and Current

State.

OK Button: Click to close the Status window.

Help: Click to launch the Help for the Status window.

Identification

Device - Logger model and description.

Manufacturer - Manufacturer of the logger.

Description - Description entered when the logger was last launched. This
description will be used as the default file name and the title in the graph.

Serial Number - Serial number of the logger.

Firmware Version - Version number of the logger's firmware.
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Contact HOBOIlink (HOBO U30 Station Only)

For the HOBO U30 Station only, a Contact HOBOlink button appears at the bottom of
the Status window. Click this button when you want the HOBO U30 Station to connect
to HOBOlink. When you click Contact HOBOIink, a confirmation message is displayed.
Once you click Yes, the Status screen will close and then the HOBO U30 Station will
attempt to connect to HOBOlink within 30 seconds. A warning may appear in the event
that a live connection with HOBOlink is already underway.

Device Details

This topic describes the elements of the Device Details section of the Status window.

Battery Level/Battery State
Condition of the battery. Consult the logger documentation for specifics on battery
capacity.
Memory Used
Percentage of the logger's memory that is full.
Note: If the battery died while the logger was logging, this will be 100% even if only a

small amount of the memory was used.

Wrap Around When Full (HOBOware Pro Only)

e Enabled
e Disabled
Wrap Count

For Station loggers only, this indicator lists the number of times the logger has
wrapped, if wrapping is enabled.

Current Status
Messages that describe the state of the logger.

For the HOBO U30 Station (HOBOware Pro only) the current state of the relay is also
noted. After the state of the logger, the message “Relay is open” or “Relay is closed” will
display.

e Awaiting Button/Coupler Start
The logger has been launched with a trigger start (if available). Press and hold
down the button on the logger for three seconds to begin logging, or follow the
instructions that came with your logger if it offers a triggered start but does not
have a button. If the logger has a light, the light will flash quickly when logging
begins.
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e Awaiting Delayed Start
The logger will begin recording data at a specific time because either Delayed
Start or Start at Interval was chosen at launch.

e Launched, Logging
The logger has been launched and is actively recording data.

e Logger Is Full
The logger has reached its memory capacity and is no longer recording data.

e Logger is stopped
The logger is not logging, is not full, and is not awaiting a delayed or trigger start.

e On Hold for Later Launch (HOBOware Pro only)
The logger has been launched with a Save Settings start (if available). Logging is
not scheduled to begin, but the launch settings have been entered and saved.

Last Launched

Date, time, and offset to Greenwich Mean Time (GMT), also known as Coordinated
Universal Time (UTC), when the logger was last launched. This is not necessarily the
time when the first sample was recorded; it is the time all of the launch parameters
were loaded in the logger.

Delayed Start (if applicable)

If the logger has been launched, but is waiting for a delayed or interval start, the
scheduled start time is shown here in local time.

Deployment Number

Number of times the logger has been launched. The number listed includes the most
recent launch.

Logging Interval

Rate at which the logger was set up to record data the last time the logger was
launched, if applicable. If multiple logging intervals are available for your logger, the
interval currently in use (if the logger is logging) will be shown in bold.

Sampling Interval (HOBOware Pro only)

For station loggers only, this is the sampling interval that was entered the last time the
logger was launched, if applicable.

Current States (U-Series loggers except the U30)

If your logger has an event button, most often the current state will be Button Up,
meaning the button is not being pressed.

Current Readings

This topic describes the elements of the Current Readings section of the Status window.
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Screen Refresh Interval

Frequency with which the Current Readings are updated, up to 3600 seconds (one
hour). A higher number means less stress on the logger's battery. The Status icon blinks
when the readings are updated.

Note: For event/state loggers, the interval is set to 0.5 seconds and cannot be adjusted.
This ensures that you do not miss events and state changes that take place between
refreshes.

Tilt meters (not labeled)

For acceleration loggers only, color-coded meters display X, Y, and Z-axis tilt (relative
to vertical, assuming that the only acceleration force on the logger is gravity)
graphically.

Sensor Readings

Sensor readings, updated in real time.

NOTES

Readings are displayed for all available sensors, even if they are not being logged.
If a channel is not being logged, its name is dimmed in the display.

If a logger has channels for external sensors, a description and reading will be
given for the external channels even if no sensors are plugged in.

If a U-Series logger (other than a HOBO U30 Station) has channels for external
sensors, a description and reading will be given for the external channels even if
no sensors are plugged in.

For event loggers, the event count in the Current Readings box will always start
at zero, even if many events have already been logged.

(HOBOware Pro) For station loggers, the location (if defined) is displayed next to
the reading.

(HOBOware Pro) If a HOBO U30 Station has an Analog Sensor Port, readings for
one or both channels are displayed.

(HOBOware Pro) The RSSI (Signal Level) is displayed for the HOBO U30/GSM
Station. This helps you determine if there is enough signal strength in the current
location for the HOBO U30 Station to contact a cellular tower for connecting with
HOBOlink. Signal level is measured on a scale of 0 to 10, with 0 being no signal, 1
being a weak signal, and 10 being a strong signal.

The battery voltage is displayed for some loggers.
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Chapter 3: Using HOBOware to
Plot & Analyze Data

Reading Out Data from a Logger

To retrieve data recorded by a logger, you must read out the logger. Reading out the
logger copies data from the logger to your computer, allowing you to save the data in a
datafile and view the plot.

During readout, the logger continues to record data unless you have stopped the logger
or the logger is full.

Steps
To read out a logger:

1. Connect the logger to the computer.

2. Click the Readout icon |]_¢J on the toolbar, or choose Readout from the Device
menu. If the logger is still logging, a message asks whether you want to stop the
logger.

Tip: If you do not want to be prompted to stop the logger every time you read
out a logging logger, go to Preferences > General > Readout Time-Saving
Options and deselect the Ask to stop logging before reading out a running logger
option.

Wait while the data is read out from the logger.

3. When HOBOware prompts you to save the data, accept the default location and
name, or enter a new name and click Save.

By default, the data is saved in the HOBOware folder located in the My Documents
directory (or Documents on a Mac), with the following extensions:

HOBOware Lite

e Most U-Series Loggers: .hobo
HOBOware Pro

o Most U-Series Loggers: .hobo or .hsec

e Station Loggers: .dtf or .dsec

If you save the file to a different folder, HOBOware will make that folder its new default.
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HOBOware Pro Tip: To bypass the Save window every time you read out a logger, see
Read Out Time Saving Options on page 69.

The Plot Setup window appears. See Plotting Data.
HOBOware Pro Tip: Bypassing the Plot Setup window.

If you would like to bypass the Plot Setup window every time you read out a logger, go
to Preferences > General > Readout Time-Saving Options and select When plotting:
Automatically plot, which bypasses the Plot Setup window and displays the plot with
default selections). Select Do not plot if you do not want to display plots while reading
out the logger. If you do not want to display plots while reading out loggers, select Do
not plot.

If you would like to bypass the Plot Setup window when opening datafiles, go to

Preferences > General > Readout Time-Saving Options and choose Automatically
plot.
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Readout Time-Saving Options

Use the Readout Time-Saving Preferences to disable certain user interaction that will
make it easier to perform readout functions such as saving datafiles and plotting data.

You access the Readout Time-Saving Options by going to File > Preferences > General
> Readout Time-Saving Options

Y Readout Time-Saving Dptions

When saving datafile; | Show save dialog A4

When plotting: | Show plot setup A4

fisk b stop logging before reading out a running logger

When saving datafile

Show save window(default)

HOBOware Pro displays a Save window after you read out a file. This
allows you to specify a location and name for the file, or decline to save the
file.

Automatically save

Select this option if you want to skip the Save window. The file will be
saved automatically with a default name (based on the launch description)
and in the default location.

When plotting

Show plot setup (default)

After reading out a logger and being prompted to save the datafile,
HOBOware Pro displays the Plot Setup window.

Automatically plot

Select this option to bypass the Plot Setup window (including Data
Assistants) and plot automatically

Do not plot

Choose this option to skip the Plot Setup window without displaying the
plot. This is useful if you are reading out many loggers now and prefer to
look at the plots later.

Ask to stop logging before reading out a running logger

A prompt appears every time you read out a logger that is logging, asking
whether you want to stop the logger or let it continue logging data during
readout.

If you disable this option, the logger will always continue logging during readout.
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Reading out Multiple Loggers

When used in conjunction with a Default Action of Readout, the Readout Time-Saving
Options allow you to read out many U-Series loggers in a row simply by plugging and
unplugging individual loggers. To do this, set these options as follows:

When saving datafile: Automatically save
When plotting: Do not plot
Ask to stop logging...: Disabled (unchecked)

Then, from the Device menu, choose a Default Action of Readout. (The Default Action
will reset to Do Nothing the next time you start HOBOware Pro.)
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Setting up a Plot

After you read out a logger, the Plot Setup window appears. Follow this procedure to
set up a plot.
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Steps

5.

Select the series you wish to view on the plot.

Click each checkbox individually to select or clear sensor measurements, states,
and events, or click the All or None buttons to select or clear all sensor
measurements, states, and events.

Select the units you want to display for each series, if available.

Select Internal Events to plot, if applicable for your logger.

Adjust the time zone offset, if necessary.

By default, data is shown in the offset used to launch the logger with HOBOware
(not a shuttle). To select a different offset, enter the hours offset from GMT (UTC)
in decimal form. You may find this useful if you logged in multiple time zones, or
if you took the logger to a different time zone after launching it.

HOBOware Pro Only: If data assistants are available, you can use them to create
additional series. Select an assistant from the list and click Process.

When you have made your selections, click the Plot button.

The plot is displayed.
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Data Types in Plots

Four kinds of data can be displayed on a plot:

Sensor measurements

Sensor measurements include the channels you selected to log at an interval during the
launch, such as temperature, RH, or battery voltage. This type of data series consists of
all the logged data points for that channel. In addition, if the logger recorded both
temperature and RH, a dew point series can be plotted.

States

States are condition changes that can be recorded at any time during deployment,
regardless of the logging interval (if any). Only state loggers, such as the U9 and U11,
can record state changes.

External Events

External Events are momentary switch closures (e.g., from turnstiles) that are recorded
by loggers with external event channels, such as the U11 logger.

Internal logger Events

Internal Logger Events are individually logged occurrences that can be recorded at any
time during deployment, regardless of the logging interval. U-Series loggers (Other
than the HOBO U30 Station) record internal logger events.

Examples of internal logger events include:

End of File: Marks the last record that was found in the logger.

Bad Battery: Time the battery capacity fell to an extremely low level (if
applicable). If you see a Bad Battery event, replace the battery before deploying
the logger again.

Stopped: Time the logger was manually stopped with HOBOware.
Host Connected: Time the logger was connected to the computer.

Coupler Connected/Coupler Disconnected: Time the logger was connected or
disconnected from the coupler, if the logger uses a coupler to communicate with
the computer.

Button Down/Button Up: For U-Series loggers that have event buttons, each
button push of at least one second is logged as a Button Down event and a Button
Up event.

Interval Change: For loggers that can be configured with multiple logging
intervals, an Interval Change event marks the moment when a new logging
interval began.
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Opening Files

The following files can be opened by HOBOware Pro:

e _hobo - Including files created with Onset's GreenLine software and both
Macintosh and Windows -compatible versions of HOBOware Lite and HOBOware
Pro.

o _hsec- Secure files (21 CFR Part 11 Conformance) for U-Series loggers.
e _hproj - HOBOware Project.

e . dtf - Files with an extension of .dtf must come from a HOBO U30 Station,
Weather Station, Micro Station, or Energy Logger. Other .dtf files are not
compatible with HOBOware Pro.

e .dsec- Secure Files (21 CFR Part 11 Conformance) for Station loggers.

e .txt/.csv - .txt or .csv files, as well as most ASCII files, can be imported.

Steps
To open a file:

From Windows Desktop or Mac Finder

Double-click a compatible file. HOBOware automatically launches itself (if it is not open
already) and opens the file.

From HOBOware
Click the Open icon L lon the toolbar, or choose Open Datafile from the File menu.
Select a file or multiple files and click Open.

Complete the Plot Setup window to select the items you wish to view in the plot. Then
click the Plot button. The plot is displayed. If you selected multiple files, you will be
prompted with a Plot Setup window for each file.

Tip: If you never use data assistants or change time zones, and would like to bypass the
Plot Setup window every time you open a datafile, go to Preferences > General >
Open File Time-Saving Options and select When opening a datafile: Automatically
plot. This displays the plot with default Plot Setup selections.

Project Files

To open a project file, choose Open Project from the File menu. Then select a project
(-hproj) file and click Open.

Click the File menu and select a recently opened datafile or project file from the Recent
Files list.
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Related Topic
Opening Files from Unsupported Loggers
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Opening Files from Unsupported
Loggers

Although the following loggers cannot be launched or read out using HOBOware, data
files from these loggers can be opened and plotted by HOBOware Pro and HOBOware
Lite. All graphing tools, filters, and Data Assistants can be used with the files and data
can be exported to text and XML project files.

HO8 (8-bit)
e HO08-001-04
e HO08-002-04
e H08-003-04
e HO08-004-04
e H08-006-04
e H08-008-04

TBI/ZWTA

TBI32-05+37
TBI32-20+50
WTAO08-05+37
WTAO08-39+75
WTA32-05+37
WTA32-39+75

HO8 (12-bit)

e HO08-030-08

e H08-031-08

e H08-032-08
H20

e H20-001
HO6

e H06-001-02

e H06-002-02

e H06-003-02

e H06-004-02
HO7

e H07-001-02

e H07-001-04
H14

e H14-001

e H14-002
H12
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e H12-001
e H12-002
H12-003
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Using the Toolbar and the Plot
Menu

This topic covers the ways in which you can modify a plot using the Tool Bar and the
Plot menu.
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1. Tools

Use the tools in the tool bar to perform a number of operations on the plot.
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Arrow  Hand Subset
tool tonl  statistics tool

%-E-@?C‘lﬁ

Crosshair Zoom
tool tool

e Use the Arrow tool to point to and select items on the graph to edit their
properties

e Use the Crosshair tool to zero in on a specific date and time in the plot and
any data points associated with that date and time.

o Use the Hand tool to move different areas of the graph into view or adjust
the position of one series so it can be viewed more easily. This is
particularly useful when you are zoomed into the graph and want to see
another section of the graph without zooming out and then zooming back
in on the new location.

e Use the Zoom tool to focus on one area of the graph, allowing you to see
more detail.

o Use the Subset Statistics tool to view statistics for a particular time span.
2. Actions

Use the Actions buttons to perform a number of actions on a plot or a
series.

Open properties Show/Hide  Filter
Zoom infout window point markers series

\ .

—

%%%@M@@Eu&

Show graph at Show/Hide Convert Add
full scale gridiines units  graph label

Click the Open properties icon to open the properties window for the plot
element that is currently selected (such as gridlines, legend, axis).

Use the Gridline icons to toggle all horizontal or all vertical gridlines on and off.

You can also toggle gridlines on and off for each axis individually. Using the
arrow tool, double-click an axis to get the Axis Properties window. Check
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the Show Gridlines box to display gridlines for that axis, or clear the Show
Gridlines box to hide the gridlines.

Click the Convert units icon to open the Convert Plot window, which allows you
to convert some or all of the series on the currently focused plot to other units
(for example, from degrees Fahrenheit to degrees Celsius).

Click the Filter series icon to open the Filter Series window. See Filtering a
Series on a page 103 for information.

Click the Add Graph Label button to label a graph.
Plot Menu

Right-click a series or an empty area in the plot to open a menu of options for
modifying the series or plot. Available options depend on whether you click on a
series or an empty area of the plot.

NOTE: You can also access these options in the View and Edit menus from the
main menu.

To move a series to the front or back, select the series, right-click and select
either Bring Series to Front or Send Series to Back. This is helpful if one series is
hidden behind another. It also changes the order of series in the Details pane,
Points table, and the legend.

NOTE: After you adjust the order of the series for optimal viewing, copy the
graph as a bitmap to paste into other programs, such as Microsoft Word or
PowerPoint®.
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Setting Series and Plot Properties

This topic covers some of the ways you can modify a plot or a series using properties.

To change properties for all plots, see Setting Properties for all Plots on page 82.
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View Properties

Double-click in an empty area of the plot to open the View Properties window,
where you can show or hide the legend, plot title, and borders.

Title Properties

Double-click the Plot Title to open the Title Properties window, where you can
change the title name, location, and font.

Legend Properties

Double-click the legend to open the Legend Properties window, where you can
add a label to the legend, change its position, and show or hide the border.

Series Properties

Double-click on a series to open the Series Properties window. See Setting Series
Properties on page 87 for more information.

Axis Properties

Double-click on one of the axis to open the Axis Properties window. See Setting
Axis Properties on page 85 for more information.
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Setting Properties for all Plots

This topic outlines preferences that you can apply to all plots that you generate or open
in HOBOware. To access plotting preferences, from the main menu select Preferences
and then click the Plotting tab.

®» @ O ©

Set Date/Time Set Units Customize Show/Hide Include Sensor
Format Fonts Gridlines Labels in Legend

iy e Doata.okf

. & Time, GMT-05:00 Solw Radation, Win®  Temp, *F  RH, %
Show/Hide I TR N [T 720 - |
Points Table 5 e a5 1350 et al
[ o ] [ roce st .
Dt
. S o Serud: Solss Rackation, ¥
Show/Hide e
Details Pane ek b1
T Series Sstistics a
5 Serws 'I-rng-_.'i ! .'. 5?"
Include Sensor Label 4~ I ¥y
in F'omtsl Table and A g e i
Details Pane il o Sarak: B, e
i -
Customize ]
Series Lines
1o
Apply Min/Max to
¥- Axis Bounds

130
4 > L0880 D0 1A GAIT 08 00

@ Enable Auto-scroll to @ Plot Setup Show Time Mark Paints
Point Outside Range Axis Label @ {not shown)
1. Show/Hide Points Table

In the Layout section of the Plotting Preferences you can control the display of
the Points Table.

2. Show/Hide Details Pane

In the Layout section of the Plotting Preferences you can control the display of
the Details Pane.

3. Include Sensor Label in Points Table and Details Pane

By default, labels added for station-type loggers are shown in the Points and
Details panes. If you do not want to include the label, deselect Use sensor Location
in the Points Table & Details Pane section of the Plotting Preferences.

4. Customize Series Lines
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Use the lines preferences to define the appearance of lines in the plot for a
specific series type.

Apply Min/Max to Y-Axis Bounds

Use the Y-Axis Preferences to apply a minimum and maximum value for the Y-
Axis to for plots for a specific series type.

Enable Auto Scrolling

Normally, if you are zoom in and click a point in the Points table that is outside
the zoom area, the plot will scroll so that the marked point is in view, while
retaining your zoom factor. Uncheck the When selected value in table is out of plot
range, drag series to that value box if you do not want to scroll to points outside
of the current view.

Plot Setup

The Plot Setup section of the Plotting Preferences gives you two options when
generating a plot:

e Automatically select all data series for plotting

e Automatically select internal events for plotting

Label Time Axis

By default, the time axis is not labeled when you display a plot. If you enable this
preference, the time axis will have a default name of "Time" when you open a
plot.

Mark Points

By default, points on a series are not marked. To have all points marked by
default, go to Preferences > Plotting > Other Options and select the Mark all
points when plotting data option. NOTE: Opening a large plot with all points
marked takes longer and consumes more system memory

Include Sensor Labels in Legend

If alabel has been assigned to a sensor, include it in the legend.

Show/Hide Gridlines

By default, vertical gridlines are always shown for the time axes; horizontal

|
gridlines are not shown. You can use the gridline icons lﬁl and lﬁl on the
toolbar, or the Gridlines item on the View menu, to toggle all horizontal or all
vertical gridlines on and off.

You may also toggle gridlines on and off for each axis individually. Using the
arrow tool, double-click an axis to get the Axis Properties window. Check the
Show Gridlines box to display gridlines for that axis, or clear the Show Gridlines
box to hide the gridlines.

Go to Preferences > Plotting > Gridlines to control whether plots open with
horizontal and/or vertical gridlines displayed.
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12. Customize Fonts

By default, most text in a graph is 9 points. To re-size the font (from 8 to 14
points), go to Preferences > Plotting > Fonts.

13. Set Units

This setting allows you to set a default of US or SI (Metric) units throughout
HOBOware .

14. Set Time Format

Configure the date and time to your desired format.
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Setting AXis Properties

To change the axis properties, double-click the axis you wish to modify with the arrow

g

tool, or select the axis and click the Properties icon ‘—’

The Axis Properties window appears.
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1. Name

Enter up to a 40-character name for the axis. The default name for a value axis is
the unit type (for example, "°F" is the name for a temperature axis and "%" is the
name for an RH axis).

Normally, the time axis is not named when you display a plot. If you want plots to
open with the time axis labeled as "Time" by default, change the setting in
Preferences > Plotting > Other Options.

2. Location

Change the location of the axis. The time axis can be located at the top or bottom.
The value axes can be located on the left or right.

3. Tick Marks

Tick marks are the lines that represent values on the axis. Numbers or values are
listed next to major tick marks; minor tick marks are not numbered

e Auto Calculate Tick Marks

By default, tick marks are automatically calculated for both the time and
value axes.

e (Custom Tick Marks
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Choose this option to specify different major and minor tick marks for the
axis.

4. Bounds

Min: Enter the minimum value you want displayed for the axis. For the time axis,
you can select a date and time.

Max: Enter the maximum value you want displayed for the axis. For the time axis,
you can select a date and time.

5. Miscellaneous

e Show Gridlines: Toggles whether gridlines are displayed in the background. By
default, gridlines are shown for the time axis only.

o Hide Axis: Toggles whether the axis is displayed or temporarily hidden. Axes for
sensor series are visible by default.

e Lock Axis Scaling and Tick Marks: Toggles whether the axis and associated tick
marks remain in the original position when zooming or navigating with the hand
tool. Locking the axis and tick marks helps to avoid inadvertently zooming or
navigating to an area on the graph without data.

e Color: Changes the color of the axis. Black is the default color for the time axis.
The color of the value axis matches the series color by default.
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Series Properties Window

A series is the group of data points for the sensor measurement, state, or event you
selected to display in the plot. To change series properties, double-click the series you

g

wish to modify or select the series and click the Properties icon l—l on the main menu.
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The following options are available in the Series Properties window:

1.

Description: Enter up to a 40-character name for the series. The series name is
displayed in the legend. The default name for a series with sensor data is the
property that was measured and the units used to display the measurements.
The default name for a series with event or state data is the type of event or
state.

Units: Enter the unit type in this field, if it is different from the default. If, while
viewing the plot, you convert to another type of unit, the text you enter here will
change to the default name for the unit you chose.

Lines Section

Connect Points: Toggles whether the points in this series are connected. This
option is selected by default for most series; it is not selected for internal logger
events.

Style: Changes the appearance of the line used to connect the points in a series.
The default varies depending on how many series measuring the same property
are being viewed.

Width: Changes the size or weight of the line used to connect the points in a
series. The default is 1 point.
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Connect as Steps: Toggles whether the lines between the points in a series are
connected as a curve or a step. When this option is selected, the line drawn
between points keeps the value of the previous point until the next point in the
series. This is useful for state or event graphs. This option is not selected by
default for sensor series.

4. Alarms Section
Enable Alarms: Alarms are available for sensor measurement series only, not
state or event series.

Enabling alarms will show lines on the graph for this series, to indicate a visual
threshold over or under which data may be falling (for example, if you want to
quickly see how many points fall below 32 degrees). Alarms are turned off by
default.

For High Alarm, enter a value relative to the series where you want the maximum
(red) alarm line to appear.

For Low Alarm, enter a value relative to the series where you want the minimum
(blue) alarm line to appear.

5. Points Section

Mark Points: If you enable Mark Points a marker appears at each data point in
this series. By default, this option is selected for any series with event data or
only one point. To avoid cluttering the graph, it is not selected by default for
other series.

Marker: Changes the shape of the marker used. The default marker varies
depending on how many series are being viewed.

Point size: Changes the point size for the marker.
6. Miscellaneous Section

Time Axis: Allows you to create an additional time axis for this series. This is
useful when you want to compare data from two different time periods.

Value Axis: Changes the axis being used for the series. Choose one of the axes
already in view, or select New Value Axis from the dropdown list to create your
own.

Color: Changes the color used for the series. The default color varies depending
on how many series are displayed on the graph.
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Adding a Graph Label

You can add multiple labels to a graph to identify specific points or call attention to a
region of the graph.

1. Right-click the graph at the desired location and choose Add Graph Label from
the pop-up menu

(Alternative: Choose Add Graph Label from the Edit menu)

NOTE: To change an existing label's properties, double-click the label or select

the label and click the Properties icon on the main menu.

The Graph Label Properties window appears.
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2. Enter values in the Label Properties window as required. See Setting Label
Properties for more information.

e Label Text - Enter up to a 24-character name for the label.
e Behavior

Attach to Series: To attach the label to a point on a series, check this box and
choose the name of the series from the drop-down list. (After you exit this

window, you can use the hand tool M to drag the label to the correct point.)
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Include Data Value in Label: If the label is attached to a series, check this box to
have the label show the value of the labeled point.

Location: If the label is attached to a series, choose a compass point to describe
the preferred position of the label relative to the labeled point.

Important: The Location indicates the preferred location of the label (space
permitting) with respect to the data point it references. This is available only
when the label is attached to a series.

e Appearance
Draw Label Over Colored Background: Check this box if you want the label to
appear in a box with a colored background.

Label Color Background: If you chose to give the label a colored background, click
this button to select a background color.

Label Color Text: Click this button to select a color for the label text.

% Transparency: Adjust the label's transparency. Transparency refers to the
ability to see the graph through the label. At 0%, the label is opaque, and you
cannot see the graph through it. At 100%, the label is invisible, and only the
graph can be seen.

Font: Select a font for the label text.

Font Size: Select a font size for the label text.

2. Click the Apply button to apply the new label and keep the window open so you
can add more labels.

3. Position Labels

Use the Hand tool to drag labels to another location if required.

If the label is attached to a series, you can drag the label to attach it to any other
point on the graph. (The hand tool must be close enough to a point to attach the
label.) Labels that are attached to a point will move with that point during
zooming and panning. Free-floating labels do not move during zooming and
panning.

4. When you have completed adding labels, click Done to close the window.

Deleting a Label

To delete a label from the graph, select the label you wish to remove and press the
Delete key (Fn-Delete on a laptop computer), or right-click the label and choose
Remove from the menu that appears.

-90 -



HOBOware User’s Guide

Zooming, Panning, & Smart Scaling
Plots

You can adjust the viewing area of the plot by zooming, panning, and smart scaling.
There are two ways to zoom: either by using the zoom tool Qor by selecting Zoom In

Id%or Zoom Out % from the toolbar or the View menu. Use the zoom tool to zoom
anywhere on the plot that you select, clicking the right-mouse button to zoom in or out.
Use the Zoom In/Zoom Out icons to keep the plot centered as you zoom. To constrain
the zoom to horizontal or vertical zooming, place the cursor over the axis you want to
zoom and click the mouse button. Hold the mouse button down to continue to zoom.
Click the right-mouse button to switch from zooming in to zooming out, and click it
again to switch back.

Use the hand tool &/ to pan the graph, which is dragging the plot viewing area along the
X- or y-axis. Panning is especially helpful when you are zoomed into a detailed plot and
want to focus on a different area without zooming out. To limit dragging to horizontal
or vertical panning, place the cursor over the axis you want to drag, hold down the
mouse button, and drag in the direction you want the plot to move.

When you first display a graph, the numerical bounds of the axes are on tick marks.
After you have panned or zoomed, this may no longer be the case. Use smart scaling to
correct that. With the hand, arrow, or crosshair tool, right-click anywhere on the graph
and select SmartScale Graph. This will automatically adjust the axes to end on tick
marks.

Tip: You can always return to the original plot view by clicking the View at Full Scale

B
l—l—l from the toolbar or the View menu.
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Undoing and Redoing Plot Changes

You can undo and redo changes made to the plot display, including zooming, panning,
crosshair placement, graph and axis properties modifications, and more.

=
To undo the most recent change, click the Undo Action |_‘| icon on the toolbar or select
Undo Action from the Edit menu.

To redo the most recent change that had previously been undone, click the Redo Action
|i| icon on the toolbar or select Redo Action from the Edit menu.

When using the Edit menu for Undo or Redo, the most recent change is listed with the
menu choice. In the following example, the most recent change that can be undone is to
"Click Crosshair" and the most recent change that can be redone is to "Drag Plot."

121 HOBOware Pro
File Device BaslM Wiew Window Help

Filker Series

(,J:-J ILA L Copy Series: RH Chrl4C
Paste Series Chrl+y
add Graph Label, ..

Remove Series: RH Delete

[#| Eraph Properties

[fl Convert Units

|2 Undo Action: Click Crosshair Ctrl4-2
[ Redo Action: Drag Plok Crl+y

Copy Graph to Clipboard

HOBOware keeps track of the changes that you make within each plot window and
temporarily stores them as "undoable actions." To see a complete list of all the actions
that can be undone or redone, click the down arrow to the right of either icon on the
D| v |5 -

toolbar.
The number of undoable actions stored is set within the plot preferences. You can
configure HOBOware to either store a specific number of undoable actions or an
unlimited number. In addition, you can enable or disable the feature altogether. Note
that storing an unlimited number of actions can impact HOBOware performance on
slower computers.
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Printing Plot Elements

Printing a Graph

You can simply print the graph, or you can set up the page and preview it before
printing.

To set up the paper for printing the graph:
1. From the File menu, choose Page Setup.
2. Change the paper type, orientation, and margins as necessary and click OK.

3. To preview how the graph will look on the page: from the File menu, choose
Print Preview.

4. Zoom as necessary

5. Click the Print icon T to print directly from Print Preview. Or, click Close to exit
the preview window without printing.

To print the graph:

1. Click the Printicon ' on the toolbar, or choose Print from the File menu.

2. Select the appropriate printer, if applicable, and click OK.

Printing Points and Details

You can print all of the data in the Points or Details panes. From the File menu, select
Print Points (available only with Java 1.5 or higher) or Print Details.

If you highlight a selection of points with your mouse before choosing Print Points, you
will also be given the option to print only the selected points.
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Closing a Plot

Important: Property changes are not saved when you close the datafile. To preserve
these changes, you can paste a bitmap of the graph into other programs, or save
changes to the plot in a .hproj project file.

To close a plot, click the Close icon 2/5 on the toolbar, or choose Close from the File
menu.

To close a plot when you are in Tabbed View:

o Windows: click the Close icon on the tab of the plot.

e Mac: click the red button in the upper-left corner of the internal frame containing
the plot.

If you made changes to the plot and then attempt to close it, a message appears asking
if you wish to save your changes to a project file. Click Save to create an .hproj file.To
close all plots, choose Close All from the File menu.

NOTE: If you are sure that you do not want HOBOware to prompt you to save a plot as
a project file when you close it: go to Preferences > Warnings > General and clear the
checkmark next to "Prompt me if there is any remaining unsaved data when closing
plot or application.”
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Viewing a Plot

You can change your view of various aspects of the plot as you analyze the data.

Changing the Order of a Series

You can shuffle the order of series by moving a series to the front or back. This is
helpful if one series is hidden behind another. It also changes the order of series in the
Details pane, Points table, and the legend.

To change the order of the series:

1. Select the arrow tool [E from the toolbar.
2. Select the series you wish to move.

3. Right-click and select either Bring Series to Front or Send Series to Back.

NOTE: After you adjust the order of the series for optimal viewing, copy the graph as a
bitmap to paste into other programs, such as Microsoft Worde or PowerPointe.

Viewing Multiple Plots

Use the Window menu to organize several plots by Tabbed View , Tile Horizontally, or
Tile Vertically . See The Window Menu 197 for more details.
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Converting Units

Use the Convert Plot dialog to change the measurement units of multiple series in a
plot (where applicable).

Convert Plot E

Select units For all series Mote: Changing the units of the plat will result
in the entire plok being redrawn.,

Series Measurement Units
1 Temp b
2 Current &

3 Bakk W

Cancel H Conwerk ]

1. For each series that supports unit options, select the desired units from the drop-
down list

2. Click Convert.

This changes the units displayed on the axis, in the legend, in the Details pane, and in
the Points table.
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Viewing Subset Statistics

NOTE: The Subset Statistics feature is only available with HOBOware Pro.

The Subset Statistics feature allows you to select a range of data in a graph, and display
the maximum, minimum, average and standard deviation for the measurements in that
range.

Demo: To view a Demo on Viewing Subset Statistics, go to:
http://www.onsetcomp.com/BHW_GraphingAnalysis.

Steps
1. Select the Subset Statistics tool ﬂ from the toolbar:

Alternate Method: Press the S key on your keyboard when the mouse pointer is
on the graph.

The mouse cursor will become the Subset Statistics Tool icon ﬁ
2. Draw Subset

With the left mouse button, click within the graph to define the start time of the
subset and drag to the right. Release the mouse button when you reach the end
time of the subset.

The graph subset appears in the graph, and the subset statistics pane appears in
the left frame. See Overview of a Graph Subset for more information.

NOTE: When you first draw the subset, it is attached to the oldest time axis on
the graph (the time axis that was created when you displayed the plot).

3. Refine Subset Range

To refine the range of the subset, click the checkmark icon in the Subset Statistics
pane. This opens the Subset Statistics properties section of the Axis Properties
window. See Setting Subset Statistics Properties for more information.
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Overview of a Graph Subset

The Subset Statistics Tool allows you to select a subset of a graph, and display the
maximum, minimum, average and standard deviation for the measurements in that

range.

Related Topics
Viewing Subset Statistics

Setting Subset Statistics Properties
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Two vertical indicators (black) appear on the graph to show the range of the

subset.

To adjust the start or end of the subset, click and drag the left or right end of the
Edit Subset Bar. You can also use the arrow keys to move the left boundary, and
Ctrl+ (Windows) or Command- (Mac) arrow keys to move the right boundary.
Place the cursor in the middle of the bar and drag to move the entire range left or

right.

2. Subset Duration:

Alabeled horizontal indicator (blue) shows the duration of the subset. Use the up
and down arrows to move the horizontal indicator up or down.

3. Edit Subset Bar:
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Resizing/Moving Subset: Place the cursor in the middle of the bar and drag to
move the entire range left or right. Place the cursor at the edge of the bar to move
the range. If you have multiple time axes, click inside the subset statistics bar to
drag it to a different time axis.

Show/Hide Display: Double-click on the Edit Subset statistics bar to toggle
between showing and hiding the display of subset indicators and labels.

4. Subset Statistics pane: Summarizes the data within the subset.

5. Subset Statistics Properties: Click on the check mark to access the Subset
Statistics Properties window, which allows you to refine the subset to a precise
time range.

Removing the Subset

To remove the graph subset and related elements:

e Right-click on the graph and select Remove Subset Stats from the pop-up menu,
or

e Choose Remove Subset Stats from the View menu, or

e C(lick the X icon in the upper-right corner of the Subset Statistics pane.
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Setting Subset Statistics Properties

This topic describes the Subset Statistics section of the Axis Properties window, which
you use to refine the range of a subset of a graph that you created using the Subset

Statistics tool.

Related Topics

Viewing Subset Statistics

Overview of a Graph Subset

Subset Statistics Properties Window
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1. Show/Hide Subset Elements

Show subset statistics for time bounds below

Check this box to enable subset statistics for this time axis. Only one time
axis can have a subset. If you enable subset statistics for one time axis
when another time axis already has a subset, the other time axis's subset

will be removed.

Show times, duration, & vertical indicators on graph

Check this box to toggle the display of subset indicators and labels on the
graph. If you disable this option, the Subset Statistics pane and the shaded
subset statistics bar on the time axis will still remain visible.

2. Configure Subset Range
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The easiest method to set a range for the subset is to indicate a fixed Start
Date/Time or End Date/Time, and then indicate the duration.

Alternatively, you can enter both a Start Date/Time or End Date/Time without
specifying a duration

Example 1

To set a range beginning at 8:00 a.m. on 1/23/08 with a duration of 2 hours:

SN

Skart Date

1}23108

-

Example 2

oW

Skart Time

Check the Show subset statistics box.
Set the Start Date to 1/23/08

Set the Start Time to 08:00:00.000 AM
Check the Anchor Start Point box.

Set the Duration to 2 Hours.

End Date

Anchar Start Paint

Duration

Days | 2 % | Hrs | 0% | Mins

End Time

0 % | Secs 4—‘

To configure a range of 1 day prior to 10:00 PM on January 23, 2008:

Set the End Date to 1/23/08
Set the End Time to 10:00:00.000 PM
Check the Anchor End Point box.

Set the Duration to 1 Day.

Skart Date

Skart Time End Date
1/23j08|
Duration
1% | Days| 0% Hs | 0% Mns

-101 -

End Time
v | [10:00:00.000 PM %

anchor End Point

S0 % | Secs



HOBOware User’s Guide

-102 -



HOBOware User’s Guide

Filtering a Series

You can create a new series based on statistical analysis of an existing series over
specified periods of time.

NOTE: When you apply a filter, the graph rescales to accommodate all of the displayed
data.

Steps
To filter a series:

1. Access the Filter Series window.
Option 1: Choose the arrow tool Rﬁ select the series, right-click and choose Filter
Series from the pop-up menu.

Option 2: Click on the series and then from the Main Menu select Edit > Filter
Series

2. Choose the type of statistic to use for the filter:

For sensor series, you can create a series showing the minimum, maximum, or
average over a period of time.

For external event series, you can create a series showing a cumulative sum, or a
count over a period of time.

For internal event series, you can create a series showing a count over a period of
time.

For series created by Data Assistants (HOBOware Pro Only), additional filters
may be available.

3. Specify the interval over which you want these values to be calculated.
4. Enter a new Resultant Series Name, if desired.

5. Click OK.

The new series is added to the graph, the Details pane, and the Points pane.
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Cropping a Series

This feature allows you to remove data from a series by changing the time frame. You
can crop one or multiple series in a plot.

1. To crop multiple series, right-click anywhere in the plot (without a series
selected). To crop a single series, right-click on the series and select Crop Series.

View Properties. ..
Other Graph Ikems » ﬂ

w Show Title
v Show Legend

Add Graph Label. ..
Show Graph at Full Scale
SmartScale Graph

The Series to Crop window appears.

2. Select Time Range for cropped series (limited to the minimum and maximum
date and time of the Time Axis in the plot).

. Saart St b on
Deselect any series _—
you do not want to crop o A=
(m} - Frswaurs. Fiore |
1o Wi S

§ et Cuate St Tee Erel Dt Ered P -
S;;T“-:E : ————— ain0s 10000 ke & CRLe | | |3omo00 o005 Click OK to crop.
ng

3. Series to Crop
Deselect any series you do not want to crop.
4. Set Time Range

Define the boundaries of the new series (inclusive, and limited to the minimum
and maximum date and time of the Time Axis in the plot). If the stats tool has
been used on the plot, the stats tool start and end points will be selected by
default.

5. Click the OK button.
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The Selected Series will be cropped, as shown in the example below.

P ) : | e y | . e
M\ m.._ il \ 14 AL u-*r-f
W e R |

The Cropped Series will be indicated in the Details Pane, and the Points Table will
reflect the new time range.
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Merging Datafiles

This feature allows you to combine multiple datafiles from a deployment into one file.

Steps

1. Open the first file (oldest).

2. Select Merge Datafile(s) from the File menu.

131 HOBOware Pro
Edit

Device

Wiew  Window Help
1 Open Datafileds), ..

Merge Dakafilels). ..

3. Select the datafiles you want to merge.

4. Click Open.

The Merge Series Setup window appears.

See The Merge Series Setup window on page 181 for details.

Merged Series

The gap between the two series will appear as a line linking between the last sample in
the series and the first sample in the next series.

it Loving Cowak

After the series have been merged the Details Pane will be regenerated, Series Statistics
will be recalculated, and a new node will be added in the Deployment Info indicating
that the series has been merged with another series.
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The samples table will be regenerated and will show samples of both series in one
column. The different logger information is added to the tree, showing the specific
information about the different loggers that collected the data samples.
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Removing a Series from a Plot

You can remove sensor, state, and event data series from the plot. This is helpful if the
datafile contains multiple series and you cannot easily view them all together.

Steps
To remove a series from a plot:

1. Select the arrow tool Q from the toolbar.

2. Click the series you wish to remove and press the Delete key, or right-click the
series and choose Remove from the menu that appears.

On a laptop computer press Fn-Delete.

A warning appears, indicating that the only way to add the series back to the plotis to
reopen the plot.

3. Click Yes.

The series is removed from the graph, the Details pane, and the Points table.
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Introduction to Data Assistants

Overview

HOBOware Pro Data Assistants let you create new data series by combining data
recorded by the logger with additional data that you enter before you display the plot.
For example, the kWh Assistant converts logged pulse data from an energy transducer
to kWh, average kW, and energy cost.

All Data Assistants can be run from the Plot Setup window after you read out a logger
or open a datafile. With this method you need to run the Data Assistant each time you
read out the logger or open a datafile. Some Data Assistants (Pulse Scaling, Linear
Scaling, kWh) can also be run from the Launch window, so that parameters are applied
automatically each time you read out the logger or open a data file.

Installing a Data Assistant

Data Assistants are included in the HOBOware application. However, there may be
times when a new Data Assistant is released between HOBOware Pro releases. To
install a new Data Assistant, click the Load button on the Plot Setup window and select
the assistant's .jar file.

Software Updates

If you have an Internet connection, HOBOware Pro can periodically ask if you would
like it to check the Onset website for software updates. This includes updates to your
data assistants.

The default is to check once per week, but you can configure HOBOware Pro to check
daily or monthly. In Preferences, go to the General pane. Check for HOBOware updates
is located under the Startup heading.

You may check for updates manually at any time. Choose Check for Updates from the
Help menu.

License Agreement

This software is furnished in accordance with a separate license agreement included
with the software, and subject to any restrictions set forth therein. For more
information about Onset's licensing terms and policies, contact Onset Customer Service
at 1 800 LOGGERS, or visit http://www.onsetcomp.com/legal.
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Using Data Assistants

There are two methods for using Data Assistants:
e Plot Setup (all Data Assistants)

When you read out a logger, open a data file, or merge datafiles, all available
assistants are listed in the Data Assistants section at the bottom of the Plot Setup
window. To use a Data Assistant, click the assistant name to select it, and then
click the Process button.

e Launch (Scaling Data Assistants: Pulse Scaling, Linear Scaling, Kilowatt-Hour)

The Data Assistants used for scaling data (Pulse Scaling, Linear Scaling, Kilowatt-
Hour) can also be run from the Launch window, so that parameters are applied
automatically each time you read out the logger or open a data file.

Once you have pre-defined a parameter set, the parameters are also used when
current readings are viewed in the window. This feature is available for the
HOBO U30, the HOBO H21 (Weather Station and Micro Station) and the

HOBO H22 (Energy Logger) loggers. Parameter sets are stored on the logger and
apply to that logger and channel configuration only.

To use an assistant from the Launch window, click the Data Assistants button
and then double click the desired assistant, or select the assistant and click the
Create or Edit button.

Default Settings

The parameters last entered into any given Data Assistant will be the default used the
next time the Data Assistant is run, unless it is being used to edit an existing parameter
set. If you run a Data Assistant at Plot Setup time, and then later you run it from the
Launch window, the default values are the value you entered at Plot Setup time.

Hiding Assistants

To prevent unwanted assistants from appearing in the Plot Setup window, or to bring
back assistants that you have previously hidden, click the Manage button. This will
open the Preferences window to allow you to change these settings.
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Summary of Data Assistants

The following Data Assistants are available:

Barometric Compensation Assistant

Use the Barometric Compensation Assistant to compensate for barometric pressure
and create a water level or sensor depth series. The BCA uses water pressure data from
a HOBO U20 Water Level Logger and additional information you provide. After you use
the assistant and display the plot, you may apply filters to the new series.

Growing Degree Days Assistant

Use the Growing Degree Days Assistant to calculate growing degree days based on
temperature data spanning at least one full calendar day (midnight to midnight).
Growing degree days are used for agricultural and turf management applications, such
as estimating harvest time or pest growth.

Grains Per Pound Assistant

Use the Grains Per Pound Assistant to calculate the absolute amount of water in the air,
based on temperature, humidity, dew point, and altitude. You can also create an
altitude-corrected dew point series.

kWh Assistant

Use the kWh Assistant to convert logged pulse data from a WattNode, Veris, or other
energy transducer to kWh, average kW, and energy cost. The kWh Assistant can be run
during Plot Setup or at Launch.

Pulse Scaling Assistant

Use the Pulse Scaling Assistant to convert a data series from a compatible sensor to
some other measurement. You enter a raw value and its corresponding measurement
value. The Pulse Scaling Assistant can be run during Plot Setup or at Launch.

Linear Scaling Assistant

Use the Linear Scaling Assistant to convert a data series from a compatible sensor to
some other measurement. You enter two raw values and their corresponding
measurement values. The conversion must be based on a linear relationship. Nonlinear
scaling is not available. The Linear Scaling Assistant can be run during Plot Setup or at
Launch.
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Barometric Compensation Data
Assistant

Introduction

The Barometric Compensation Assistant uses water pressure data from a HOBO U20
Water Level Logger and additional information from you to compensate for barometric
pressure and create a water level or sensor depth series.

After you use the assistant and display the plot, you may apply filters to the new series.

Using the Barometric Compensation Assistant

To create a water level or sensor depth series:

1. Read out alogger or open a datafile that contains water pressure data from a U20
Water Level Logger.

2. From the Plot Setup dialog, select Barometric Compensation Assistant and click
Process.

The Barometric Compensation Assistant dialog appears.

[ KRl Raramairic Compensandan Acsiczam

~Fluld [ nsny
) Foenh Wakar IR2.208 1h/TH

- Sah waner (G196 Ibi'teh
» Brackish ‘Walwr (53052l 1)
Plargal Inpur =000 Al t

) Dureed Froe Tame Channel, assumming fne malu

Earpsriic ONfipensatei Pasamelers

[ Usa 2 Rference Warer Level
Reerence Waner Level: 50,000 Foer 3l
feference TNE. | 2730004 32559 PR CMT-05:00 [Pres = 21152 0241 g |
Baramemric Danafile. | (Wel_Lag Bara.scho Chucee..

N NG 4 TeiErETEE waet e, here lsna
rowed Lo Emeet 4 cataland banemele preaas

Fenuhant Serien Kams: Water | sapl

User Woles.

Conee | Crete Mevwe Seres |

3. Provide Fluid Density information by choosing a water type (fresh, salt, or
brackish), entering a specific constant value, or using the temperature series (if
logged) to use temperature-compensated density assuming fresh water.
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4. To enter a reference water level, check the Use a Reference Water Level box,
enter the water level, and indicate whether it is in feet or meters.

Enter the water level as a positive number if it is measured upward from a
reference point below the water's surface, such as the water's height above sea
level.

Enter the water level as a negative number if it is measured downward from a
reference point above the water's surface, such as a well cap.

Then, from the drop-down, select the logged time and value that is closest to the
time when you measured the water level.

When selecting a logged value and time to link to the reference level, make sure
the logger readings have stabilized. When a logger is first deployed in water, it
takes some time for its temperature to reach equilibrium. You will get the best
accuracy if you link your reference reading to a stabilized logger reading.

When using a reference water level, the resulting series data will contain water
level values relative to this reference level. If you do not use a reference water
level, the resulting series data will contain values for absolute sensor depth.

5. You can either use a barometric data file from another source, or enter a fixed
barometric pressure. For the most accurate water level results, use a reference
water level and a barometric data file. The barometric data can come from
another HOBO U20 Water Level Logger in air; a HOBO Weather Station, HOBO
Micro Station, HOBO U30, or HOBO Energy Logger; or a text file from another
source.

To use another file to provide barometric information, click the Use Barometric
Datafile button and enter (or browse to) the name of a .hobo, .hsec, .dtf, .dsec, or
.txt file that contains a barometric pressure series from an overlapping time
period. You will have the option to display this series on the plot.

Important: To use a .txt file, see Import Text Files Requirements on page 133.

To use a constant pressure value, click the Use Constant Barometric Pressure
button. Enter the constant value and indicate whether it is in psi or kPa. (You
cannot use a constant pressure value in combination with a reference water
level.)

6. Keep the default Resultant Series Name, or enter a new one. You may also enter
User Notes concerning the series you are creating.

NOTE: Your settings are retained, so you do not need to re-select your density
and barometric file each time you use the Barometric Compensation Assistant as
long as they still apply to the new water level data set.

7. Click Create New Series. The new series is listed and selected in the Plot Setup
dialog.

You can click Process on the Plot Setup dialog again to create another series
using different barometric compensation parameters.

8. Click the Plot button.
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The settings you entered will be displayed in the Details pane of the plot.

¥ ~ Series: Water Level, feet
» [T} Logger Info
¢ Deployment Info
¥ Series Statistics
¥ 5] Barometric Compensation Parameters
[27] Fluid Density: Derived from Temp. Channel
7] Reference Depth: 50.000 feet
7] Reference Time: 12/30/04 3:25:59 PM GMT-05:00
2] Barometric Datafile: /Well_Log_Baro.hobo

Available Filters

After the plot is displayed, you may apply minimum, maximum, and average filters to
the new water level or sensor depth series as you would for any sensor data series in
HOBOware Pro.
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kWh Assistant

Introduction

The kWh Assistant converts logged pulse data from a WattNode, Veris, or other energy
transducer to kWh, average kW, and energy cost.

This assistant can be applied only to logged data from a S-UCA-xxxx or S-UCC-xxxx
Electronic Switch Pulse Input Adapter. It is not compatible with the S-UCB-xxxx or S-
UCD-xxxx Contact Closure Pulse Input Adapter.

After you use the assistant and display the plot, you may apply filters to the new series.

Using the kWh Assistant

To create energy data from a pulse data series:

1. Read out a logger or open a datafile that contains a Counts series from a S-UCA-xxxx
or S-UCC-xxxx Electronic Switch Pulse Input Adapter.

2. From the Plot Setup dialog, select kWh Assistant and click Process. The kWh
Assistant dialog will appear.

& k'Wh Assistant

rSelect Data Series

Pulse Series; 1) Coumts, Compressar 4 Tll

~Setup

Energy Transducer
@ warthode: | T-wia-3v-208 %]
) Veris: ER-8051-300 & | kKWh/pulse:
! Other: ] per CT Rated Am

Current Transformer
CT Size: 20 Amps

rOutput Series
™ Energy (in kWh)
Resultant Series Mame: -Engrg.'-
g Average Power per interval
Resultant Series Name:  Avg Power

™ Usage Cost 1/ kwh = § 010000

Resultant Serles Mame: Cost

User Motes: H".ALTysbarr' am raof

{_ Cancel } { Create Mew Saries
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3. If your datafile includes multiple Counts series, choose the one you want to convert
from the Pulse Series drop-down list. (If your logger supports sensor locations, the
location you entered will be displayed here.)

4. In the Setup panel, select the Energy Transducer that was used, and choose the
model number from the drop-down list. (Since the Veris transducers have a switch to
define kWh/pulse, you must specify that here as well.)

If your transducer is not listed, select Other and enter the conversion factor. Choose the
type of conversion (Wh/pulse per CT Rated Amp, Wh/pulse, or kWh/pulse) from the
drop-down list. You should be able to find this information in the manual that came
with your energy transducer.

5. Enter the current transformer size (in Amps) in the CT Size field. (Veris transducer
CT sizes are predefined.

6. In the Output Series panel, select one or more series you wish to create. For each
series, you may keep the default Resultant Series Name, or enter a new one.

 To create a series that shows energy in kWh, check the Energy box.

 To create a series that shows average power, check the Average Power per
interval box.

« To create a cost series, check the Usage Cost box and enter the cost per kWh.
7. Enter any User Notes concerning the series you are creating (optional).

NOTE: All of these settings will be retained as default values the next time you access
the kWh Assistant.

8. Click Create New Series. The new series are listed and selected in the Plot Setup
dialog.

9. You can click Process on the Plot Setup dialog again to create additional series using
a different raw series or different parameters.

10. Click the Plot button. The settings you entered will be displayed in the Details pane
of the plot.

¥ ~ Series: Energy, kWh
* T} Logger Info
=k Deployment Info
P ¥ Series Statistics
¥ 5 kWh Parameters
[Z7) Energy Transducer: WattNode (T-WNA-3Y-208)
[Z5) CT Size: 20.0 Amps
[7] Sealing Factor: 0.5 Wh/pulse
¥ | User Motes
HWVAC system on roof

Available Filters

After the plot is displayed, you may apply filters to the new series as you would for any
other series in HOBOware Pro. In addition to the minimum, maximum, and average
filters that are available for most series, the energy and cost series allow you to create
new series showing totals over a period of time.
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Linear Scaling Assistant

The Linear Scaling Assistant converts a data series from a compatible sensor to some
other measurement when you enter two raw values and their corresponding
measurement values. The conversion must be based on a linear relationship. Nonlinear
scaling is not supported. After you use the assistant and display the plot, you may apply
filters to the new series.

Supported Sensors

This assistant is available for the following sensors:

CABLE-2.5-STEREO Voltage Input Cable (for U12 loggers)
CABLE-4-20-mA Input Cable (for U12 loggers)
S-CIA-xxxx 12-bit 4-20mA Input Adapter

S-VIA-xxxx 12-bit Voltage Input Adapter

S-FS-CVIA FlexSmart™ Analog Module

S-FS-TRMSA FlexSmart TRMS Module

U30 Analog Sensor Port

S-FS-TRMSA (U30 TRMSA Module)

S-LWA-xxxx Leaf Wetness

S-SMA-xxxx Soil Moisture

The Linear Scaling Assistant can be applied only to logged data from these sensors.

Other Types of Scaling

To avoid confusion, keep in mind the other types of scaling that are available within
HOBOware Pro:

FlexSmart™ modules are set up for scaling prior to launch, as part of the module
configuration process. You can later rescale these scaled series using the Linear
Scaling Assistant if you need to create a different measurement. See Chapter 5.

You can use HOBOware Pro to set up linear scaling for the CABLE-4-20-mA and
CABLE-2.5-STEREO sensors on a U12 logger prior to launch. The advantage to
scaling before launch is that you can view the scaled values on the Status
window, and the data will be properly scaled when you read out the logger or
open the datafile. You can later rescale this scaled series using the Linear Scaling
Assistant if you need to create a different measurement.

The Pulse Scaling Assistant is similar to the Linear Assistant, but only allows
scaling of pulse data. See the Pulse Scaling Assistant (page 120) for more
information.
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Running the Assistant

From the Launch window

1. Launch a logger that has a supported Electronic Switch Pulse Input Adapter
connected.

2. In the Launch window, click the Data Assistants button.

3. Double-click the assistant name (or select the assistant name and click the
Create button).

The Linear Scaling Assistant dialog will appear.

From the Plot Setup window

1. Read outalogger or open a datafile that contains a Counts series from a
supported Electronic Switch Pulse Input Adapter.

2. Inthe Plot Setup window, double-click the assistant name (or select the assistant
name and click the Process button).

The Linear Scaling Assistant dialog will appear.

Using the Linear Scaling Assistant

Linear Scaling Assistant E|
@—' =Sedect Diaka Series
Rave Series: | |RESTSp] |
rParameters
Raw Scaled
®—h' Lirsts: iy urit s
Yahoe 1: 0.0000 3| = [0.0000
Wahe 2: 20,0000 5| = |5.0000

@—h- Resultant Series Name: | Linear Scaling 2

@_,_...-’—""‘r' Lisar Motes: |

W
[ cancel || Save Parameter et ].__@

1. Select Data Series - If your datafile includes multiple scalable series, choose the
one you want to scale from the Raw Series drop-down list. (If your logger
supports sensor locations, the location you entered will be displayed here.)

2. Parameters - In the Scaled column of the Parameters panel, enter the units name
for the scaled series, and enter the scaled values in the Scaled column to
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correspond with the numbers in the Raw column. (The default values in the Raw
column are based on the high and low values supported by the sensor, but you
may use different values, as long as those values fall within the sensor's range.)
These numbers establish a linear relationship between raw and scaled values.

3. Resultant Series Name - Keep the default name, or enter a new one. You may also
enter User Notes concerning the series you are creating.

4. User Notes - (Optional) - Enter notes concerning the series you are creating.
5. Process Assistant

If you ran the assistant from the Launch window, click the Save Parameter Set
button.

If you ran the assistant from the Plot Setup window, click the Create New Series
nutton.

To create additional series using a different raw series or different parameters, click
the Create button (if in the Launch window) or the Process button (if in the Plot Setup
dialog).

If you are running the assistant from the Launch window, the parameters will be
applied each time you readout the logger. If you are running the assistant from the Plot
Setup window, the new series will be generated when you click the Plot button.

NOTE: All of these settings will be retained as default values the next time you access
the assistant.

Scaled Series

The scaled series will appear in the graph, and data will be displayed in the legend and
in the Details pane.

¥ ~ Series: Pressure, "HZ20
» [} Logger Info
P o Deployment Info
P ¥ Series Statistics
¥ [} Linear Scaling Parameters
[ value 1 Raw: 4.0 mA
[ value 2 Raw: 20.0 mA
5 value 1 Scaled: 0.0 "H20
5 value 2 Scaled: 10.0 "H20
¥ | User Notes
Air duct pressure in building 3

Available Filters

After the plot is displayed, you may apply minimum, maximum, and average filters to
the scaled series as you would for any sensor data series in HOBOware Pro.
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Pulse Scaling Assistant

The Pulse Scaling Assistant converts a data series from a compatible sensor to some
other measurement when you enter a raw value and its corresponding measurement
value. The conversion must be based on a linear relationship. Nonlinear scaling is not
supported. After you use the assistant and display the plot, you may apply filters to the
new series.

The Pulse Scaling Assistant can be run from the Launch window (Pre-set Parameters)
or from the Plot Setup dialog. If you run the assistant from the Plot Setup dialog, you
must run the assistant each time you readout the logger or open a datafile.

Supported Sensors

This assistant is available for the following sensors:

o S-UCA-xxxx and S-UCC-xxxx Electronic Switch Pulse Input Adapter

e S-UCB-xxxx and S-UCD-xxxx Contact Closure Pulse Input Adapter

The Pulse Scaling Assistant can be applied only to logged data from these sensors.

Other Types of Scaling

To avoid confusion, keep in mind the other types of scaling that are available within
HOBOware Pro:

e FlexSmart™ modules are set up for scaling prior to launch, as part of the module
configuration process. See Chapter 5.

e You may use HOBOware Pro to set up linear scaling for the CABLE-4-20-mA and
CABLE-2.5-STEREO sensors on a U12 logger prior to launch.

e The Linear Scaling Assistant is similar to the Pulse Scaling Assistant, but has
slightly different input options and is compatible with a different group of
sensors. See the Linear Scaling Assistant (page 117) for more information.

Pre-set Parameters

If you run the assistant from the Launch window, parameters are applied automatically
each time you read out the logger. Once you have pre-defined a parameter set, the
parameters are also used when current readings are viewed in the Status window.
Parameter sets are stored on the logger and apply to that logger and channel
configuration only.

The parameters last entered into any given Data Assistant will be the default used the
next time the Data Assistant is run, unless it is being used to edit an existing parameter
set. If you run a Data Assistant at Plot Setup time, and the next time you run it from the
Launch window, the default values are the value you entered at Plot Setup time.

The Pre-set Parameters feature is available for the HOBO U30, the HOBO H21 (Weather
Station and Micro Station) and the HOBO H22 (Energy Logger) loggers.
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Accessing the Pulse Scaling Assistant

From the Launch window

1. Launch a logger that has a supported Electronic Switch Pulse Input Adapter
connected.

2. Click the Data Assistant button.
3. Double-click Pusle Scaling Assistant.
4. Click the Create button.

The Pulse Scaling Assistant window appears.

From the Plot Setup window

1. Read out alogger or open a data file that contains data from a compatible pulse
Sensor.

2. From the Plot Setup dialog, select Pulse Scaling Assistant.
3. Click the Process button.

The Pulse Scaling Assistant window appears.

The Pulse Scaling Assistant window

Pulse Scaling Assistant

@—h ~Select Data Series
Roaws Series: | [FIEarLE v I:

@—b rParameters

Raw Scaled
Unts! Counts | |unke

W

[ Cancel || SaveParameter Set ]-l-—@

1. Select Data Series - If your data file includes multiple scalable series, choose the
one you want to scale from the Raw Series drop-down list. (If your logger
supports sensor locations, the location you entered will be displayed here.)

2. Parameters - In the Scaled column of the Parameters panel, enter the units name
for the scaled series, and enter a scaled value in the Scaled box to correspond
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with the number in the Raw box. These numbers establish the relationship
between the raw and scaled values.

3. Resultant Series Name - Keep the default name, or enter a new one.

4. User Notes (Optional) - Enter notes concerning the series you are creating.

NOTE: All of these settings will be retained as default values the next time you
access the Pulse Scaling Assistant.

5. Process Assistant

If you ran the assistant from the Launch window, click the Save Parameter Set
button.

If you ran the assistant from the Plot Setup window, click the Create New Series
nutton.

6. To create additional series using a different raw series or different parameters,
click the Create button (if in the Launch window) or the Process button (if in the
Plot Setup dialog).

If you are running the assistant from the Launch window, the parameters will be
applied each time you readout the logger. If you are running the assistant from the Plot
Setup window, the new series will be generated when you click the Plot button.

NOTE: All of these settings will be retained as default values the next time you access
the assistant.

Scaled Series

The scaled series will appear in the graph, and data will be displayed in the legend and
in the Details pane (shown below).

Details
¥ ~ Series: Rain, Inches
» |} Logger Info
2 Deployment Info
P ¥ Series Statistics
¥ || Pulse Scaling Parameters
5 1 Count = 0.010 Inches
¥ | User Motes
Rainfall in Field 3

Available Filters

After the plot is displayed, you may apply filters to the scaled series as you would for
any other series in HOBOware Pro. In addition to the minimum, maximum, and average
filters that are available for most series, the scaled pulse series allows you to create a
new series showing totals over a period of time.
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Growing Degree Days Assistant

The Growing Degree Days Assistant calculates growing degree days based on
temperature data spanning at least one full calendar day (midnight to midnight).
Growing degree days are used for agricultural and turf management applications, such
as estimating harvest time or pest growth.

One growing degree day (GDD) is equivalent to a one degree increase above a
minimum threshold temperature for a period of one day. For example, assuming no
horizontal cutoff, if the minimum threshold temperature is 70°F and the temperature
was a constant 85°F for the day, the GDD for that day is 15 GDD.

A single GDD value is calculated for each full calendar day of temperature data, and
plotted at noon for that day. GDD values are cumulative; that is, the GDD for each day
adds to the previous days’ GDD value.

Important: Time of day is a factor in the GDD computation. When you launch a logger,
be sure that your computer’s clock is set to the proper time zone for the area where the
logger will be deployed. If you try to correct it later by entering a different offset in the
Plot Setup dialog, you may get confusing or misleading results.

Steps

1. Read out alogger or open a datafile that contains data from a temperature
Ssensor.

2. From the Plot Setup window, select Growing Degree Days Assistant and click the
Process button.

The Growing Degree Days Assistant window appears.
8 Growwnsy Degres Dy Assistant

Select Duta Series Caleulation Mathad

Temperuure Seried! [ Temgerarure, Alr 150 ST ) Average Mtk 0iigh) Low)
(5™ O Single Triangle (na Cutoff)
Development Threaholds

_ Single Tnangle dw/ Hommnatal Cutoft)

Lt Upper
e 5 )
50.000 20 000 Singhe Sine ino Cuto
W - 19EHT ———— B @———— U _ Single St b Hosriponial Cutolf)

ety L Aotual Temperabare beihod ing Cutedli

Eiafix Paramerers ) Mt Temgsraturs Methad fw) Honzontal Ceofl)

T 97

Select Bofix Dace | Tr24705 B LBl O Aensal Termperature Methad fwf Vertial Cutadf)
Degres Duys CF o Bvent Jo0n Degree Duys
Event Destription: SO0 e Waumy

Resultant Senes Mame: GDD

Unr Motes

7 Cancel f?;"**mﬂ'“"—(: }

7
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8.
9.

Select Data Series - If your datafile includes multiple temperature series, choose
the series you want to use from the drop-down list. (If your logger supports
sensor locations, the location you entered will be displayed here.)

Calculation Method - check the calculation method you want to use. See
Calculation Methods below for more details.

Development Thresholds - Select lower and upper threshold values.

These are the minimum and maximum thresholds that will be used in the GDD
calculation. Use the sliders to set these thresholds, or enter the values manually.
If the calculation method you chose does not use an upper threshold, the upper
threshold option will be disabled.

Temperatures are in degrees Fahrenheit if your default unit preference is US, and
in degrees Celsius if your default unit preference is SI.

Biofix Parameters

Select Biofix Date - choose a date that marks the beginning of the development
phase. The dates in this list are the full days contained in the datafile.

Degree Days to Event - enter the number of degree days needed to reach an
event of interest (harvest time, pest emergence, etc.). This will create an alarm
line on the graph to indicate when the event took place. Degree days are in
Fahrenheit (DDf) if your default unit preference is US, and in Celsius (DDc) if
your default unit preference is SI.

Event Description (Optional) - enter text to identify the event.

Resultant Series Name - Keep the default or enter a new one.

User Notes (Optional) - enter notes describing the series you are creating.

Click the Create New Series button.

The new series is listed and selected in the Plot Setup dialog.

To create another series using a different methods or parameters, click Process on the
Plot Setup dialog again and enter new values.

10.

Click the Plot button.

NOTE: All of these settings will be retained as default values the next time you access
the assistant.

Scaled Series

The scaled series will appear in the graph, and data will be displayed in the legend and
in the Details pane (shown below).
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¥ ~ Series: GDD, DDf

» Tl Logger Info

b = Deployment Info

B ¥ Series Statistics

¥ = GDD Parameters
|25 Method Type: Average Method (High/Low)
|25 Low Threshold: 60.000 °F
|25 High Threshold: 90.000 °F
|ZZ] Biofix Date: 7/24/05
2| Degree Days to Event: 200.0
2| Event Description: GDD to Maturity

Calculation Method

Average Method

Calculates the average of the high and low temperatures for the day (adjusted to the
lower and upper thresholds, if necessary), then subtracts the low threshold to compute
the GDD.

Single Triangle (no cutoff)

Uses the low and high daily temperatures to compute a set of two linear equations to
generate a triangle. The area between the curve and the low threshold is then used to
compute the GDD.

Single Triangle (horizontal cutoff)

Uses the low and high daily temperatures to compute a set of two linear equations to
generate a triangle. Then it adjusts any temperatures above the upper threshold to the
upper threshold. The remaining area between the curve and the low threshold is then
used to compute the GDD.

Single Sine (no cutoff)

Uses the low and high daily temperatures to compute a sine wave that assumes the low
temperature occurred at midnight and the high temperature occurred at noon. The
area between the curve and the low threshold is then used to compute the GDD.

Single Sine (horizontal cutoff)

Uses the low and high daily temperatures to compute a sine wave that assumes the low
temperature occurred at midnight and the high temperature occurred at noon. Then it
adjusts any temperatures above the upper threshold to the upper threshold. The
remaining area between the curve and the low threshold is then used to compute the
GDD.

Actual Temperature (no cutoff)

Uses the logging interval of the temperature data to perform a numerical integration.
The area between the curve and the low threshold is used to compute the GDD.
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Actual Temperature (horizontal cutoff)

Adjusts any temperatures above the upper threshold to the upper threshold. Then it
uses the logging interval of the temperature data to perform a numerical integration.
The area between the curve and the low threshold is then used to compute the GDD.

Actual Temperature (vertical cutoff)

Uses the logging interval of the temperature data to perform a numerical integration.
Any interval in which the temperature exceeds the upper threshold is excluded from
the calculation. The remaining area between the actual curve and the low threshold is

then used to compute the GDD.
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Grains Per Pound Assistant

The Grains Per Pound Assistant calculates the absolute amount of water in the air,
based on temperature, humidity, dew point, and altitude. You can also create an
altitude-corrected dew point series.

To create a grains per pound and altitude-corrected dew point series:

1.

Read out a logger or open a datafile that contains temperature, humidity, and
dew point series.

From the Plot Setup window, select Grains Per Pound Assistant and click the
Process button.

The Grains Per Pound Assistant window appears.

Select Data Series
O Temperature Serfes: | 1) Temperature 10K Thermistor .'_

8nr Grains Per Pound Assistant

-
.
)
-

1

Relative Humidiny Series 1) Relative Humidity (Requires Temp Channel Lh

Dew Point Series: | 1) Dew Point (Requires Temp and RH)

:::|

o 25
i

@—p Altitude above Sea Level: O fieet £
@,_" ® Add Altitude-Corrected Dew Point Series to Graph

®_. Resultant Series Mame: Grains
Q

7.
8.

User Motes

L

g l:mcel Create New Series

Select Data Series - If your datafile includes multiple temperature, humidity, or
dew point series, choose the series you want to use from the drop-down lists. (If
your logger supports sensor locations, the location you entered will be displayed
here.)

Altitude above Sea Level - To correct for altitude (optional), enter the altitude
use the drop-down menu to indicate whether this number is in feet or meters.

Add Altitude-Corrected Dew Point Series to Graph - Check this box to see an
altitude-corrected dew point series on the graph.

Resultant Series Name - Keep the default or enter a new one.
User Notes (Optional) - Enter notes describing the series you are creating.

Click the Create New Series button to process the assistant.

The new grains per pound series (and altitude-corrected dew point series, if
applicable) is listed and selected in the Plot Setup dialog.
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To create another series using different data series or altitudes, click the Process
button on the Plot Setup window.

9. Click the Plot button.

Scaled Series

The scaled series will appear in the graph, and data will be displayed in the legend and
in the Details pane.

¥ ~ Series: Grains, gpp
» [T} Logger Info
o Deployment Info
b ¥ Series Statistics
¥ = Grains Parameters
5] Akitude: 0.000 feet

Available Filters

After the plot is displayed, you may apply minimum, maximum, and average filters to
the grains per pound and altitude-corrected dew point series as you would for any
sensor data series in HOBOware Pro.
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Conductivity Assistant

Introduction

Use the Conductivity Assistant to apply compensation to absolute conductance data
from a U24 Conductivity logger.

Conductivity Assistant @

Select Data Series

Conductivity Series: | Elmeya =g e aul == v ﬁ%

1

-Temperature Compensation -Calibration

Conwvert Electrical Conductivity ta Specific Conductance at 26 @C () Use factory calibration only

Changes here update calibration time measurement walues
() Use measured paints For calibration
(%) Monlinear, Natural Water Compensation per ENZ7565

() Linear compensation default at 2.1 %/°C Starting calibration point = DDD | WS [ em {Specific Conductance)
() Linear compensation at | Measurement time: :UI,I'SI,I’IU 03:49:13 PM GMT-05:00 [Sp Cond = -1.4 pSfom] ~ ..
Series Mame Ending calibration point = DDD | B3 | £m {Specific Conductance)
Conductance  |Specific Conductance _.: Measurement time: ;01;31;10 03:51:58 PM GMT-05:00 [Sp Cond = -1.4 pS/om] -
Salinity [Salirity 3
Lser Mokes: I | Only report data between selected points

Cancel ] [ Create Mew Series

1. Select Data Series

Select the series that corresponds to the range of your data. Note: If you only
selected one range at launch time, only one series will appear here.

- Conductivity Full Range (default) - when the data goes above 1000 uS/cm.
- Conductivity Low Range - when the data is less than 1000 pS/cm.

2. Temperature Compensation
Select your desired compensation method.
3. Calibration Method

By default, data is calibrated using the factory values. To enter your own
calibration values, select Use measured points for calibration and then enter data
points derived from your specific conductance readings taken with a calibrated
meter. See Calibration for more information.

Starting and Ending Value: This method adjusts for any inaccuracy due to sensor
drift or fouling. This assumes there is a linear change in calibration adjustment
required.
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Starting value only - All readings are adjusted up or down by a fixed value from
this calibration point.

Ending Value Only - The factory calibration value is used as the starting point.
This assumes there is a linear change in calibration adjustment required.

4. Only report data between the calibration points- Any readings from before or
after the calibration points will be removed from the resulting series.

5. Resultant Series Name - The default is Specific Conductance. Enter new name if
desired.

6. User Notes (Optional) - Enter notes if desired.
7. Click the Create New Series button to return to the Plot Setup dialog.

The Plot Setup dialog will now contain a series called Specific Conductance (or the
name you entered for Resultant Series Name).

The default units are microSiemens/cm (uS/cm). You can change the units to
milliSiemens/cm (mS/cm) if desired. The default units for salinity are ppt (parts per
thousand) and this cannot be changed.

Plot Setup a

Description: | 200909013
Select Series to Plok
S Mone
1 Low Range pSicm ~ o
2 Full Range nsicm £
3 Temp °F ~
EBatt W
s Specific Conductance pSfcrn “
5 Salinity ppt =
4 >

Click Plot to plot the data.
The plot will appear.

The Details Pane will show the three series: Abs Conductivity, Temp, and Specific
Conductivity.

Dekails
+~’ Series: Low Range, p3fom
+- Series: Full Range, pSfcm
+-+ Series: Temp, °F
4 Series; Specific Conductance, pSfom
+-+ Series: Salinity, ppt
+--% Event Type: End CF File

Available Filters

After the plot is displayed, you may apply minimum, maximum, and average filters to
the scaled series as you would for any sensor data series in HOBOware Pro.

Importing Data
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Importing Text Files

NOTE: This feature is only available in HOBOware Pro.

You may graph non-HOBOware data by importing data from certain text files:

® You can easily open text files that were created by Onset’s Alarm & Readout Tool
version 2.0 or higher.

® You can also open text files that were exported from Onset's BoxCar Pro 4.3
software, using the default BoxCar export settings. This allows you to view data
from Onset loggers that cannot be readout using HOBOware Pro.

e With some adjustments, you can open text files that were exported from other
software. You can also build text files from scratch, using historical or other
types of information.

Also see Importing Text File Requirements 133.

Steps
To import data from a properly formatted text file:

1. From the File menu, choose Import Text Data.
2. Select a text file (.txt) and click Open.

3. Ifthe text file was created by the Alarm & Readout Tool, skip ahead to step 8.

Otherwise, HOBOware Pro attempts to parse the text file and displays the Text
Import Information window. To conserve system resources, it displays only the
first several records in the file, not the entire contents.

4. Look at the data in the Delimiter Preview area to be sure that the date, time,
and data columns were separated correctly.

o[f they were not, use the Data Separator, Date/Time Separator, and
Decimal Separator pull down menus to choose other delimiters until the
data looks correct.

eYou can resize the columns by clicking and dragging the dividers between
the column headers.

eFor text files that were not exported in BoxCar's default format, click the
Edit Date/Time Format button and ensure that the import function is
interpreting incoming date, time, and year formats and separators
correctly. Use the current date and time displayed in the Sample panel as a
guide. Make changes as needed, then click OK.

5. When the Delimiter Preview is correct, click OK.

6. Depending on the file's contents, the Plot Setup window may be displayed at this
time. If so, skip ahead to step 8.
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Otherwise, the Text File Information window is displayed. This window allows
you to add optional information and change units, if needed.

e Enter a Description, which will become the plot title and be included in
the Details pane.

o Select a Model from the list. If you select Other/3rd Party, you can enter
a description (up to 20 characters) of the logger or other data source in
the next field.

o Enter the logger's Serial Number, if applicable.

¢ [nthe Channel Parameters box, verify that the units are correct for the
data in the file.

7. Click OK.

8. The Plot Setup window is displayed. Select the series you wish to view in the
plot. You also have the option of changing the times on the plot to a different
time zone.

9. When you have made your selections, click the Plot button.

The plot is displayed. You may want to save your work in a project (.hproj) file for
quick viewing later.
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Import Text Files Requirements

NOTE: This feature is only available in HOBOware Pro.

When you import a text file, the file must meet certain requirements. You can view or
edit text files in a text editor or word processor. To delete, rearrange, or reformat
columns of data, you may need to use a spreadsheet program. Remember to save the
corrected file in text (.txt) format.

Serial Number

There may be an optional header for serial number information located at the
beginning of the file, before the column headings. At the beginning of the line must be
the phrase "Serial Number:" followed by a space, then the serial number, then two
dashes:

Serial Number: 733329 --

Contents

Below the header (if any) should be the data, starting with column headings. There
must be no other text in the file other than the optional header, column headings, and
data. The first column must be date, the next must be time, and the rest must be data.

Delimiters

Valid delimiters for separating date and time are space, comma, tab, and semicolon.
Valid delimiters for separating other data are comma, tab, and semicolon. The delimiter
used to separate the date from the time may be different from the delimiter used to
separate the data.

Date

The date column must have the heading, "Date" and date values should be formatted as
mm/dd/yy. If they are in a different format, remember to indicate the correct format in
the Edit Date/Time Format window when you import the file.

Date

12/31/04
12/31/04
01/01/05
01/01/05

Time

The time column must have the heading, "Time" and time values should be formatted
in 24-hour format as hh:mm:ss.sss (decimals are optional). If they are in a different
format, remember to indicate the correct format in the Edit Date/Time Format window
when you import the file. UTC offset is assumed to be the same as your computer's
current time zone.

Time
23:59:59
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23:59:59.5
00:00:00
00:00:00.5

e No thousands separator can be used.

e Rows of data must be separated with a paragraph return.

Measurements

Data column headings must have the format "Measurement (Units)". Additional
information (such as channel number or serial number) can follow, but is optional.
Only spaces can be used between the end of the measurement name and the opening
parenthesis. An example is "RH (%)".

RH (%)
38.7
38.9
39.0
39.0

If the column header and units of an imported series exactly matches the text in the
table below, HOBOware will recognize the measurement and be able to perform unit
conversions, apply data assistants, etc. to that series.

Measurements listed below that either have only one unit type, or can be any unit type,

cannot have their units converted, but may still be used with applicable data assistants.

Measurements that are not listed in the table (or do not exactly match the text below)
can be exported, but without any units conversions or use of Data Assistants.

| Measurement Type Column Header Units

| Acceleration x accel, y accel, z accel g, m/s2, ft/s2

| Carbon Dioxide co2 ppm

| Counts counts [any units]

| Dew Point dew point F,C

| Leaf Wetness leaf wetness [any units]

| Light Intensity intensity lux, lum/ft2

| PAR par [any units]

| Pressure pres kPa, Pa, mbar, mm Hg, psi, in Hg
| Rain rain mm, in

| Relative Humidity rh %

| Soil Moisture soil moisture [any units]

| Solar Radiation solar rad W/m2

| Sum Vector sum vector g, m/s2, ft/s2

| Temperature temp F,C

| Tilt x tilt, y tilt, z tilt deg, rad

| Wind Speed wind speed m/s, km/hr, mph, knots
| Gust Speed gust speed m/s, km/hr, mph, knots
| Wind Direction wind direction [any units]
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Formatting the Date/Time Column
in Excel

In Excel, dates and times for each data point may initially appear as #######. Times
also may not have seconds listed.

Steps
To display the full date and time with seconds in Excel:

Adjust the time column width so you can see the whole date and time.

Select the time column from row 3 down.

1

2

3. From the Format menu, click Cells.

4. Select the Custom category and then select m/d/yyyy h:mm as the type.
5

Add ":ss" (or ":s5.000" if you used a fast logging interval) to the end of the string
in the Type field:

m/d/yyyy h:mm:ss (normal logging interval)
m/d/yyyy h:mm:ss.000 (fast logging interval)

6. Click OK.

The seconds should be listed automatically.

To export the date and time in separate columns go to Preferences> General
> Export Settings and enable the Date and time format: Separate into two columns.
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Importing Files from HOBOIlink

NOTE: This feature is only available in HOBOware Pro.

This feature allows you to import the current data file for a remote HOBO U30 Station
from HOBOlink directly into HOBOware for analysis.

To import a file from HOBOlink into HOBOware:
1. Select File > Import Data File from HOBOlink

The Import File from HOBOlink window appears.

—
Extract HOBOlink Text File

9,
link

Note that an Internat connection is reguired to use this feature
U3o Info

U3 Senial MNumber

HOBOlink User Info

Username
Password |

" Save this infarmation

Cancel J [ Go

2. Enter the serial number of the HOBO U30 Serial Number
3. Enter the Username and Password of the HOBOlink account.
4. To have your log in information saved, select the Save this information box.
5. To import the file, click Go.
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Exporting Table Data

Overview

You can export the points shown in the Points table to a text file (.csv or .txt) for
importing into Microsoft Excel and other applications.

Before You Begin

To change preferences for exporting, Preferences > General > Export Settings.

Steps
To export points:

1. Make sure the Points table includes the series you want to export. This might
include series pasted from other datafiles, or series derived through filters or
Data Assistants.

2. Click the Exporticon @ on the toolbar, or choose Export Table Data from the
File menu.

The Export Options window appears.

Export Options

(<]

() Expott to a single file
(%) Export ko muliple files (For files that exceed Excel's maximum row mit)

Nurmber of rows per file: | 46,794 &

Fileriame Prefix: |Energy_Logoer Pro_Launched wih_2.2.2
File Type: csv
Sample: Energy_Loager Pra_Launched with 2.2.2_Pagel.cav
Energy_Logaer Pro_Launched with_2.2.2 Pagel.csv

3. Select Option

4. To export all of the data in a single file, choose Export to a single file and click
Export. In the Save window, accept the default location and file name, or enter a
new location and name and click Save.
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5. To split the data over multiple files (particularly important if your data cannot fit
in a single spreadsheet), choose Export to multiple files and make your
selections:

¢ Indicate the maximum Number of rows per file. Consult the
documentation that came with your spreadsheet program to find out the
maximum number of rows it accepts, and remember to leave room for
header rows.

o Accept the default Export Location, or click Choose to use a different
location. (The default location creates a new folder for the files.)

e Accept the default Filename Prefix (based on the datafile name), or enter
a new one. The export file names will consist of this text plus "_PageX,"
where X indicates the order of the files (starting with 0).

e (lick Export.

You can now open the file(s) in Excel or another package. You can easily view the raw
data in a text editor.

-138-



HOBOware User’s Guide

Exporting Data in BoxCar Format

The Export Settings pane gives you flexibility in setting various date and time formats,
allowing you to export and import data in a format compatible with Onset's Box Car
Pro software.

Select the Use default Boxcar Pro export settings option to have all Export settings
set to Box Car defaults. See Export Settings for more information.

You can also change the following Display Preferences:

e 12 hour and 24 hour time formats
e MDY, DMY formats

e Date separator
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Copying Points Data into another
Application

To copy a series from one graph into another:
1. Select the data in the Points Table.
2. Copy Data
Windows: press Ctrl C
Mac: press Command- C
3. Open any text editor, word processor, or spreadsheet software.
4. Paste the data into the other application.
Windows: press Ctrl V
Mac: press Command-V

Fields are delimited by tabs, and records are separated by paragraph returns.

You can also copy the graph as a bitmap for pasting into other programs and
documents. The graph must be visible when you do this.

With the graph visible, select Copy Graph to Clipboard from the Edit menu.
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Exporting Details

Overview

You can export the information in the Details pane to a text file, which can be opened in
any text editor, or imported into many other types of programs (word processors,
spreadsheets, etc.).

To configure HOBOware to automatically export the data to a text file every time the
logger is read out. See Export Settings on page 212.

Steps
To export details:

1. Make sure the Details pane includes the series you want to export. This might
include series pasted from other datafiles, or series derived through filters or
Data Assistants.

2. From the File menu, select Export Details.
3. Accept the default file name, or type a new name.

4. Click Save.
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Bulk Export Tool

Overview of the Bulk Export Tool

The Bulk Export Tool is a plug-in tool for HOBOware Pro allows you to export
HOBOware files to text format for use in programs other than HOBOware Pro.

You can export the following file types:
e .hobo

o dtf

* .hsec

e .dsec

The Tool will take care of naming conflicts to prevent overwriting any pre-existing files,
and writes a log file into the target folder that lists the files exported and the file names
that were created for the created text files.

For more information on HOBOware Pro data files, see Working with Data in the
HOBOware User's Guide.

System Requirements

HOBOware Pro version 2.3.1 or higher

File Naming
For exported files the native extension is removed and ".txt" is appended.
Example: foo.hobo is renamed foo.txt
If a file name already exists, new files will be appended with "_0", "_1" etc.
Example:
foo.txt
foo_0.txt
foo_1.txt

Configuring Export Settings

The Bulk Export Tool uses the general export settings for HOBOware Pro.

To configure the Export Settings, go to: File > Preferences > General > Export Settings
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YAML

You can choose to have YAML ("YAML Ain't a Markup Language") headers added to the
exported files (they are not inserted by default). If enabled, YAML headers are inserted
at the front end of the file. You can remove the YAML header using any text editor.

YAML™ (rhymes with “camel”) is a human-friendly, cross language; Unicode based data
serialization language designed around the common native data structures of agile
programming languages.

For more information see yaml.org.

To enable YAML headers go to: File > Preferences > Bulk Export > YAML and check the
Export with YAML Headers box.

Using the Bulk Export Tool

Exporting Files

1. From the Main Menu in HOBOware Pro, go to Tools > Bulk Logger File Export >
Select Files to Export ...

2. Inthe Select Files to Export dialog, select the files you wish to export and click
Continue.

3. Inthe Choose Exports Folder dialog, navigate to the directory where you want
the files to be exported and click Export.

A progress bar will indicate the status of the export (if this happens very quickly you
may not see the bar).

When the export completes, a dialog appears saying “Text file export complete”.
4. Click OK.

The .txt files and a log file will be located in the directory you specified.

Log File

In the directory chosen for the export, a log file is created showing the result of each
exported file. It will either indicate the successful export and the resulting file names,
or an error message if there was a problem with the export. The final dialog will
indicate if there was an error and refer to the log file for more information.

Log File Naming Convention

Export_<day>_<month>_<year>_<hour>_<minute>_<second>.log
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Copying a Series to another Plot

To copy a series from one plot to another:

1. Open the source plot (the plot which includes the series you want to copy)
and the destination plot (the plot where you want to paste the series).

2. Inthe source plot, choose the arrow tool [% and select the series you want to
copy.

3. Copy the series:
right-click on the series and choose Copy Series from the pop-up menu
or, from the Main Menu select Edit > Copy Series

or press Ctrl+C (Windows) or Command-C (Mac)

4. Go to the other plot and with the arrow tool, right-click anywhere on the
destination plot and

choose Paste Series from the pop-up menu
or, from the main menu select Edit > Paste Series
or, press Ctrl+V (Windows) or Command-V (Mac)

The new series is added to the graph, the Details pane, and the Points pane.
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Working in Secure Mode

Overview

You can create secure files in HOBOware Pro to comply with 21 CFR Part 11, or simply
to add a level of security when working with datafiles. When Secure Mode is enabled,
HOBOware Pro begins an audit trail in the logger when you launch it, and adds an
encoded digital signature to the new datafile when you read it out.

A digitally signed file, or "secure file," has a filename extension of .hsec (for most U-
Series loggers) or .dsec (for station-type loggers).

NOTE: You can open .dsec files in HOBOware Lite but you can only create secure files in
HOBOware Pro.
http://www.onsetcomp.com/solutions/products/software/docs/HWPro2_3-
21cfr.pdf

NOTE: Issues may arise if you do not always use HOBOware Pro in the Secure Mode, if
you sometimes use HOBOware Lite, or if you sometimes use a version of HOBOware
prior to 2.3.0. See Security Mode Issues on page 147.

Enabling Secure Mode (HOBOware Pro Only)

Secure Mode must be enabled to create a secure file.

NOTE: Project (hproj) and export files are not secure, even if you create them from
secure files.

To enable Secure mode:
1. Go to Preferences > General.
2. Select Enable Secure Mode.

When Secure mode is enabled, a padlock icon [ appears in the lower right corner of
the main HOBOware Pro window.

Opening a Secure File

Secure files can be opened with HOBOware Pro 2.3.0 or greater. You can open .hsec
files only with HOBOware Lite 2.3.0 or greater.

Every time you open a secure file - even when you are not in Secure mode - HOBOware
verifies the encoded digital signature to detect whether the file has been corrupted or
tampered with. If even one bit of the data has changed since readout, a warning
message will appear when you open the file, and none of the series will be marked as
verified.

The padlock icon [ appears in the legend next to the series that were verified as
original data.
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In the Details pane, audit trail information is displayed under the Data Verification
node for each series. HOBOware Pro automatically obtains the Launch User and
Readout User names from your computer's operating system. To save the Launch
User name, you must have Secure Mode enabled when you launch the logger.

Verification

o Series that were created by filtering are not verified.

o Series that were created as a result of user input after readout, such as running a
data assistant or entering a constant temperature value for pressure or humidity,
are not verified.

e Series retain their verification status (and padlock icon) when copied and pasted
into other plots.

Verification Failure

If HOBOware cannot verify the digital signature when you open a file, it will display a
message that verification has failed. This means that the file has been altered or
become corrupted since it was originally saved. It will offer to display the plot if
possible, but will not display the padlock icon in the legend or provide signing details in
the Details pane. You will still be able to perform typical HOBOware functions on the
file.
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Security Mode Issues

I[ssues may arise if you do not always use HOBOware Pro in Secure mode, if you
sometimes use HOBOware Lite, or if you sometimes use a version of HOBOware prior
to 2.3.0.

Depending on the type of logger, the version of HOBOware that launched the logger,
and the version of HOBOware that reads out the logger, the resulting datafile may not
be compatible with versions of HOBOware prior to 2.3.0, or you may not be able to read
out the logger at all.

Launch non-Secure (any version of HOBOware)
Readout non-Secure (any version of HOBOware)
A backward-compatible datafile (.hobo or .dtf) is created.

Launch non-Secure (any version of HOBOware)

Readout in Secure mode

A secure file (.hsec or .dsec) is created with an audit trail that lists the readout
user, but not the launch user. Secure files are not backward-compatible.

Launch in Secure mode;

Readout in pre-2.3 version of HOBOware

Most U-Series loggers: The logger cannot be read out.

Station-type loggers: A backward-compatible datafile (.dtf) is created.

Launch in Secure mode;

Readout non-Secure in HOBOware 2.3

Most U-Series loggers: A datafile (.hobo) is created, but it is not backward-
compatible.

Station-type loggers: A backward-compatible datafile (.dtf) is created.

Launch in Secure mode;

Readout in Secure mode

A secure file (hsec or .dsec) is created with a full audit trail. Secure files are not
backward-compatible.
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Chapter 5: Working with Devices

Working with the HOBO U30 Station
(HOBOware Pro Only)

The HOBO U30 Station is designed primarily for use with HOBOlink which allows for
continuous logging and transmission of data using mobile network technology. There
are, however, some features that are only accessible through HOBOware Pro, and some
recommended guidelines for using HOBOware Pro.

Overriding HOBOIink

If you attempt to launch, read out, or check that status of the HOBO U30 Station using
HOBOware Pro, you may see a message indicating there is already a live HOBOlink
session underway. You can choose to override the HOBOlink connection and use
HOBOware Pro instead.

Alternatively, you may see a message indicating the HOBO U30 Station is busy and a
HOBOware Pro session cannot begin. Try again in a few minutes.

The readout configuration you define in HOBOlink sets up how frequently the HOBO
U30 Station will connect to HOBOlink. For example, if you set a connection interval for
4 hours then the HOBO U30 Station will contact HOBOlink automatically every 4 hours.

There may be circumstances in which you want to override this schedule and contact
HOBOlink immediately. For example, you moved the HOBO U30 Station to a different
location and you want to make sure it can still connect to HOBOIlink, but you don’t want
to wait four hours until the next connection. Click the Contact HOBOlink button in the
Status window to force an immediate connection.

Which Software to Use

The following table details when to use HOBOware Pro instead of HOBO link.

Launching

[t is strongly recommended that launching be done exclusively through HOBOlink Any
launch that you have configured with HOBOIlink will override the launch parameters
set with HOBOware Pro.

Reading out

Readouts are done automatically on a schedule that you set with HOBOlink. Use
HOBOware Pro to read out only if you are conducting a test or if you need an
immediate readout.
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Checking status and signal strength

Check HOBOIlink for the latest data, current status, and alarm information.

Open the Status window in HOBOware Pro if you wish to check how powerful the
cellular signal for the HOBO U30 Station in the current location. This will help you
determine if you need to reposition the station for optimal signal strength.

Configuring the Analog Sensor Port

This can only be done in HOBOware Pro and is accessed through the Launch window.
See Chapter 5.

Changing the default relay setting or testing the relay

The default relay setting for the HOBO U30 Station is normally open, and can only be
changed in HOBOware Pro. You can also use HOBOware Pro to test the relay.

Use HOBOlink to set up individual alarms.

Testing individual Smart Sensors

Use HOBOware Pro to test the accuracy of individual Smart Sensors.

When the HOBO U30 Station is not logging,

1
2
3.
4

Unplug all Smart Sensors.
Plug one Smart Sensor back in.
Check the current reading for the sensor in the HOBOware Pro launch window.

Repeat with the remaining Smart Sensors.

Additional plotting and analysis of datafiles

HOBOlink displays data read-out from the HOBO U30 Station in line graphs and shows
the readings from the last connection. The data is also saved in a datafile that can be
downloaded and saved to your computer. You can then open the datafile in HOBOware
Pro and view and plot the data in different ways.
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Controlling the Relay on the HOBO
U330 Station (HOBOware Pro Only)

NOTE: You can only configure the relay on the HOBO U30 Station using HOBOware Pro.

The HOBO U30 Station has a built-in, system-wide relay. The default setting is
deactivated (open).

Steps
To change the relay:
1. Connect the HOBO U30 Station to the computer with the USB cable.
2. From the Device menu, select Control Relay.
3. Select Set default (deactivated) state.

4. Select either Open or Closed.

Testing the Relay
To conduct an immediate test of the relay:

1. Connect the HOBO U30 Station to the computer with the USB cable.
2. From the Device menu, select Control Relay.

3. Select Activate (close) relay.
You should hear a click in the HOBO U30 Station.
4. Select Deactivate (open) relay.

You should hear the click again.

Use HOBOlink to configure alarms for individual sensors, low battery, and low memory.
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Changing the State of the U330 Relay
Contact

The U30 relay contact is a latching relay that can be configured as either Normally Open
or Normally Closed. The factory-default setting is Normally Open. You can change the
default relay settings in the Alarm window in HOBOware.

Steps

This procedure assumes the U30 Station is connected to a computer running
HOBOware.

1. From the Device menu select Alarms to open the Alarms window,

2. Inthe Relay Contacts section, select Normally Open or Normally Closed.

Alternate Method: From the Device menu select Control Relay > Set Default
(Deactivated) State and then select either Open or Closed.

3. Ifyou are setting an Alarm Action of Pulse Relay, you can set the Relay Pulse
Width. The defaultis 1 s.

4. Click Set to send the alarm configuration to the U30 Station.

To test the relay, click the Close Relay or Open Relay button (button that
appears depends on which state the relay is in). You should hear a click in the
HOBO U30 Station. Click the button again to return to the default state. Use a
digital multimeter to check for continuity to confirm that the relay is opened and
closed as expected.

Alternate Method: From the Device menu select Control Relay > Activate Relay,
then select Deactivate Relay.
Sonsor Alarms B
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The Alarms Window for the
U30/NRC

This topic describes the Alarms window for the HOBO U30/NRC. Use the Alarms
window to add, edit, or remove U30/NRC alarms.

Charemh Current (51-U00-CVTA-I00 ) 5N 2
Yol age (1 -UEM-OVIA-CC ) S 2

i reaken than L0558 ¥ - Sets activate relary

1. Channels

This section includes all of the channels that support alarms. Select a channel and
click Add to configure an alarm.

2. Alarms: This section includes all of the alarms that have been configured.

3. Relay Contacts

Select if the relay is Normally Open or Normally Closed. This only applies if the
Alarm Action (configured in the Alarm Configuration window) is set to Activate
Relay or Deactivate Relay.

4. Close Relay

To test the relay alarm function, click the Close Relay/Open Relay button.
Click Help to open the Help topic for this window.

Click Add to open the Alarm Configuration window and configure an alarm.
Click Edit to open the Alarm Configuration window and edit an existing alarm.

Click Remove to remove the selected alarm.

Relay Pulse Width

© 0 N o
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This sets the duration of the Relay Pulse when the Alarm Action is set to Pulse
Relay. The defaultis 1 second.

Click Set to send the alarm configuration to the logger.

Click Cancel to cancel any entries you have made and return to the Launch
window.
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The Alarm Configuration Window for
the U30/NRC

Use Alarm Configuration window to configure alarm thresholds and actions for the
U30/NRC. You access this window from the Alarms window.

Alarm Configuration El
Alarm Vahjes

Pelac; 20,0000 ¥ = Current Reading: -0.2033 ¥
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: [] High Rlarm | 16,1060 d'j_ before alarm stabe changes .‘_—®
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(7] Low alarm  [3.7666 mumwucmrstw
el 0,000 ¥ ?:
(jj Alarm Action
Activate relay W [] Deactivate on Alsrm Clear

()y—=le=] [cul_JUN[ ox 11-—®
G

1. Alarm Values

Set the Alarm high/low threshold and the number of samples.

Select the check box for the High Alarm and/or the Low Alarm. Enter an alarm in
the box(es) or use the sliders. If you enter values manually, the software may
adjust them slightly to the nearest values supported by the logger.

If only a high value is entered, the alarm will trigger if the reading exceeds that
value. If only a low value is entered, the alarm will trigger if the reading is below
that value. If both high and low are entered, the alarm will trigger if the reading
falls outside of that range.

You can also set the number of samples that must be displayed before the alarm
will be triggered. The sample period is whatever you have configured as the
sample rate on the logger.

Note: To avoid unintended activation of the relay contact, set the number of
samples to allow for anticipated breaches of the alarm threshold. If the
measurement is still out of range when the number of samples is reached, the
relay contact will be activated.

2. Alarm Action
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Select an action to occur when the alarm is triggered: Activate Relay
(Open/Close), Deactivate, Pulse, Toggle, Open, Close.

By default, the relay is deactivated when the alarm clears. To disable this,
uncheck the box next to Deactivate on Alarm Clearing.

Click Help to open the Help for this window.
Number of Samples: See Alarm Values above.
OK to return to the Alarms window.

Click Cancel to cancel all entries and return to the Alarms window.
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Configuring an Analog Module/ZPort

This topic describes how to configure an analog sensor port on the HOBO U30 Station
or a FlexSmart module in the HOBO Energy Logger.

NOTE: Analog Module/Port Configuration is only available in HOBOware Pro.

Overview

The HOBO Energy Logger is compatible with Onset smart sensors and FlexSmart
modules. The HOBO U30 Station uses smart sensors and an optional analog sensor
port. FlexSmart modules and the analog sensor port are user-configurable to
accommodate a wide range of Onset and third-party sensors. To take advantage of this
adaptability, HOBOware Pro lets you configure these modules/ports at launch time, or
create and save different configurations to be loaded into the modules/ports whenever
needed.

Steps

NOTE: This procedure is for creating a new configuration and sending it to a port. To
send an already saved configuration to a port, see Loading a Saved Configuration (page
165).

To configure an analog module or port, perform the following steps:

1. From the Launch window click the Configure button (or from the Device menu,
choose Configure Modules/Ports).

If the logger is already logging, you will be warned that the logger will have to be
stopped first.

The Select Channel to Configure window will appear showing all configurable Analog
Sensors attached to the logger.

If you are using the HOBO Energy Logger, you can attach additional modules while
viewing this window. when done, click Refresh to update the module list.

2. Click on the + sign to expand the entry and show the channels.

Select Channel to Configune

Click to see Attached Conligur abde Modules /Ports Uilities
channel =i-Analog Inpak (91-LIE0-OVIA- ) SN: 2 =
== SN, vokage | _::__J Click button for
-2 Hahag Doae: ‘_] desired action
i o
Select channel /

(= (=]
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Each channel in the module is defined by its channel number (the physical order in the
module), the configured channel name, and any location (assigned at launch) defined
for this channel in the logger.

NOTE: The default channel names Voltage and Current are just place holders and either
channel can be configured to measure voltage or current. For example, both channels
can be used to monitor sensors with 4-20 mA output.

3. Select a channel name and then click the Configure button to open the Channel
Configuration window.

NOTE: You can also access the Channel Configuration window from the Launch
window. In the Channels to Log section, double-click the module/port name to
expand it, click the channel name to select it, and click the Configure button.

The Configure Channel window appears.

4. Change any relevant configurable parameters:

5. Save the Configuration (Optional).

You do not have to save the configuration if you are going to send it to the
module/port right away, but you may find it convenient to save the configuration
for future use, especially if you have defined custom sensor settings.

To save this configuration for future use with any module/port of the same type,
click Save, enter a name for the file and click Save.

By default, the file is saved to the following location with an extension of .hcfg.
Windows: My Documents\HOBOware\ Configs
Mac: Users/<username>/Library/Application Support/HOBOware/Configs

6. To send the currently displayed configuration to the module/port, click
Configure.

The module will remain in this configuration until you send it a different configuration.
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The Configure Channel Window

This topic describes the elements in the Configure Channel window.

Configure Channel §|

r_hannel Info

Module/Port Mame: FS TRMS &C1
Firmware Version: 2.5
Serial Mumber: 1307256

Channel Mumber: 1
Channel Mamne: W

~5Scaling Parameters

Raw Scaled
Uniks: ml"'IRMS o W
Yalue 1 oy = |0
Yalue 2: 333|% | = |50
[ Help ][ Cancel ][ Load ]I Save II Configure

Channel Info

Module Name

FlexSmart module model and description.

Firmware Version

Version number of the module's firmware.

Serial Number

Serial number of the module.

Channel Number

Physical order of the channel in the module, starting at 1.

Channel Name

Description, up to 16 characters, of the physical property this sensor will measure. For
example, if the external sensor attached to this channel was a flow meter, you could
specify Flow rate as the measured property. Choose one of the predefined names from
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the pull-down menu, or choose Custom to display a dialog that allows you to define a
new name.

If you check the Save this value for next time box, the name will be added to the
Channel Name pull-down menu so that it can be selected in the future when using the
same type of module. Saved names are stored as preferences, and are removed when
you restore preference defaults.

Excitation Power

Some modules can supply power to attached sensors using the logger's battery.Click
the Set Excitation Power button to display the Excitation Power dialog. Check the
Excitation Power Used box to enable excitation power and then select the mode. See
Configuring Excitation Power on page 162.

Measurement Type

Native measurement recorded by the module, if applicable. Some modules have
multiple types of native measurements. For example, the FlexSmart Analog module can
measure either current or voltage. If your module offers more than one type of input,
select the correct one for your sensor.

Scaling Parameters

See Setting Scaling Parameters on page 160.
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Setting Scaling Parameters

This topic describes the settings for the scaling parameters section of the Configure
Channel pane.

~3caling Parameters

Raw Scaled
nits: '-.-' PSIG b
Yalue 1: 0% = o
Yalue 2 5% = |1o0

Raw

Units:

This is the type of output the sensor has; either V or mA, corresponding to the type of
sensor selected.

Raw Value 1 and Raw Value 2 should be input in these units.
For example, if the external sensor has an output of 4 - 20 mA, the raw units would be
in mA.

Value 1
The low raw value given by the external sensor. In the previous example, this would be
4 mA.

Value 2

The high raw value given by the external sensor. In the previous example, this would be
20 mA.

Raw Value 2 must always be greater than Raw Value 1.

Scaled

Units
Choose one of the predefined units from the pull-down list, or choose Custom to define
units for other types of sensors. See Custom Units below.

Value 1

The value you will see on the graph when the sensor reports a raw value equal to Raw
Value 1. This value should be entered in the same units that are specified in the Scaled
Units box.
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Value 2

The value you will see on the graph when the sensor reports a raw value equal to Raw
Value 2. This value should be entered in the same units that are specified in the Scaled
Units box.

Custom Units

If you select Custom in the Scaled Units drop-down list, the following window appears.

Insert Units S|

Insert ywour custom unik value here,

[] 5ave this value for next time

Enter a description up to eight characters of the units associated with the physical
property to be measured. For example, if the sensor attached to this channel was a flow
meter that measured flow rate, you could specify CFS (Cubic Feet per Second) as the
scaled unit. If you want to see data in particular SI or US units, you need to enter the
appropriate scaling values and units here.

Custom units do not allow for conversion between SI to US units. It is only a reference
used to indicate how the module is configured and how the resulting data should be
labeled.

Check the Save this value for next time box to have this unit name added to the
Scaled Units drop-down list so that it can be selected in the future when using the
same type of module.

Custom unit names are removed when you restore preference defaults.

Click OK to return to the Configure Channel window.
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Configuring Excitation Power

NOTE: Analog Sensor Port Configuration is only available with HOBOware Pro.

Description

You can configure sensor excitation power and warm up on the Analog Sensor Ports.
Sensor excitation is a voltage output provided by the HOBO U30 Station to power a
sensor that is connected to it. This power may be needed because the sensor is not self-
powered, or because the sensor’s power capacity cannot support a long deployment.

When sensor excitation is required, the logger can provide 12 V DC sensor excitation
voltage up to 200 mA total for transducers that require external power for proper
operation. The excitation voltage has a programmable warm up time and is controlled
by the Analog Sensor Port.

A warm up time can be up to 120 seconds. If the warm up required is longer than 120
seconds, or if you are not concerned with battery life, you may choose the Continuous
option, which will power the sensor for the entire deployment. Then click OK to return
to the Configure Channel window.

Battery Life

Providing excitation power drastically decreases the logger's battery life. (Consult the
logger manual for more information.) In order to save battery power, you may specify
the minimum time needed to power the sensor before taking a measurement. For
example, if you specify a Warm Up of one second and set the logging interval in the
logger to one minute, the logger will power the external sensor for one second, log data
and then turn off the excitation power for the next 59 seconds.

Always enable the logger's internal battery channel when logging with excitation
power. If the battery becomes too low to provide excitation power, excitation power is
turned off, but logging continues as long as the battery can power the logger. This will
cause the further readings on that channel to become inaccurate. If you are logging the
internal battery channel when this happens, an Excitation Off event will be shown in
your datafile to mark the point at which excitation power was disabled.

Configuration
You configure Excitation Power from the Configure Channel window.

1. Click on the Set Excitation Power button to open the Excitation Power window.
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Configure Channel @

~Channel Info
Module Name: Analog Channel
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2. Check off the Excitation Power Used box.
3. Select the Mode.

a.If the Mode is Warm Up, select the warm up time in seconds.

4. Click OK.

Modes

Warm up

When in Warm up Mode the logger supplies excitation power for a brief, user-
programmable period prior to each measurement. This mode allows you to select the
minimum warm up time needed to allow for sensor stabilization, while conserving
battery power.

For example, if you specify a warm up of one second and set the Logging Interval to one
minute, the HOBO U30 Station will power the external sensor for one second, log a
measurement, and then turn off the excitation power for the next 59 seconds. The
warm up time can be up to 120 seconds.

If the warm up time selected is greater than the logging interval selected, the logger
will interpret the excitation mode as continuous.
Continuous

When in Continuous Mode the logger supplies constant excitation power to the sensor
for the entire duration of the deployment. This mode will result in reduced battery life.
Continuous mode is required if the sensor needs more than two minutes of warm up
time.

The Analog Sensor Ports begin functioning when logging begins. When the ports are
functioning correctly, the Active indicator LED on the port blinks once per logging
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interval to indicate that a successful measurement has been made. The Ex. On indicator
LED will also be lit when excitation is enabled.
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Loading a Saved Configuration

The Load Configuration window lists all defined configurations in the currently
selected folder that are compatible with the module/port.
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1. Use Default Module/Port Configuration
2. Use Configuration File

3. File Location: To browse to a file in a folder other than the default, click Choose
Folder.

To load a file from the default directory, select it from the list.

4. Click Continue.

5. Click Configure to send the currently displayed configuration to the
module/port.

The module/port will remain in this configuration until you send a different
configuration to it.

NOTE: If you are experiencing problems with the module, you can reset the channel to
its default configuration. Select Use Default Module Configuration, then click Continue.
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Resetting a Module to the Default
Configuration

If you are experiencing problems with a module, you can rest it to the default

configuration.
Steps

1. From the Device menu, choose Configure Modules/Ports.

2. Inthe Select Channel to Configure window, select a channel and click
Configure.

3. Inthe Configure Channel window, click the Load button.
The Load Configuration window appears. This lists all defined configurations in
the currently selected folder that are compatible with the module/port.

4. Choose a configuration.

To use one of the previously saved configurations, click the button next to Use
Configuration File, then click the button next to the name of the configuration file
you want to use.

To get a file from a different location, click on Choose Folder and browse to the
desired directory.

NOTE: If you are experiencing problems with the module, you can reset the
channel to its default configuration by selecting Use Default Module Configuration,
then click Continue.

5. Click Continue.

This will take you back to the Configure Channel window.

6. To send the currently displayed configuration to the module/port, click

Configure.

The module/port will remain in this configuration until you send a different
configuration to it.

Default Module Configurations

The following screen shots show the default configuration for the analog modules. The
configuration is the same for both channels.
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Working with a Shuttle (HOBOware
Pro Only)

NOTE: HOBO Shuttles require HOBOware Pro.

HOBO shuttles provide a convenient way to read out and relaunch loggers in the field.
The HOBO U-Shuttle features a text display and is compatible with all loggers that can
be used with HOBOware Pro. The HOBO Waterproof Shuttle communicates with
HOBOware-compatible optic loggers.

NOTE: To use a U-Series logger (other than the HOBO U30 Station) with a shuttle, the
logger must first be launched with HOBOware version 2.2 or higher at least once.
Consult the shuttle user guide for details.

HOBOware Pro allows you to launch these shuttles, collect logger data in the field, and
offload the datafiles from them.

e Shuttle Management window
o Offloading Files from a Shuttle
o Saving Files from a Shuttle

o Deleting shuttle files

For detailed instructions refer to the user guide that came with your shuttle.

Shuttle Status
To check the shuttle status, go to the Shuttle Management window.

U-Shuttle Firmware Updates

To update your U-Shuttle's firmware, download the firmware update file from the
website, then choose Update U-Shuttle Firmware from HOBOware Pro's Help menu.
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The Shuttle Management Window

This topic describes the fields in the Shuttle Management window for the U-Shuttle and
Waterproof Shuttle.

NOTE: You can only offload HOBO Shuttles using HOBOware Pro.

U-Shuttle Battery Life

While the Shuttle Management window is displayed, the U-Shuttle remains on battery
power for up to an hour. After one hour, or any time the U-Shuttle's main battery level
becomes low, the window closes and the shuttle powers down. To further conserve the
shuttle's battery life, you should close the window, disconnect the shuttle, and turn the
shuttle off as soon as you finish working with it.

The Waterproof Shuttle is powered by the USB port, and does not need to be turned
off.
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1. Device Details
Device Type: Shuttle model and description.
Serial Number: Serial number of the shuttle.
Firmware Version: Version number of the shuttle's firmware.
Main Batt Level (AA)(U-Shuttle only)

Condition of the shuttle's main batteries. Consult the U-Shuttle User's Guide for
specifics on battery capacity.

Clock Batt Level (CR1225) (U-Shuttle only)

Condition of the battery that provides backup power to the shuttle's clock. Consult
the U-Shuttle User's Guide for details.
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Battery Level (Waterproof Shuttle only)

Condition of the shuttle's batteries when you opened the Waterproof Shuttle
Management window. If the batteries are low, remember to change them before
going into the field. Consult the Waterproof Shuttle User's Guide for specifics on
battery capacity.

Last Launched

Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC) when the
shuttle was last launched.

Computer Clock: Time reported by the computer's clock.

Shuttle Clock

Status of the shuttle's clock in relation to the computer's clock. If the difference is
more than five seconds, the shuttle clock label and icon will flash red. The shuttle's
clock is synchronized to the computer when you launch the shuttle or press the Set
Shuttle Clock button.

2. Files on Shuttle

This panel lists the logger datafiles that are available to be offloaded from the shuttle. If
the shuttle is empty, this will say "No Files Available on Shuttle."

Status: Message that describes the state of the datafile on the shuttle. When HOBOware
Pro is offloading a file from the shuttle, the status message is replaced by a progress bar.

For the U-Shuttle only, the status message AWAITING OFFLOAD appears when
HOBOware Pro is offloading files from the shuttle, and FINISHED after each file is
offloaded.

For the Waterproof shuttle only, files have the status message OFFLOADED only if
the file has been offloaded from the shuttle and saved as a datafile. If the file has not
been offloaded, or it has been offloaded but not saved, its status is NOT
OFFLOADED.

Logger Type: Model and description of the logger that logged the data in this file.
Serial No.: Serial number of the logger that logged the data in this file.

Launch Desc.: Description entered when the logger was launched. This description will be
the default datafile name.

Launch Time: Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC)
when the shuttle was last launched.

File Size: Actual size of the datafile.
3. Check All/Uncheck All
Use these buttons to check or uncheck all of the files on the shuttle to be offloaded.

4. Synch Shuttle Clock

-170 -



HOBOware User’s Guide

Click this button to synchronize the shuttle's clock to the computer clock without
launching the shuttle. (Exit HOBOware Pro if you need to update the computer's clock
first.)

Important: If the difference between the shuttle's clock and the computer's clock is more
than 59 minutes, the Set Shuttle Clock button is not available. You must launch the shuttle
to correct the time difference.

5. Launch Shuttle

Click this button to Launch the shuttle. Launching the shuttle will delete all datafiles and
reset the shuttle's clock.

Re-Launching the shuttle also repairs a corrupted header.
6. Offload Checked

Click this button to offload all checked files to the computer.
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Offload Files from a Shuttle

NOTE: HOBO Shuttles require HOBOware Pro.

To offload datafiles from a shuttle to a computer:

1. Connect the shuttle to the computer.

2. Choose Manage Shuttle from the Device menu.

Alternate Method: To quickly offload all of the new datafiles that are on the shuttle,
choose Readout from the Device menu.

3. Choose files to offload:

U-Shuttle

All files are selected by default if the shuttle has not been offloaded before. To uncheck all
files, click the Uncheck All button. To uncheck individual files, click the checkbox next to
each file.

Waterproof Shuttle

Only the files that have not previously been offloaded and saved are selected by default. To
check or uncheck individual files, click the checkbox next to each file. Use the Check All
and Uncheck All buttons next to Previously Offloaded Files and New Files (Not
Offloaded) to control the selection of these groups of files.

To automatically delete files from a Waterproof Shuttle after you offload and save them,
enable the Delete Contents Upon Offload option. Files will be automatically deleted only
after you successfully save them to the host computer.

4. Offload Files

Click the Offload Checked button to begin offloading the datafiles.

Once offloading begins, the Offload Checked button will change to Cancel Offload.
When offloading is complete, the Files on Shuttle panel on the Shuttle Management
window will change to a Files Offloaded From Shuttle panel.

You can now save the files to your computer. See Saving Files from a Shuttle 173.
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Saving Files from a Shuttle

Before you can save files, you must offload them from the shuttle. See Offloading Files
from a Shuttle 172.

Saving Files

The illustration below shows the parts of the Shuttle Management window related to
saving files.
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1. Save Folder

The default location for the save is indicated in the Save Folder box. To change to
another location, click Choose and browse to the location

2. Automatically Open Files
To have the folder automatically open on the desktop after the files are saved, check:
Windows: Open Folder in Windows Explorer after Save.

Mac: Open Folder in Finder after Save.

3. Choose files to save.
By default, all of the files you offloaded will be selected for saving.
To uncheck individual files, click the checkbox next to each file.
To uncheck all files, click the Uncheck All button.
To save all files (if you have already unchecked a few), click the Check All button.
4. Datafile Name
Enter a new name if desired.
5. Cancel Save
To exit without saving any files, click Cancel Save.
6. Save Checked

Click this button to save all checked files.
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The files are saved to the specified folder.
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Deleting Files from a Shuttle

NOTE: HOBO Shuttles require HOBOware Pro.

NOTE: If the Files Offloaded From Shuttle panel is displayed, you must save the
offloaded files (or cancel without saving) before deleting any files.

Deleting Files from a U-Shuttle

To delete all files from a U-Shuttle, whether they have been offloaded and saved or not,
click the Launch Shuttle button on the Shuttle Management window to launch the
shuttle. You cannot delete individual files from a U-Shuttle.

NOTE: Because the shuttle's header information occupies 64 KB, 3.94 MB is the
maximum amount of free memory available on a U-Shuttle.

Launching also resets the shuttle's clock and its Last Launched time.

Deleting Files from a Waterproof Shuttle

To automatically delete files after you offload and save them, enable the Delete
Contents Upon Offload option before clicking Offload Checked. Files will be
automatically deleted only after you save them.

To select specific files to delete, click the checkbox for each unwanted file on the Shuttle
Management window. To select all of the files that have already been offloaded, click
the Check All button next to Previously Offloaded Files. Then click Delete Checked.

To delete all files from a Waterproof Shuttle, whether they have been offloaded or not,
click the Launch Shuttle button on the Shuttle Management window to launch the
shuttle. This will also reset the shuttle's clock and its Last Launched time.
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Chapter 6: HOBOware Reference

The Filter Series Window

You can create a new series based on statistical analysis of an existing series over
specified periods of time.

NOTE: When you apply a filter, the graph rescales to accommodate all of the
displayed data.

Filter Series

Shiow the

Mazcirnumn Solar Radiation BCAREEE=D ~ | |Day w | interval

@—h Resultant Series Mame: |Max: Solar Radiation

Cancel H (o] 4 ]*—@

1. Statistic Type

Choose the type of statistic to use for the filter:

For sensor series, you can create a series showing the minimum, maximum,
or average over a period of time.

For external event series, you can create a series showing a cumulative
sum, or a count over a period of time.

For internal event series, you can create a series showing a count over a
period of time.

For series created by Data Assistants, additional filters may be available
(HOBOware Pro Only).

2. Interval

Specify the interval over which you want these values to be calculated.
3. Resultant Series Name

Enter a new Resultant Series Name, if desired.
4. Click OK.

The new series is added to the graph, the Details pane, and the Points pane.
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The Launch Window for Station
Loggers

This topic describes the Launch Window for the following station loggers:
e HOBO Weather Station (U21-01)
e HOBO Micro Station (U21-02)
e HOBO Energy Station (H-22)

e HOBO U30 Station (see Chapter 5 for more information)

For more details see Launch Parameters for Station Loggers.
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1. Logger Information: Logger Type, Serial Number, Deployment Number, and
Battery Level.

2. Description: A description you enter for the launch.
3. Channels to Log: See Channel to Log Guidelines for Station Loggers.

4. Wrap Around When Full: You have the option to allow station-type loggers to
wrap and continue logging after the memory has filled up. The newly logged
information will overwrite the oldest logged information. Check this box if you
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10.

11.

12.

13.

14.

15.

want the logger to continue logging, overwriting the older data, instead of
stopping when full.

Logging Interval: How often the logger will record data from the sensors.

Sampling Interval: The sampling interval allows you to take multiple
measurements within the logging interval, then average them together to create
a single logged measurement.

Logging Duration: The approximate time it would take to fill the logger's memory
based on the logging interval and the currently connected and enabled sensors, if
applicable.

Launch Options: Select when to launch the logger.
Help Button: Click to launch the on-line help for the Launch Window.

Utilities (HOBOware Pro Only): Depending on the logger and sensors connected,
various utilities are available.

Data Assistants (HOBOware Pro Only)

HOBOware Pro Data Assistants let you create new data series by
combining data recorded by the logger with additional data. When you use
a Data Assistant from the Launch window, the parameter set is saved and
applied to data every time you read out a logger. The derived data is also
shown when you check the latest readings in the Status window.

You can use the following Data Assistants from the Launch window
(others can only be used from the Plot Setup window): Pulse Scaling,
Linear Scaling, and kWh. This feature is available for the HOBO U30, the
HOBO H21 (Weather Station and Micro Station) and the HOBO H22
(Energy Logger) loggers.

Click on the Data Assistants button to access the Data Assistants window.
Select the desired assistant and click the Create button to run the selected
assistant. After you enter values, click Save Parameter Set.

See HOBOware Pro Data Assistants for more information. See the assistant
on-line help or user guide for more information on a specific assistant.

Alarms

If alarms are available on the logger, the Alarms button will be active. Click the
Alarms button to access the Alarm Configuration window.

User Notes: You may enter up to 2000 characters of information about the
deployment. This text will be displayed in the Details pane after you read out the
logger and display the data.

Skip launch window next time: Check this box if you would like to bypass this
window the next time you launch a device.

Launch Button: Click to launch the device.
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The Launch Window for U-Series
Loggers

The Launch Window for all U-Series loggers (except the U30 Station) is shown below.

See Launch Options for U-Series Loggers on page 49 for more information.
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1. Logger Information: Logger Type, Serial Number, Deployment Number, Battery
or Battery Level.

2. Description: Enter a description for the launch, up to 40 characters, in this field.
This description is used as the default file name when you read out and save the
data recorded by the logger. It is also the title of the graph

3. Channels to Log: See Channels to Log Guidelines for Station Loggers.

4. Logging Interval: The rate at which you want the logger to record data.

Logging Duration: Approximate time it would take to fill the logger memory
based on the logging interval and currently enabled sensors.

6. Launch Options: When to launch the logger.
7. Help Button: Click to open the on-line Help for the Launch window.

8. Skip launch window next time (HOBOware Pro only): Check this box if you would
like to bypass this window the next time you launch a device.

9. Launch Button: Click to launch the logger.

-179 -



HOBOware User’s Guide

10. Utilities (not available on all loggers): Includes Scaling, Alarms.
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Merge Series Setup Window

Use the Merge Series Setup window to combine multiple datafiles from a deployment
into one file.
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1. Series in Selected Datafile(s)

All series available in the selected datafiles appear on the left side of the Select
Series to Plot section. Uncheck any series you do not want to include in the
merge.

2. Merge With

All matching series available in the selected series will be populated in the Merge
With section, to the right of the corresponding series. Each new series can only
be merged with the series of the same measurement type.

If no matching series (of the same measurement type) is available in the plot, the
Merge With list will show No Series. If a matching series is found, you can still
append the series without merging by choosing no series from the Merge With
list. The series will be appended to the plot without being merged with any
series.

3. Data Assistants

Any Data Assistants that have been used for a series will appear in the Data
Assistants section, appended with the file name. If you click the Process button,
the Data Assistant will process the file associated with it. The new series
resulting from the Data Assistants will be appended to the channels panel.
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4. Plot button

Click the Plot button to merge selected series with their matching series. The
new series unit will be converted to the matching series unit (if needed) before

the merge.
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The Plot Setup Window

After you read out a logger or open a saved datafile, the Plot Setup window appears.
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1. Description - Enter text to describe the plot.

2. Select Series to Plot - Select the series you want to plot and the units, if
applicable.

3. Select Internal Logger Events to Plot - Select internal logger events to plot (only
available for some loggers).

4. Offset from GMT - Set the Time Zone Offset from GMT if required.
5. Data Assistants (HOBOware Pro Only)

HOBOware Pro Data Assistants let you create new data series by combining data
recorded by the logger with additional data.

NOTE: The following Data Assistants can also be run from the Launch window:
Pulse Scaling, Linear Scaling, kWh.

6. Plot Button - Click this button to plot the selected data on a graph.
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Select Channel to Configure Dialog

1. Click the plus sign next to the module/sensor name to see available channels.

2. Select the desired channel.

3. Click on the button for the action you want to perform: Disable, Configure,
Refresh.

If you click Configure, the Configure Channel window appears.
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This topic describes the elements in the Status window:
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Device Identification: Includes device type and serial number.

Current Readings: Shows current readings for attached sensors.

Device Details: Includes Battery Level, Memory Used, Current Status, and Current

State.

OK Button: Click to close the Status window.

Help: Click to launch the Help for the Status window.

Identification

Device - Logger model and description.

Manufacturer - Manufacturer of the logger.

Description - Description entered when the logger was last launched. This
description will be used as the default file name and the title in the graph.

Serial Number - Serial number of the logger.

Firmware Version - Version number of the logger's firmware.
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Contact HOBOIlink (HOBO U30 Station Only)

For the HOBO U30 Station only, a Contact HOBOlink button appears at the bottom of
the Status window. Click this button when you want the HOBO U30 Station to connect
to HOBOlink. When you click Contact HOBOIink, a confirmation message is displayed.
Once you click Yes, the Status screen will close and then the HOBO U30 Station will
attempt to connect to HOBOlink within 30 seconds. A warning may appear in the event
that a live connection with HOBOlink is already underway.
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Configure Scaling Window

You must configure scaling for the following third-party sensors that are not scaled
automatically by HOBOnode Manager.

e Wattnode: T-WNB-3Y-208/ T-WNB-3D-240 / T-WNB-3D-480

e Veris: T-VER-8051-300/ T-VER-8053-800/T-VER-H970-200/T-VER-971BP-
200/T-VER-PXU-L/ T-VER-PXU-X

e Jon: T-ION-TVOC

Configure Scaling Window

Scaling Type |REUUCITERIEI
_ Click here to view Scaling
o Olnoar (=) Pubse | ¥iew Scalng Factors... 4——  Factors by sensor

Mate: Linear zcaling it generally uzed with snalog input,

and pulsa scaling with pulze input, This senzor measuns
analog eput.

Scaling Parameters

Raw Scaled
Measurement: Yoltage Power +—® Scaled Measurement
Raw Value 1 Uniks: ¥ ki -l-—@ Scaled Units
(O —f— vaen: 13 = | ooz 3 et (5) Scaled Value 1
Ve 2! =

[camcel | [0k |

1. Scaling Type - The Scaling Type is automatically selected based on the type of
sensor selected. Linear scaling is enabled for analog sensors; Pulse scaling is
enabled for pulse sensors.

2. Measurement

Raw - This is the source measurement type.

Scaled - Enter the scaled measurement type.
3. Units

Raw - This is the type of output the sensor has; either V or mA, corresponding to
the type of sensor selected. Raw Value 1 and Raw Value 2 should be input with
this unit.

Scaled - Enter the scaled units.

4. Valuel
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Raw - The low raw value given by the external sensor.

Scaled - The value that will appear on the graph when the sensor reports a raw
value equal to Raw Value 1. This value should be entered in the same units that
are specified in the Scaled Units box.

5. Value 2

Raw - The high raw value given by the external sensor.

Scaled - The value that will appear on the graph when the sensor reports a raw
value equal to Raw Value 2. This value should be entered in the same units that
are specified in the Scaled Units box.

Click OK when done.

Click the View Scaling Factors button to see Scaling Factors by sensor.

Scaling Factors

Click the link below to see the scaling factors for your sensor model.
Wattnode: T-WNB-3Y-208/ T-WNB-3D-240 / T-WNB-3D-480
Veris: T-VER-8051-300/ T-VER-8053-800

Veris: T-VER-H970-200

Veris: T-VER-971BP-200

Veris: T-VER-PXU-L/ T-VER-PXU-X

[on: T-ION-TVOC
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The File Menu

From the File Menu you can open datafiles and projects, import and export data, and
print plot elements.
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1. Open Data File(s) - Select this option to open a compatible datafile. See Opening
Files 73 for more information.

2. Merge Datafile(s) - Select this option to add a datafile to the end of another
datafile.

3. Open Project - Select this option to open a HOBOware project. See Opening Files
73 for more information.

4. Plot/Export Wireless Data - This applies to a data node network and is only
available in HOBOware Pro.

5. Recent Files - Select this option to quickly access the last 10 files you opened.
6. Close - Select this option to close the active file or project.

7. Close All - Select this option to close all open files and projects.

8. Save Datafile - Select this option to save the active datafile.

9. Save Project - Select this option to save the active project.
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10.

11.

12.

13.

14.

15.
16.
17.
18.
19.

20.

Import Text Data (HOBOware Pro Only) - Select this option to graph non-
HOBOware data by importing data from certain text files. See Importing Text
Files 130 for more information.

Import Text File from HOBOlink - Select this option to open a text file generated
by HOBOlink for a HOBO U30 Station.

Export Details - Select this option to export the information in the Details Pane
into a text file that can be opened in any text editor, or imported into many other
types of programs (word processors, spreadsheets, etc.). See Exporting Details
Error! Bookmark not defined. for more information.

Export Table Data - Select this option to export the points shown in the Points
table to a text file (.csv or .txt) for importing into Microsoft Excel and other
applications. See Exporting Points as Excel Text for more information.

Page Setup - Select this option to set up your paper size, margins, and orientation
for printing a graph.

Print Preview - Select this option to preview the page for printing a graph.
Print - Select this option to print a graph.

Print Details - Select this option to print the Details Pane.

Print Points - Select this option to print the Points Table.

Preferences - Select this option to access the Preferences window to change the
default behavior of HOBOware. See Setting Preferences for more information.
Note: Preferences is available from the HOBOware menu on Macintosh.

Quit - Select this option to close HOBOware.
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The Device Menu

This topic describes the options in the Device menu.

BN Edit Wiew  Window  Help

2 Launch... Chrl+L
' Readout... Ctrl+R
b Status... Chri+I
.} Stop... CErl-HE
Manage Shuttle. .. Ckrl4+3hifE+m
Manage HOBO Data Mode Mebwark, .. Crrl+Shifk+H
Configure Modules)Ports., ., Ckrl+Shift+C
Conkral 30 Relay [
Configure U30 Alarms ]
|} select Device. .. kel
Default Action ]
IItilities b

1. Launch - Select this option to access the Launch window to configure launch
parameters and launch a logger.

2. Readout - Select this option to copy data from a logger to your computer,
allowing you to save the data in a datafile and view the plot in HOBOware.

3. Status - Select this option to view real-time information about the attached
logger, including: state of the logger, time logging will begin, current readings,
logger memory used.

4. Stop - Select this option to stop a device.

5. Manage Shuttle (HOBOware Pro Only) - Select this option to manage a
HOBO shuttle. See Working with a Shuttle Error! Bookmark not defined. for
more information.

6. Manage HOBO Data Node Network (HOBOware Pro Only) - Select this option to
open the HOBOnode Manager.

7. Configure Modules/Ports (HOBOware Pro Only) - Select this option to configure

analog sensor ports or Flexsmart modules.

8. Control U30 Relay - Select this option to configure the default state of a relay on a
HOBO U30, or to activate or deactivate the relay for testing. See Controlling the
Relay on the HOBO U30 Station for more information.

o

Configure U30 Alarms - Select this option to set up alarms on the HOBO U30
Station.
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10. Select Device - Select this option to select a device that is connected to the
computer.

11. Default Action (HOBOware Pro Only) - Select this option to configure HOBOware
Pro to perform the same action (Launch, Readout, or get Status) every time a
logger is connected. See Repeating an Action on Multiple U-Series Devices 54 for
more information.

12. Utilities - Select one of the three Force Offload options only if you are having
problems reading out your device or as directed from Onset Technical Support.
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The Edit Menu

This topic describes the options in the Edit menu.

%1 HOBOware Pro

File

Device WEslM Wiew  Window Help

Filker Series

= E
(,LJJ I_A [ Copy Series: RH ChrlHiC

Paste Serigs Chel+Y
add Graph Label, ..
Rerove Series: RH Delete

[#| Eraph Properties

[fl Convert Units

|2 Undo Action: Click Crosshair Ctrl4-2

[ Redo Action: Drag Plok Crl+y
Copy Graph to Clipboard

Filter Series - Select this option to create a new series based on statistical
analysis of an existing series over specified periods of time. See Filtering a Series
(page 176) for more information.

Copy Series - Select this option to copy a series and then paste it into another
plot. See Copying a Series to another Plot 144 for more information.

Paste Series - Select this option to paste a series into another graph. See Copying
a Series to another Plot 144 for more information.

Add Graph Label - Select this option to access the Add Graph Label window to
add labels to a graph to identify specific points or call attention to a region of the
graph. See Adding Labels to a Graph (page 89) for more information.

Remove Series - Select this option to remove a series from a plot after you have
selected the series in the graph or in the Details pane. If you remove a series, it
can only be recovered by reopening the original datafile or a saved project file
that contains the series.

Graph Properties - Select this option to access the Series Properties window. See
Setting Series Properties 87 for more information.

Convert Units - Select this option to access the Convert Plot window, which
allows you to convert some or all of the series on the currently focused plot to
other units (for example, from degrees Fahrenheit to degrees Celsius).

NOTE: Changing the units of a plot will result in the entire plot being redrawn.
See Converting Units (page 96) for more information.

Undo Action - Select this option to undo the last change made to the current plot.
The most recent change is listed after the Undo Action menu choice. In this
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10.

example, the most recent change to the plot was to "Click Crosshair." See Undo
and Redoing Plot Changes for more information.

Redo Action - Select this option to redo the last change that was previously
undone. The most recent change that was undone is listed after the Redo Action
menu choice. In this example, the most recent change that was undone was "Drag
Plot." See Undo and Redoing Plot Changes for more information.

Copy Graph to Clipboard - Select this option to copy the graph to the clipboard.
You can then paste it into another text editor or word processing application.
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This topic describes the options in the View menu.

* HOBOware Pro
File Device Edt RUEUE Window Help

10.

11.
12.

1 % Zoom In

2 =%, Zoom Out

3 ) view Full Scale |
4 W Details Pane

5 v Poinks Table I
6 v Shiow Title

T v Shiows Legend

8 2 Mark All Poinks

9« M VYertical Gridlines

10 M| Horizontal Gridlines

1 Select None

12

13

14 Bring Series To Fronk

15

Send Series To Back

Zoom In - Select this option to access the Zoom In tool.

Zoom Out - Select this option to access the Zoom Out tool.

View Full Scale - Select this option to view the graph in full scale.

Details Pane - Select this option to show or hide the Details Pane.

Points Table - Select this option to show or hide the Points Table.

Show Title - Select this option to show or hide the Graph Title.

Show Legend - Select this option to show or hide the Legend.

Mark All Points - Select this option to mark all points.

Vertical Gridlines - Select this option to show or hide vertical gridlines on the

graph.

Horizontal Gridlines - Select this option to show or hide horizontal gridlines on

the graph.

Select None - Select this option to deselect all elements in the graph.

Remove Crosshair - Select this option to remove crosshairs from the graph.
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13. Remove Subset Stats - Select this option to remove a subset from a graph.
14. Bring Series To Front - Select this option to bring a series to the front in a graph.

15. Send Series To Back - Select this option to send a series to the back of a graph.
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The Window Menu

Use the Window menu to organize several plots.

= HOBOware Pro
Edit  Wiew RUGHGTE Help
1 e || Tabbed View  Cerl#Shift+T
2 = Tile Horizonkally Chrl+Shife+H
3 L Tile Mertically  Crrl+Shift+Y

File Device

1. Tabbed View - Layers the plots as tabs so that you can see the file name of each
open plot (or "Untitled*" for an unsaved datafile). You can also get to this view by
clicking the Tabs icon in the lower left of the window.

2. Tile Horizontally - Arranges up to five plots horizontally. If six or more plots are
open, they will be tiled as a grid. You can also get to this view by clicking the
Horizontal Tile icon in the lower left of the window.

3. Tile Vertically - Arranges up to five plots vertically. If six or more plots are open,
they will be tiled as a grid. You can also get to this view by clicking the Vertical
Tile icon in the lower left of the window.

Multiple Views

You can open the same datafile multiple times to create different views of the graph,
then use the Tile commands on the Window menu (or resize and move the windows
manually) to see all of them at once. This is helpful if you want to zoom in on several
different areas and view them side-by-side, see the detail of a small area while the full
graph is still in view, or view each series in a different window.
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The

Help Menu

Use the Help menu to get more information about HOBOware, upgrade the software
and certain devices, and request help from Onset Technical Support.

HOEOware Help F1
Check for Updates. ..

Update J-DT-1/U-DT-2 Firmware, .,
Manage License Key, ..

Enable Logging...

Submit Technical Support Request, .,
About HOBCware Pro

HOBOware Help - Select this option to open the help system, displaying the full
table of contents.

Check for Updates - Select this option to check if there are any HOBOware
updates available on the Onset website. You can also set the general startup
settings in Preferences to automatically check for software updates on a
schedule that you select.

Update U-DT-1/U-DT-2 Firmware - Select this option if you need to update the
firmware on your shuttle (Part numbers U-DT-1 and U-DT-2 only). You should
only need to do this as directed by Onset Technical Support.

Manage License Key - Select this option if you need to enter a new license key.
This is only necessary if you are running a trial version of HOBOware and have a
new license key to enter, or if you are using HOBOware Lite and have a license
key to upgrade to HOBOware Pro.

Enable Logging - Select this option to turn on logging within HOBOware. When
logging is enabled, a series of text files will be generated and saved every time
you use HOBOware. It is recommended that you only enable logging when
requested to do so by Onset Technical Support, who may need additional files to
troubleshoot any technical problems you may be having with the software.

Submit Technical Support Request - Select this option if you are having a
problem with HOBOware and would like to request help from Onset Technical
Support. Fill in all the requested information in the form, including your name,
email address, logger/device model name and serial number, and a detailed
description of the problem you are encountering.

About HOBOware - Select this option to see which version of HOBOware you are
using. Note: This option is available from the HOBOware menu on Macintosh.
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The Toolbar

The toolbar, located at the top of the main HOBOware window, allows point-and-click
access to the most frequently used functions. Pause the pointer over each icon on the
toolbar for a description of each tool.

S8 ad-- B-E-oRSED v+t FQNEMEMETo= ?
LLJJ Launch - Opens the Launch window.

I= .

I_cJ Readout - Opens the Readout window.

=
I_lJ Status - Opens the Status window, which displays the logger's state and current
readings.

i I.'Stop - Stops a logging logger.

|_| Select Device - Opens the select Device window, which displays available devices.
For HOBOware Pro, the accompanying pulldown menu allows you to specify whether
you want HOBOware to look for USB devices, serial devices, or both.

U
|5:|S Set Default Units - Change the default unit type between US and SI. Any changes you
make will take effect with the next plotted file.

I:l Undo Action - Undoes the most recent change made to the plot.

|r_| Redo Action - Redoes the most recent change that was undone to the plot.

L] Open - Launches the Open window, from which you can open HOBOware files.

|.if|.| Save - Opens the Save window, from which you can save the plot as a project
(-hproj) file.

45 Close - Closes the currently focused plot.
>
4.?3 Export - Opens the Export Options window, from which you can configure settings

for exporting a text file of the data (in .csv or .txt format) for use in spreadsheet and
other applications.

' Print - Prints the graph as it appears on your screen.

Rﬁ Arrow - Launches the Arrow Tool, which you can use to point to and select items on
the graph to edit their properties.

-i- Crosshair - Launches the Crosshair Tool, which you can use to display values for
points on the graph and cross-references them to cells in the Points pane.

" Hand - Launches the Hand Tool, which you can use to scroll an axis or the entire
graph.
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<, Zoom - Launches the Zoom Tool, which you can use to adjust the scaling of an axis or
the entire graph.

R subset Statistics - (HOBOware Pro Only) Launches the Subset Statistics Tool, which
you can use to view statistics for a particular time span.

% In - Launches the Zoom In Tool, which allows you to zoom in on a smaller area of
the graph.

L'{\’ Out - Launches the Zoom Out Tool, which allows you to zoom out to a larger area of
the graph.

S
l—l—l Show Graph at Full Scale - Resets the scale of a graph to accommodate all of the
displayed data.

|§_| Graph Properties - Opens the properties window for the element currently
selected (such as series, legend, axis).

w Vertical Gridlines - toggles vertical gridlines on or off.

lﬁl Horizontal Gridlines - toggles horizontal gridlines on or off.
lEl Mark Points - toggles point markers on or off.
g8

|_| Units - Opens the Convert Units window, which allows you to convert some or all of
the series on the currently focused plot to other units (for example, from degrees
Fahrenheit to degrees Celsius).

S—
i Filter Series - You can create a new series based on statistical analysis of an existing
series over specified periods of time.

Abc
Ea Add Graph Label - Opens the Graph Labels Properties dialog, which allows you to
add a label to the plot or to a specific series, and change the appearance of that label.

? - Help - opens the Help.
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Using the Crosshair Tool

Use the crosshair tool to zero in on a specific date and time in the plot and any data
points associated with that date and time.

1. Select the crosshair tool:
Click the Crosshair icon -#- on the toolbar, or press the C key on your keyboard

2. Click a point on the graph to mark it.

3. Click another point to move the marker.

NOTE: When you click on a graph, HOBOware selects the nearest data point. When
series are very close together, and the location you click is between two points, it is
possible that the nearest point is not on the series you clicked.

You can also mark the point on the graph by clicking the corresponding cell in the
Points table.

Scrolling

Normally, if you are zoomed in and click a point in the Points table that is outside the
zoom area, HOBOware will scroll to the marked point's area of the graph. If you do not
want HOBOware to scroll, change the setting under Points Table & Details Pane on
the Plotting preference pane.

Changes to Plot

The plot changes in several ways when the crosshair is in use. The Points pane shifts to
the row that contains the data point. Where the crosshair intersects a data point, a
square surrounds the data point. The intersection points are also marked by small
color-coded arrows on the left and right value axes.

Legend

If the legend is displayed next to the graph, the point values for each series are updated
to reflect the crosshair location. Values are listed in the legend differently depending on
whether the data is a logged sample, state, or event:

e Values that are not in parentheses are actual data points logged at the time
selected by the crosshair.

e Values in parentheses are estimated because there were no exact values for the
series at the time selected by the crosshair. Zoom in or move the crosshair to see
actual values.

e Avalue of "..." indicates that there is no series data during the time selected. This
is seen most frequently for events. If the time selection falls within an event
series, but does not contain an event, parentheses surround the "..." value.
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e Avalue of "logged" indicates an internal logger event happened at the selected
time.

NOTE: The legend must expand in height to list the point values. If your application
window is too small to accommodate the expanded height, the values will not be added
to the legend. You can still refer to the Points table to find the values of the selected

points.

Removing the Crosshair

To remove the crosshair from the graph, right-click on the graph and select Remove
Crosshair from the pop-up menu. Or, choose Remove Crosshair from the View menu.
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The Zoom Tool

Overview

Use the zoom tool to focus on one area of the graph, allowing you to see more detail.

NOTE: Zooming will not work on an axis that is locked. To unlock an axis, double-click
the axis with the arrow tool and clear the checkmark next to Lock Axis Scaling and
Tick Marks.

Using the Zoom Tool

To select the zoom tool:

e (lick the Zoom icon Q on the toolbar; or

e Press the Z key on your keyboard.

Toggle

Right-click to toggle between zoom in and zoom out.

Zoom Direction

Check the symbol inside the zoom tool to determine the direction you are zooming. A
plus sign (+) or arrows pointing outward will zoom in, while a minus sign (-) or arrows
pointing in will zoom out.

Level

Click an area on the graph inside the axes to zoom one level (a factor of two). Continue
clicking to zoom multiple levels.

Zoom Continuously

Hold down the left mouse button in one location to zoom continuously. Release the
mouse button to stop zooming.

Zoom in Area

Hold down the left mouse button while drawing a rectangle around the area you wish
to zoom in on, then click inside the rectangle. The area inside the rectangle expands to
fill the whole graph.

Restrict Motion

Hold down the X key while zooming to restrict motion horizontally. Hold down the Y
key while zooming to restrict motion vertically.

Tips:
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o Ifyou are currently working with the crosshair, arrow, or hand tool, you can click

the Zoom In/Out icons % and l‘_"!b on the toolbar to quickly zoom into and out
of the middle of the display without changing tools.

e When you first display a graph, the numerical bounds of the axes are on tick
marks. After you have panned or zoomed, this may no longer be the case. Use
smart scaling to correct that. With the hand, arrow, or crosshair tool, right-click
anywhere on the graph and select SmartScale Graph. This will automatically
adjust the axes to end on tick marks.

* You can always return to the original plot view by clicking the View at Full Scale

&
l—l—l from the toolbar or the View menu.
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The Hand Tool

Overview

Use the hand tool to move different areas of the graph into view or adjust the position
of one series so it can be viewed more easily. This is particularly useful when you are
zoomed into the graph and want to see another section of the graph without zooming
out and then zooming back in on the new location.

NOTE: Panning will not work on an axis that is locked. To unlock an axis, double-click
the axis with the arrow tool and clear the checkmark next to Lock Axis Scaling and
Tick Marks.

Using the Hand Tool

There are two ways to select the hand tool:

e (lick the Hand icon ‘ﬁfr? on the toolbar; or

e Press the H key on your keyboard.

Pan Across Graph

Click within the graph and hold down the left mouse button to pan a different section of
the graph into view. The graph follows the movement of the mouse, and the axes are
continuously updated in response to the movement. To stop dragging, release the left
mouse button.

Restrict Motion
Hold down the X key while dragging to restrict motion horizontally. Hold down the Y
key while dragging to restrict motion vertically.

Pan One Series at a time

Click the axis associated with the series and hold down the left mouse button. Only the
series connected with the axis will follow the movement of the mouse.

Tips:
e When you first display a graph, the numerical bounds of the axes are on tick
marks. After you have panned or zoomed, this may no longer be the case. Use
smart scaling to correct that. With the hand, arrow, or crosshair tool, right-click

anywhere on the graph and select SmartScale Graph. This will automatically
adjust the axes to end on tick marks.

e You can always return to the original plot view by clicking the View at Full Scale

&,
l—l—l from the toolbar or the View menu.
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Setting HOBOware Preferences
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Preferences

You can change the default behavior of HOBOware in the categories listed below.
Preference settings are unique for each user login on your computer.

Some preferences have one of the following icons next to them, indicating a difference
in behavour between HOBOware and HOBOnode Manager.

General

Set Preferences for Export Settings, Selecting Devices, File Associations, Startup, Time-
Saving Options *, and Data Verification *.

* indicates that preference is available in HOBOware Pro Only

Communications

Set Preferences for Device Types *, Serial Ports *, Device Speed, and Other Options.
* indicates that preference is available in HOBOware Pro Only

Plotting

Set Preferences for Fonts, Layout Points Table and Details Pane, Gridlines, Plot Setup,
and Other Options.

Data Assistants (HOBOware Pro Only)

Set show/hide preferences for HOBOware Pro Data Assistants.
Display

Set Preferences for Default Unit System and Date/Time.
Warnings

Set Preferences for various warning types.

HOBOnode

Set preferences for HOBOnode Manager including General, Alarm, and Advanced (for
data storage).
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General Preferences

Use the General Preferences to control a variety of HOBOware behavior. You access the
General Preferences by going to File > Preferences > General.

Launch Time-Saving Options

See Launch-Time Saving Options on page 40.

Readout Time-Saving Options

See Readout Time-Saving Options on page 69.

Open File Time-Saving Options

¥ Open File Time-Saving Options

‘When opening a datafile: | Show plot setup

e When opening a datafile:

Show plot setup (default)
When opening a datafile, HOBOware Pro displays the Plot Setup window.
Automatically plot

Select this option to bypass the Plot Setup window and automatically
generate the plot.

Export Settings
See Export Settings on page 212.

Selecting Devices

¥ Selecting Devices
On any device operation (Launch, Readout, Status, Stop):

(&) Show Select Device window ) Only show Select Device window
if bwo or more devices are found, if a device has not been selected.
even if one is already selected,

e Show Select Device window ..... (default)

When multiple loggers are connected, HOBOware displays a window listing all
connected loggers every time you choose a logger operation, such as launch,
readout, status, or stop. This allows you to choose the device you want to work
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with before continuing with the command, and it ensures that you are always
working with the logger you expect.

Only show Select Device window if a device has not been selected

Select this option if you do not want to be prompted by the Select Device window
every time you choose a logger operation. You will still be prompted the first
time you try to communicate with a logger, but your logger selection will remain
in effect until you change it manually with the Select Device command on the
Device menu.

File Associations (Windows Only)

Use this option to control the association of file types with HOBOware.

NOTE: You must have administrator privileges on the computer to change file type
associations.

HOBO file types are: .hobo, .hsec, and .hproj.
DTF file types are: .dtf and .dsec.

¥ File Associations

Click buttons b change fle Hogo e bypes

UnMa
kype associations: - n

Click buttons to change file type associations.

Map

After you install HOBOware, files with extensions of .hobo, .hsec .dtf, .dsec, and
.hproj are automatically associated with HOBOware. This means that these files
are identified by a HOBOware icon and can be opened by double-clicking them.

Unmap

Select this option to disable the association of file extensions with HOBOware to
avoid conflicts with another software application.

Data Verification (HOBOware Pro Only)

¥  Data Verification

[] Enable Secure Mode

. In Secure Mode, HOBOware will add a digital signakure

ko saved datafiles upon readout (indicated by hsec or .dsec extension).
This digital signature ensures the integrity of the datafile
and will be werified each time the file is opened.

Mobs: In order o wiew a Full aedit bral, wou will need bo
laurech and resdont devices with secuve Mods enablad.

Enable Secure Mode (disabled by default)

Select this option to enable Secure Mode and have HOBOware Pro add a digital
signature to new datafiles when you read out loggers. The digital signature is
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indicated by a filename extension of .hsec for hobo files and .dsec for dtf files. The
signature will be verified each time you open the datafile to ensure its integrity.
This option is turned off by default.
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Startup Preferences

Use the Startup Preferences to customize how HOBOware performs on startup.
You access the Startup Preferences by going to File > Preferences > General > Startup

¥ Startup
Show splash screen on startup

Check for HOBOware updates: |Once per week v
When checking for HOBOware updates:

(®) Natify me of new HOBCOware add-on components and updates to my instaled components

() Matify me of updates ka my installed companents anly

e Show splash screen on startup

The splash screen appears when you start HOBOware, to let you know that the
software is loading. If you clear this checkbox, the splash screen will not display.

e Check for HOBOware updates:

If you have an Internet connection, HOBOware will prompt you once per week to
check the Onset website for updates to HOBOware (and for HOBOware Pro, other
associated software). You can change this to once per day or once per month.

If you do not have an Internet connection, or if you would prefer to check for
updates manually using the Check for Updates item on the Help menu, choose
Never (manual checks only).

e  When checking for HOBOware updates (HOBOware Pro Only):

Notify me of new HOBOware add-on components and updates to my installed
components (default)

When you check for software updates, HOBOware Pro informs you of
updates to HOBOware Pro components that you have installed, and also
notifies you if any new HOBOware Pro components are available.

Notify me of updates to my installed components only

Select this option if you do not want to be notified of any new components.
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Export Settings

Use this window to customize how your data is formatted when you export a data file.
You access the Export Settings by going to File > Preferences > General > Export
Settings

¥ Export Settings

Use BoxCar Format @—4 Uise defauit BoxCar Pro export settings |
@

Export File Type o Export fils type: |csv w0

[ I
: [#] Inchude ine: number column :
Table Data @—F: (] Inchude piot title in header :
| [ Absrarys shows fractional seconds |
: [] Separate date and time into two cohumns :

1
Column header: [] No quotes or commas in headings, properties in parentheses

T
1 I
Column Header @—-: [ inchude logger serial number :
I [

[ Inchude sensor serial umber, or labed If available

Date format: MDY % | Dabe sample: (1171209

|
|
I Date separstor: |Slash () +
|
|

Formats ®—'

|
|
|
|
Time Format: | 12-Hour % |
|
Posithve number Format: | 1,234.56 « |

|

|

Megative number format: |-1,234.56

Automatically @_» ] automaticaly export: table data upon readng out a logger
Expaort {Offloaded datafile must be saved and plotted First)

I * Bypass multi-fils export dislog and save as single fils |
Multi-file Expaort | (Exportedtable data wil be automatically saved with the same file prefix and in the same drectory as the offloaded datafie) |
{: ) I
|

Window

1. Use Boxcar Format

Click the Use default BoxCar Pro export settings button to export data using the
default settings for Onset's Boxcar Pro software, which are shown in the screen
capture at the bottom of this page.

2. Export File Type
Select the file type: Excel (.xls) or Text (.csv or xls).
3. Table Data

(This section does not apply for .xls File Type)
Select the desired Export table data column separator.

When Comma is selected as the column separator, the default file type is .csv,
which can be imported automatically into Microsoft Excel.

When Tab or Semicolon is selected for the column separator, the default file
type is xls).

Other options: Select or deselect options as desired.

eInclude line number column
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By default, exported files include line numbers. Uncheck this box if you do
not want line numbers included in the file (for example, to export in
Onset's BoxCar-like format)

eInclude plot title in header

Deselect this option if you do not want the plot title included in the header.
This option is primarily for compatibility with Onset's BoxCar Pro software
format.

¢ Always show fractional seconds

Select this option for compatibility with Onset's BoxCar Pro software
format.

e Separate date and time into two columns

This setting controls how the columns in the Points table are separated in
the export file. By default, date and time are exported as a single column to
facilitate graphing in spreadsheet programs. If enabled, this setting splits
the date and time into two columns.

4. Column Header
o No quotes or commas in headings, properties in parenthesis

Select this option for compatibility with Onset's BoxCar Pro software
format.

eInclude logger serial number

This setting adds the logger's serial number to each column header when
you export the Points table. This is especially useful if you are exporting
series that were copied and pasted from plots that came from different
loggers.

eInclude location string or sensor serial number (if available) (HOBOware Pro
only)

If this option is selected, the sensor's serial number (if available) is added
to each column header when you export the Points pane. This is especially
useful if you are exporting data that includes similarly-named series that
were recorded on different sensors; for example, a HOBO Weather Station
datafile with data from three temperature sensors.

If No quotes or commas in headings, properties in parentheses is selected,
the location string, if available, will be added instead of the sensor serial
number.

NOTE: In order to export the location string, you must also select Include
sensor Location (if available) in points table and details pane in the
Plotting Preferences pane.

5. Formats
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eDate Format - Select the format in which you want the date to be shown.

e Time Format - Select whether you want HOBOware to show the time in a 12-
hour or 24-hour format. The default is 12-Hour.

e Positive Number Format - Select the desired format for positive numbers

eNegative Number Format - Select the desired format for negative numbers
6. Automatically Export

Select Automatically export table data upon reading out of a logger if you want the
data to be exported to a separate text file every time a logger is readout and you
plot the data by clicking Plot in the Plot Setup window. An export file is saved in
addition to the standard data file.

7. Multi-File Export Window
e Bypass Multi-file Export

By default, the data will be exported to a single text file with the same prefix and
in the same location as the datafile. To export multiple files, uncheck this option.

e Show multi-file export Dialog

Select this option to save the exported data to multiple files, which may be
helpful if the datafile is very large.
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BoxCar Pro Format Settings

¥  Export Settings

Use defaulk BoxCar Pro export settings |

Export File bype; | Text {kxk or .csv) »
Export table data column separator: | Tab -
[ Include line number column
[] Include plot title in header
Always show Fractional seconds

[] Separate date and time into bwa calurns

Colurmn header: Mo quotes or cormas in headings, properties in parentheses
[] Include logger serial number

Include sensor serial number, or label string iF available

Date Format; |[M DY % | Date sample: |[12/03/09

Date separator: | Slash (f) |+
Time Format: | 24-Hour %
Positive nurber Farmat: | 1,234.56

Megative number Format: | -1,234.56

[] Automatically export table data upon reading out a logger
{Cffloaded datafile must be saved and platted First)

Evpass multi-file export dialog and save as single File
{Exported table data will be automatically saved with the same File prefix and in the same directory as the offloaded datafile)
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Communication Preferences

The following preferences are available on the Communications pane:

You access the Launch Time-Saving Options by going to File > Preferences > General
> Launch Time-Saving Options.

Device Types (HOBOware Pro Only)

¥ Device Types

Select device type: () USE devices only
(") Serial devices anly

(%) USE and serial devices

e Select device type

If you use only USB loggers or only serial loggers, click the appropriate button for
improved logger response time. Otherwise, if you use both types of loggers
regularly, keep the default of USB and serial devices. You can quickly change this

preference by using the pull-down menu next to the Select Device icon |_l on the
toolbar.

Serial Ports (HOBOware Pro Only)

¥ Serial Ports

Select Al

Setial pork(s) to use:

e Serial port(s) to use

Select the specific serial ports you want HOBOware Pro to search for devices, or
click Select All to have HOBOware Pro check all of the serial ports shown on this
list when it searches for devices. Note that if you want HOBOware Pro to use only
one port, you can have only one serial logger connected at a time. However,
checking multiple ports can cause slow performance, even when no loggers are

connected.

Device Speeds

¥ Device Speeds

Serial port speed: Fast serial enabled
(uncheck if using ethernet ko serial adapters or other slow ports)

1USE logger readout: Fast readout enabled
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Serial port speed: Fast serial enabled (HOBOware Pro only)

This setting allows the computer to read out your serial logger at a speed that is
appropriate for most systems. Disable this option only if you are having
communication problems with the logger; for example, when the logger is
connected via a slow serial-to-LAN bridge device. Communication between the
computer and the logger is slower when this option is turned off.

USB logger readout: Fast readout enabled

This setting allows the computer to read out your USB logger quickly. Disable
this option only if you are having communication problems with the logger.
Communication between the computer and the logger is slower when this option
is turned off.

Other Options

¥ Dther Dptions

Close the status window on logger disconnect or communication error
Nake: Status window opened from launch is dways cosed

Close the status window on logger disconnect or communication error.

When this option is selected, the Status window closes automatically (on the next
refresh) if it is open when you remove the interface cable, base station, or
coupler from the logger, or if communication is interrupted for another reason.
Otherwise, it is left open. If the Status window was opened from the Launch
window, it will close automatically even if this option is not selected.
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Plotting Preferences

Use the Plotting Preferences to control a varierty of aspects of a plot.
You access the Plotting Preferences by going to File > Preferences > Plotting

To apply certain preferences to a single series, double-click the series to open the
Series Properties window.

To apply changes to real-time HOBOnode plots in HOBOnode Manager, restart
HOBOnode Manager or delete the plot for the sensor (by unchecking the Plot box) and
then re-checking it.

Fonts

Use the Fonts Preferences to controls the size, type, style, and color for most text on the
graph.

NOTE: The plot title font will be two points larger than the selected font size.

¥  Fonts
Font Size: |9 %
Font Type: | Dialog w

Fonk Style: |Plain |

Lines

Use the lines preferences to define the appearance of lines in the plot for a specific
series type. Rules added will appear in the panel at the bottom. Only one rule can be
added per series type. To delete a rule, click the delete button on the row.

¥ Lines
‘Wwhen plotting multiple series of the same unit bype: ©
() Use the same color for each series () Use a different color for each series
{each series has a unique line style) {value-axis color will not match all series)

IUse Rules

Series Type: | Current w | Line Size: |1 | Line Style: | Dot “ | Line Color: |:| [ Choose... ] | Add Rule |
Seties Type Line Size Line Style Line Color -
Compressed Air Flow 1 Dot . Remove
Eattery 1 Dot . Remove
Current 1 Dat |:| Remaove

»

o When plotting multiple rules of the same type: Select desired option.

Use the same color for each series (default)

By default, if there are multiple series of the same unit type (for example,
temperature and dew point series in degrees Fahrenheit), plots all of the series in
the same color, and uses a different line style (solid, dashed, dotted, etc.) for each.

Use a different color for each series
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Select this option if you prefer each series to have a solid line in a different color.
The series will still be attached to a single, common axis, but only one series will
match the axis color.

e User Rules check box - Check to enable using line rules on the plots.
o Series Type - Select the series type to apply the rule to.
e Line Size/Line Style/Line Color

Select options to define the appearance of the lines in the plot. Click the Choose
button to select a color.

Line size style and color will be applied on series lines, its corresponding value
axis, and its corresponding representation in the legend. These settings can be
overridden for the series and value axis by double clicking on them to show the
properties window.

e Add Rule button - Click the Add Rule button to add the rule to the series type.

To add another rule, select a new option from the Series Type drop-down, select
options, and then click Add Rule.

Y-AXis

Use the Y-Axis Preferences to apply a minimum and maximum value for the Y-Axis to
for plots for a specific series type. Rules added will appear in the panel at the bottom.
Only one rule can be added per series type. To delete a rule, click the delete button on
the row.

Bounds are applied on Series Value Axis. These settings can be overridden on a specific
plot by double clicking on the axis and changing the Bounds values in the Y-Axis
Properties window.

¥ y-axis
sz Rules

Measurement Type: |Temperature + | Bound Min: 10 % Bound Max: 1005 Unit Type: | o0 % | AddRule

Measurement Type Baund Min Baund Max Unit Type ad
Temperature 1.0 100.0 *C Remave

e User Rules check box - Check this box to enable the rules.
o Series Type - Select the series type to apply the rule to.
e Bounds Min. and Max - Select the minimum and maximum values for the axis.

o Unit Type - Select the desired units.

Add Rule button - Click the Add Rule button to add the rule.
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Layout

Show the details pane when plotting data

HOBOware Pro: By default, the Details pane is not open when you display a plot.
If you want the Details pane to be hidden when you display a plot, clear this box.

HOBOware Lite: By default, the Details pane is not open when you display a plot.
If you want the Details pane to be shown when you display a plot, check this box.

Show the points table when plotting data

HOBOware Pro:By default, the Points table is open when you display a plot. If you
want the Points table to be hidden when you display a plot, clear this box.

HOBOware Lite: By default, the Points table is not open when you display a plot.
If you want the Points table to be shown when you display a plot, check this box.

Points Table & Details Pane

Include sensor Label (if available) in points table and details pane (HOBOware
Pro Only).

This setting adds the sensor's label, if it has a label defined, to each column
header in the Points table and to the Details pane. This is especially useful if you
have data that includes similarly-named series that were recorded on different
sensors; for example, a HOBO Micro Station datafile with data from three voltage
Sensors.

When selected value in table is out of plot range, drag series to that value.

Normally, if you are zoomed in and click a point in the Points table that is outside
the zoom area, the plot will scroll so that the marked point is in view, while
retaining your zoom factor. Clear this box if you do not want to scroll to points
outside of the current view.

Gridlines

Enable horizontal gridlines when plotting data.

By default, horizontal gridlines are not displayed when you open a plot. Enable
this option if you always want a new plot to display gridlines for all value axes.

Enable vertical gridlines when plotting data.

By default, vertical gridlines are always displayed when you open a plot. Clear
this checkbox if you never want a new plot to display gridlines for the time axis.
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Plot Setup

Automatically select all data series for plotting

By default, when you read out a logger or open a datafile, some series (such as
Dew Point) are not selected for display on the Plot Setup window. Enable this
option if you want every series to be selected.

Automatically select internal events for plotting (e.g. Button Up/Down, Host
Connected, EOF)

When you open a plot, internal events are selected by default on the Plot Setup
window. Clear this box if you usually do not want to see these events.

Other Options

Mark all points when plotting data

By default, when you display a plot, point markers are displayed for any series
with event data. Otherwise, to avoid cluttering the graph, point markers are not
displayed. Enable this option if you want all points to be marked on every series
whenever you display a plot. On a large plot, marking all points takes longer and
consumes more system memory. Series that consist of only one point are always
marked.

Label the time axis

By default, the time axis is not labeled when you display a plot. If you enable this
preference, the time axis will have a default name of "Time" when you open a
plot.

Use sensor labels (if available) in legend

If a label has been assigned to a sensor, include it in the legend.

Undo & Redo

¥  Undo & Redo
Enable Unda & Reda

Mumber of stored undoable actions: (&) 20 % | ) Enable unlimited undoable actions

Enable Undo & Redo

This controls whether you can undo and redo the changes you make to plots. By
default, this feature is enabled.
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e When the Undo & Redo preference is enabled, you can specify how many
changes to plots will be stored within HOBOware.

If you select "Number of stored undoable actions," then there will be a
limit to the number of changes to the plots that you can undo. For
example, if you choose to store 25 undoable actions, then you will be
able to undo the last 25 changes that you made to the plots, but not
the 26th. You can configure HOBOware to store from 1 to 50 undoable
actions (changes to the plot) with this setting.

If you select "Enable unlimited undoable actions," then there will be
no limit to number of changes to the plots that you can undo. Note
that storing an unlimited number of actions can impact HOBOware
performance on slower computers.
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Data Assistant Preferences

Use the Data Assistants Preferences to Show or Hide Data Assistants when you plot
data.

You access the Data Assistants Preferences by going to File > Preferences > Data
Assistants

By default, when you read out a logger or open a datafile, all compatible assistants are
listed in the Plot Setup window.

To prevent an assistant from being listed in the Plot Setup window, clear the box next
to its name. To re-enable an assistant that you have previously disabled, check the box
next to its name.

To enable all of the data assistants, click Show All. To disable all of them, click Hide All.

¥ Data Assistants

| Showal || Hideal |

Show the Following Data Assiskants when relevant data is present:

Barametric Compensation Assistant
kith Assistant

Growing Degree Days Assistant
Grains Per Pound Assistant

Linear Scaling Assistant

eEEEEG

Pulse Scaling Assistant
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Display Preferences

Use the Display Preferences to control the default units and date/time format in plots.
You access the Startup Preferences by going to File > Preferences > Display

Default Units

This setting allows you to set a default of US or SI (Metric) units throughout HOBOware
. It changes the units in the Current Readings the next time you display the Status
window, and the default units in the axis, legend, points, and details the next time you
display a plot. The default is US.

¥  Default Unit System

Unit System: (US » |2

Indicates defaulk unit system when creating new plats and checking logger skatus,

Date/Time

In this section you can configure the date and time to your desired format.

NOTE: When you create an export file, the date and time are exported as they appear in
the Points table. If you open the file in Excel, they are automatically reformatted to
Excel's default date and time format, which you may customize within Excel.

¥ Date/Time

|———————m—m=m e ————m———
®_"| Year format: 2-digit Year » | Date sample: |11/18/05 :
______________________________________________________________ :
®_..:Time fFormat: 12-Hour % Time sample: |02:32:25 PMEST I
Mate: Changing the wear or time Formats will reult in

all plots being redrawn, which can take several seconds,

Additional date and time format information is
cpecified by the operating system,

To change the default language and Formatting,
go to Regional Contral Panel settings,

1. Date
e Date format - Select the format in which you want the date to be displayed.

e Date separator - Select the character you want to be place between date
elements.

2. Year format
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Select whether you want HOBOware to display the year as two digits or four. The
default is 2-digit Year. Changing this setting will cause all open plots to be

redrawn. An example of the currently selected format is shown to the right in the
Date sample box.

Time format

Select whether you want HOBOware to display the time in a 12-hour or 24-hour
format. The default is 12-Hour. Changing this setting will cause all open plots to

be redrawn. An example of the currently selected format is shown to the right in
the Time sample box.

Use locale for all

Check this box to have all options set to the default settings for the current locale.
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Warnings Preferences

Use the Warnings Preferences to disable warning pop-ups that you do not want to
appear. Before you do so, however, keep in mind that the warnings are intended to help
prevent mistakes and inadvertent data loss. Review each warning carefully before
disabling it. To re-enable a warning, re-select the check box.

To disable all of the warnings in a group, click the Select None button for that group.
To enable all of the warnings in a group, click the Select All button for that group.

You access the Warnings Preferences by going to File > Preferences > Warnings.

General

Y General

l Select Al H Select None l

Prompt me i

There is any remaining unsaved data when closing piot or application

The project file being opened was created with a diferent version of HOBOware

Warnings Before the Launch Screen

v wWarnings Before the Launch Screen

[ Select all ][ Select Mone ]

FPrompt me if:

The logger is waiting for a delayed start
The logger is waiking For a kriggered skart
The logger is currently logging

The logger needs to be readout {(USE Devices only)
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Warning After the Launch Screen

¥  warnings After the Launch Screen

[ Select Al ][ Seleckt Mone ]

Prompt me if;

The Temperature channel is disabled but required to log Pressure

The Temperature channel is disabled but required ko log Relative Hurmidity

The specified delay time is in the past

The lagging interval specified is too small For the TRMS module

The Battery channel is disabled but recormmended when using excitation power

The logger's battery power is too low to provide excitation to external sensors

The Battery channel is enabled but will nok log data without other sensors attached
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Restoring Default Preferences

To return all preferences to their original settings for a user, in the Preferences window
click the Restore Defaults button.

[ Setup Assistank ][ Load Preferences ][ Save Preferences l[ Restore Defaults I[ Cancel ][ K, J

The following window appears.

—

A

fire you sure you want to restore all
preferences to their defaulk values?

Click Yes.

The default settings for all preference are restored.

Other Settings

In addition to the options configured in the Preferences window, HOBOware reverts to
the following settings:

Data File Folder Locations

Defines each user account's preferred folder locations for datafiles, text files, and
project files. The three folder locations are tracked separately based on the
folders you last accessed. When you restore the preference defaults, the default
folder for each file type is reset to the HOBOware folder in your My Documents
(Windows) or Finder (Mac) folder.

FlexSmart modules or Analog Sensor Ports (HOBOware Pro Only

Custom-defined channel names and units for FlexSmart modules or Analog
Sensor Ports are stored as preferences. When you restore the preference
defaults, the custom-defined channel names and units are removed from the pull-
down menus in the Configure Channel window. However, this will not affect
customized channel names and units that you saved in configuration files (.hcfg).

HOBOware software updates

The date and time of the most recent check for HOBOware software updates.
When you restore the preference defaults, HOBOware will not retain this date,
and will offer to check for updates the next time you restart HOBOware.
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Chapter 7: HOBOnode Manager &
Wireless Data Node Networks

Managing a Wireless HOBO Data
Node Network

System Overview

HOBO data nodes can be used to measure a wide variety of parameters including
temperature, humidity, voltage, current and pulses. Sensor data is transmitted by the
nodes to the HOBO data receiver)and viewed and plotted using HOBOnode Manager, a
component of HOBOware Pro. You may also need to add HOBO data routers (ZW-
ROUTER) to your network to overcome distance limitations or obstructions.

Maximum Devices Per System: 100
Maximum Data Nodes per Router (either a ZW-ROUTER or a data node routing data): 12

Routing data between data nodes allows for continuous connections and
reconfiguration around broken or blocked paths by hopping from node to node until
the destination is reached. This form of network is very reliable because it is self-
healing and can still operate when a data node breaks down or a connection goes bad
by reorganizing itself. To maximize network performance and reliability, plug all data
nodes into an AC power outlet.

| /I\ sensor - ——- data path | HOBOware/
HOBOnode Manager

__________________ R — [
= P L Nt | T —— [t

1\ PR 1\ Router ——~_
Node W/ P Router/Node Receiver /Lr
- I

o -7 ]

Node - -7 I

> T

- |

-~ I

- I

L l

P |

= - ]

M -7 !

' - |

Node - |

\ - |

\lf N L i

Nade Router/Node *, =« 7 Router/Node
| I | =
Device Type Functionality
Receiver Connects to your computer and receives data from nodes.
Router Roules data from nodes to the receiver. Used for routing only.
Router/ If a node is connected to AC power (before inserting batteries),
MNode it is a router node. It records measurements from sensors and

sends data to receiver and can also route data from other nodes.

If a node is has battery power only, it is a node. It records
measurements from sensors and sends data to receiver, but it
cannot route data from other nodes.

Node

By default, sensors take measurements once per minute. You can change this by
changing the Logging Interval.
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By default, data nodes transmit data to the receiver every 10 minutes. You change this
by editing the Connection Interval.

See Changing the Logging Interval and Connection Interval (page 339).
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Hardware Components

A HOBOnode wireless system consists of the following components:

HOBO data receiver

The HOBO data receiver forms the root of the network. Each network has one receiver
that performs the following functions:

e Forms the network,
e Stores network information,

e Collects measurement data from nodes and transmits measurement data to
HOBOnode Manager, and

e Sends configuration commands to the data nodes.

NOTE: The HOBO data receiver may be referred to simply as the "receiver” in the
documentation.

HOBO data nodes

HOBO data nodes record data using either internal or external sensors. The data is then
transmitted across the network back to the receiver. Data nodes may also double as
routers when they are powered by an AC adapter. NOTE: A HOBO data node may be
referred to as a "node" in the documentation.

HOBO data router (ZW-ROUTER)

The ZW-ROUTER routes data from nodes to the receiver or another node or router. Use
this device for routing data from other nodes only.

External sensors

Nodes do not supply power to external sensors. For external sensors that require
power and are connected directly to a node, you must supply power to the sensor.

For external sensors outputting more than 2.5 v, you must use an adapter cable: ADAP5
or ADAP10. For output other than 2.5, 5, or 10 v, you must perform some calculations
to analyze the recorded data.

Use the appropriate cable to connect the sensor to the data node and select the
corresponding cable in the Sensor Type drop-down when configuring the sensor in
HOBOnode Manager.
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HOBONnode Manager

HOBOnode Manager is a component within HOBOware that you use to configure
wireless data nodes. You access HOBOnode Manager from the Device menu in
HOBOware Pro.

Minimum Requirements

See the following page at the Onset web site for minimum requirements.

http://www.onsetcomp.com/hobo-wireless-data-nodes

Interaction with HOBOware

e HOBOnode Manager is a component of HOBOware Pro. A separate icon for
HOBOnode Manager appears in your task bar when it is running.

Bre Fre

| &1 HOBCware Pro | = | HOBCnode Manager

® You cannot access HOBOnode Manager if you have a HOBOware window open
(such as Launch or Status).

* You can close HOBOnode Manager and leave HOBOware running.
® You cannot close HOBOware and leave HOBOnode Manager running.

e You can close both HOBOware and HOBOnode Manager and keep device
communication running. A HOBOware icon appears in your system tray when
device communication is running.

Device Communication

This component controls communication between the nodes and HOBOnode Manager.
Unless you stop it, device communication continues even if you close HOBOnode

Manager or HOBOware. When you re-open HOBOware Manager, it will take some time
for the cached data to be retrieved and for the real-time plots to reflect all stored data.

When device communication is running, a HOBOware icon appears in your system tray.
Right-click (or left-click on a Mac) on the icon to access the Device Communication
menu, which shows the Receiver Status, and has options for Stopping Device
Communication and Starting HOBOnode Manager.
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In addition, an icon appears in the status bar at the bottom of the main HOBOware
window to show whether the receiver is currently connected. If the receiver is

' . Mo devi ted @ . .
connected, you'll see this ' o TS @ in the bottom right corner of the

HOBOware window. If the receiver is disconnected, you'll see this

Mo devices connected (3 . " . "
w instead. Note: The "No devices connected” message next to the

receiver icon does not refer to devices within your data node network; it indicates that
other devices, such as loggers and shuttles, are not currently connected. If you were to
connect a logger or a shuttle, that message is updated independently of the receiver
icon.

Using the Heartbeat monitor alarm, you can periodically verify that the device
communication is still running. See Enabling a Heartbeat Alarm (page 282).

NOTE: If you update your HOBOware software, you must stop device communication
to perform the installation.
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A Tour of HOBOnode Manager

This topic provides a description of the elements in HOBOnode Manager.

Tabs

T i
T Mt T e L e TTEETE ¢ v

Device 4 =
Table
: [ 1 e s M3 T l P—
Configuration FARE L L}

Bar
Help Form Network
button button

Actions Plot/Export

Drop-down Menu Data button

1. Tabs: Click the tabs to toggle between the Plots (page 240), Map (page 238), and
Alarms (page 241) pages.

2. Device Table

The Device Table shows the receiver and all nodes and sensors in your network,
and includes information such as Status, Measurement Type, and Readings. From
the Device Table you can configure the receiver and nodes, add real-time plots,
configure alarms, and add nodes to the Network Map.

3. Configuration Bar

Use the Configuration Bar to perform operations on a node or sensor, such as
applying sensor type to external sensors, apply groups to sensors, or opening the
Configure window.

4. Help button - Click the Help button to open the on-line Help. Click the Open topic
with navigation link to open the full Help table of contents.

5. Actions Drop-down Menu
Includes the following actions you can perform on your network:

e Print Device Table - Select the option to print the Device Table.
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o Edit HOBO Data Node Preferences - Select to open the preferences for data
nodes.

6. Plot/Export Data button - Click the Plot/Export Data button to open the
Plot/Export Wireless Data window (page 317).

7. Form Network button

Click the Form Network button to add nodes to your network. See Adding Nodes
to your Network (page 265).
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Monitoring your Network

Use the Device Table to monitor the status of the devices in your network. You can also
monitor your network using the Network Map (page 238).

Slgnal
Device Sensor Last Alarm Battery
Status Readings Connection Status Leuel
Seloct  Label Trpe SN Stobus Meas, Type | Feadng Pt Tieres Group(s) M-w Alum &u:ew
O Recerver @ZW-P.C‘\’R 2372373 CONMECTED - s = 2
[0 Bayl & w013 —2434008— ACTIVE - - - - E] - |I|| i ‘
O Bay | Temp —& FW-INT-TMPL 2431992-1 ACTIVE Tempersture  TLIEIF  [F] 2 minutes ag - — -
O Bay | RH ——& TW-INT-RH1 2431992-2 ACTIVE RH 3%.560%  [F]  2eminutes age = — 8 -
0 ; - frvalog 24319923 ACTIVE . x . .
'_] —a A /] 24319924 ALCTIVE - - -
al @ ow007 24 MISSING - . - - . = all —
O ——8 CARLE-UZ3-002Z (Temg) 2431976-1 MISSING  Temperatwre 69.256°F [ 2bouk 2 hours age - -
0O 8 CABLEUZS-002 (RH) | 2499762 MISSING  RH 4.059% [F]  sbouk 2hours ago
O - fnalog Sensods 249763 MISSING ble - bis
:| - 243974 MISSING
Node ACTIVE — Alarm Tripped ——
Node MISSING Alarm Enabled —

1. Device Status - This column indicates the status of the device: ACTIVE, or

MISSING.

2. Sensor Readings - This column shows the current reading for the sensor.

3. Last Connection - The last time the data node connected to the receiver.

4. Alarm Status - The alarm icon in this column indicates the status of the alarm.

Grey - No alarm configured
Green - Alarm enabled

Red - Alarm Tripped

5. Signal Strength

This column indicates the signal strength of the wireless connection between the
node and the receiver or the nearest router.

6. Battery Level - Indicates the strength of the batteries in the device.

For information on other columns in the Device Table, see The Device Table (page

352).
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Sorting Devices

You can change the order of devices in the table by clicking the column header for the
column you want to sort on. For example, to group all temperature sensors together,
click on the Meas. Type column header.

Click here to sort the Device Table
by Measurement Type

Calack Labed Type S b Meas, Type & [Peadng
O Bary 1 RH & TW-INT-RIHI MANTE2 ACTIVE BH A1
O By 1 Int. Temg —&=d IW-INT-THP1 2431992-1 ACTIVE |r Temperabure | .20
O Exy 1 Ext Temp = TMO Y HMAN3 ACTIVE | Temgeratune _! E6.173°F
0 Unissed = <Select Analog Sans 24319924 OFF sl st
£l Rashoas @ IW-ROVR 2372373 CONNECTED

0O By 1 & TW-013 2992 BCTIVE

To restore the original (default) sort order, right-click anywhere in the Device Table
and select Restore Sort Order.

Printing the Device Table

To print the Device Table, click the Actions button at the bottom of the HOBOnode
Manager window and select Print Device Table.

You can also print the Device Table by right-clicking anywhere in the Device Table and
selecting Print Device Table.

Device Communication

If Device Communication is running, the Device Communication icon will appear in
your system tray and the Receiver status will be Connected. You can also monitor
Device Communication using a Heartbeat Alarm (page 282).

! Receiver Connected | Receiver Status

Slop Device Communication
Start HOBOnode Manager

-—

-+— [Device Communication lcon
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The Network Map

Place icons on the Network Map to help you keep track of your devices. You can expand
Information Balloons on the device to view status information and sensor readings.
You can import a custom background image, such as a floor plan.

Information Imported

Balloon

o WH 22N
e Uk s
A Uk e
it Dowvicn Irbowmmabio,
r g— node
f 1 .
Offica % receiver
Room 4 Room 5
Selet kel Troe SN S Mot Troe  Feadng Pt Tt Gropds)  Map . Sl Bty |
[0  Fuscse @.— v 7323 WAECTED - a . : = s : [ ]
O el T 43 I . - - - = - all B d
Py | Towg - TW-INT-THR | Tempersburs 74,063°F [ 1 mirwie 0 . = -
C By BH = T BT-R =] T T L A e B R
i : L430FEE4 STHE
el Ty 431 = o i
@ Connection Path Add Device to Map
1. Map Tab

To view the Network Map, click the Map tab.
2. Information Balloons

Click on a device in the Network Map to open a pop-up that shows current
readings and other device information. To have pop-ups appear automatically,
click the Configure Map icon and select Show Information Balloon when adding
new data nodes and on startup. You can also how much information is included in
the balloon. See Configuring the Network Map (page 310) for more information.

3. Imported Map Image

To customize your map background image, see Customizing the Network Map
Background (page 313).

4. Add Device to Map
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To add a device to the map, check the Map box in the Device Table and then click
in the map where you want to place the icon.

5. Connection Path

Lines on the map show the path each device takes to the receiver.

You can monitor the communication between a data node and the data receiver
by checking the connection paths between devices. If a device has missed a
scheduled connection, the path will become a dotted line.

To change the path color, see Configuring the Network Map (page 310).
6. Tools
eZoom
Use the zoom tools to zoom in and out of the map.
¢ Configure Map

Click the Configure Map button to open the Configure Map window. See
Configuring the Network Map (page 310).

e Refresh Network Paths

The path that a device takes to the data receiver may change due to a node
being moved or because the original path was obstructed. To see the latest
paths, click the Refresh Network Paths button.

Alarms

If an alarm has tripped on a node, the node on the network map will have a red ring
around it.

-239-



HOBOware User’s Guide

Real-Time Plots

In the plots window you can view sensor data in real-time plots.

Select the appropriate tab to view Use time tabs to view
by Sensor or by Measurement different time frames
Moty | Map | Marms
i) P L) o1t e T %Y REREEEE
B Pemg -
Plat appears for il —— ——— -
R 5 T S——, ——
selacted sensors. £l L
wmm s wme  wes wwes wew  mmw oo
BTN B4 0808 M EST SEWIE A DO08 A EST
[
£ o RIS
o i frim CEETEL T Gveld M s g e [
[a] [— e FOICI  COMMECTED . . . . [u] = e [
O el g Teoar 2008 ACTHE . g g (] o | ¥ S
[ By i T DAL (gl R ACTME Temparature 857 [ i -
B mieor  —mree " s s eomare s maonsmon B g Check the Plot box lo
9 o :;:.w,gwo.,::x‘ P s 5 - = " - add a sensor to the plot.
O beiTes i PNT- B TOVARD ACTRE  Tempeahae  TRART  DGCWMO ORI30AM [ [
0 beies - T AT ACTRE P HUARW OREu ok [ -
O insed e et b s> [IVHED (PP Tk Uk Ul - '
O tessd ol T b s S (AT Fomuiahe  Uriesiah Lo - [ -
[ TwaLLoE WA AR - - . . . o oM
(ST DT DRGNS ACIDE Tespeatire TIT_ G0 CROT0M_[] - " - 2
| M Ewe Swn Trpe ¥ Groes ¥ | oot | v |[nmers ¥ | [ o | [ et | |55 e |
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Alarms

Alarm Types

There are two categories of alarms in HOBOnode Manager:
e Sensor Alarms

You can configure alarms to be notified if a sensor reading is out of a configured
range. See Adding a Sensor Alarm (page 277).

e System Alarms
Missing Node (page 280) - You can configure an alarm to notify you if a node has
not connected to the receiver within a specified length of time.

Heartbeat (page 282) - You can configure HOBOnode Manager to periodically
notify you that the receiver is active and communicating with nodes.

Low Battery - You can set up an alarm to trip when battery gets low in a node or
router.

Alarm Notification

You can set up Alarm Actions to be notified of alarm conditions by email, text message,
or by an audio or visual alarm in HOBOnode Manager. Before you can set up alarms
with Email or Text notifications, you must set your Alarm Preferences (page 275).

Sensor data is sent to the receiver periodically (based on the Connection Interval) and
not continuously. Therefore, there is a delay between the time the alarm condition
occurs and is recorded by the sensor and when you are alerted by any notifications you
have configured. The default Connection Interval is 10 minutes. For critical
applications, you may want to decrease the Connection Interval so that you are alerted
to alarm conditions more frequently.

See Changing the Logging Interval and Connection Interval (page 339).

Monitoring Alarms

Once you have configured alarms, go to the Alarms window and click the Sensor pane
to view tripped alarms.

Use Alarm Actions to receive visual, audible, or email/text notification when an alarm
trips. See Adding a Sensor Alarm (page 277).
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Alarm Status also indicated by
icons in Device Table

NOTE: If an alarm you configured is not appearing in the Alarms window, make sure

the filter is set to Show all.
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Deployment: Before You Begin

Before you begin the setup procedure, Onset suggests you do the following to help
make your deployment easier.

Perform a Site Survey (page 244) to determine your equipment needs and
locations.

Review Deployment Guidelines (page 246).

Put the enclosed sticker on the front of your data nodes and write down a
descriptive label to help you identify the data node. You will enter the label in the
software as well.

Complete the Deployment Information Table to help you keep track of your data
nodes.

Create a Custom Network Map Image

You can upload a custom image, such as a floor plan, to use in the Network Map.
If you don’t already have an image, you can create one using a drawing program.
You should upload your image before you add data nodes to your network so
that you can place them on the map as you go.

See Uploading a Custom Network Map (page 313) for information on creating
and uploading a custom image.
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Site Survey

One of the first objectives in setting up a wireless network is to analyze your site to
determine your equipment requirements and physical setup. This involves answering
specific questions related to your particular application. Doing this prior to physical
setup will save time and ensure the most efficient, productive, and cost-effective
system possible.

What do you want to measure?

Make a list of specific parameters to be measured (i.e., temperature, humidity,
voltage, current, pulses). If possible, determine desired measurement
frequencies for each.

Where will you make your measurements?

Determine the physical location for each of the measurements by making a
facility map. Include the physical distances between measurement locations.
Include obstructions between measurement locations that may interfere with
radio communication, such as metal walls, water pipes/tanks, or appliances.

Does the location provide accurate representation?

Ensure that the locations chosen provide the most accurate representation for
measurements. If, for example, you want to measure temperature for an air flow
study, the most appropriate location for the measurement would be in close
proximity to the airflow. You wouldn’t want to make the measurement in a
location where airflow doesn’t exist or where dead spots occur, such as in the
corners of a building.

Do you need a concealed, inconspicuous location?

Onset has made every effort to design the network devices to be small,
inconspicuous and tamperproof. If further security or concealment is required,
the devices can be located in inconspicuous or hard-to-reach locations.

How often will measurements be made?

Determine frequency requirements for each measurement. Some may need to be
made more often than others.

Is power available at measurement location?

Determine power availability (120VAC) for each of the measurements. This is
important if you want a node to have routing capabilities as only a node with
external power can act as a router.
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Determining Equipment Requirements

With your site survey complete, you can make a list of equipment you need. As a
general rule it's best to start at the measurement sites (data nodes) and work back to
the receiver. Most data nodes offer multiple channels, giving flexible measuring
capabilities while using minimal equipment.

Using the facility map, place nodes in each of the measurement locations and note if it
will be plugged into an outlet (which gives it routing capabilities) or if it will have to
run on battery power alone (not recommended).
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Deployment Guidelines

Follow these guidelines when deploying nodes.

Maximum communication distance

This system has been designed to communicate over distances up to
approximately 150 -300 feet. This is assuming there are no obstructions or
interference and a direct line-of-sight between the communicating devices.
Obstructions to radio communications can be overcome by strategically placing a
router to relay traffic around the obstruction.

The following table gives some general guidelines on the degree to which certain
materials will obstruct your signal.

i

Degree of

Materials Attenuation * Examples
Air None Open space, inner courtyard
Wood Low Door, floor, partition
Plastic Low Partition
Glass Low Un-tinted windows
Tinted glass Medium Tinted windows
Water Medium Aquarium, fountain
Living
creatures Medium Crowds, animals, people, plants
Bricks Medium walls
Plaster Medium Partitions
Ceramic High Tiles
Paper High Rolls of paper
Concrete High Load-bearing walls, floors, pillars
Bulletproof
glass High Bulletproof windows
Metal Very high Reinforced concrete, mirrors, metal cabinet, elevator cage

* Attenuation is the gradual loss of signal intensity when passing through a medium.

Network Self Healing and Restoration

The self-healing, restorative nature of a mesh network allows it to recover if a
node becomes inoperable. If data nodes are routing data through a lost node,
they will automatically search for a new node to act as a router to the receiver.

Ensure that if any one of the data nodes in your network become inoperable,
there is another data node within range to take over routing for that node.
Rearrange the data nodes or add new ones if required.

Deploying Temperature Sensors

Follow these guidelines when deploying Temperature sensors:
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Mount the sensor so that at least 10 cm (4 inches) of the sensor cable is placed in
the medium that is being measured. The temperature sensor is approximately
0.32 cm (1/8 inch) from the end of the stainless steel tip.

When mounting the probe, care should be taken to thermally isolate the sensor
from the mounting surface to ensure accurate air temperature readings.
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Device Types

The following table shows the different device types and how they appear in
HOBOnode Manager.

Device Type/lcon in
HOBOnode Manager

Primary Power Source

Functionality

Recaiver

¥

bTd ACPowerOutlet

Receives data from nodes and sends to HOBOnode Manager

Router
(ZW-ROUTER)

bT0d Ac Power Outlet

Routes data from nodes to the receiver or another node or router.

Although the ZW-ROUTER has a temperature sensor, you should

not rely on this sensor for accurate readings. Use this node for
routing only.

Router/Node

@

AC Power Outlet

Records measurements from sensors and sends data to receiver.
Can route data from other nodes.

IMPORTANT
Plug into AC power before installing batteries.

Node

E 3 AAA Batteries

Records measurements from sensors and sends data to receiver.
Cannot route data from other nodes.
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Basic Deployment

The diagram below shows an example of a basic setup where all data nodes are
plugged into an AC power outlet (recommended) and there are no obstructions. Data
from some nodes may pass through other data nodes to reach the receiver.

pfd Lld 8 |

Campuna
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Overcoming Obstructions

The diagram below shows a scenario where there are some obstructions between some
nodes and the receiver. Data node A is placed in a position so that it can connect to the
receiver (through data node D), and also route data from data nodes B and C, which are
obstructed from connecting directly to the receiver.

Metal
Door
m -
® @ =
E : IEIevatar wi
Shaft

L]
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Overcoming Distance Limitations

The following diagram shows a scenario where data nodes A and B cannot connect to
the receiver due to distance.

- Campuser

The following diagram shows a ZW-ROUTER (C) added to route data from data nodes A
and B to the receiver. When you add a ROUTER, position it to maximize the number of
nodes it can connect to. Add additional ROUTER(s) if needed.

= ® y =
N Router camor

%6
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Automatic Re-routing

If a node loses its signal, a node routing though it will automatically search for a new
route to receiver.

In the example below, data node A was routing data through data node B. When data
node B loses communication with the receiver, data node A automatically searches for
a new path and routes data through data node C.

P im______x___@)?

=3

Computer [ I_\._

i
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Backing up a Critical Node

In the diagram below, node D is in a critical path between 3 other nodes and the
receiver. If node D goes down, nodes A, B, and C will have no connection to the receiver.

03] o5 x-e=
7
X

/
/

o e
@S Shatt

©

The following diagram shows how you can add a router or router/node to a critical
spot in the network to overcome the loss of a data node. If data node D goes down, data
node E will continue to route data from data nodes A, B, and C.

Although you want to mount the backup router/node in the same general area as the
primary node so that you can connect to all of the remote nodes, you don’t want to put
it in the exact same spot as the primary node in case the cause of the lost connection is
a signal obstruction that would affect both nodes.

Router added for
redundancy

Og| oy l L =

Computer

i |7 |
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Deployment Information Table

Before you begin configuring and deploying your nodes, record the serial number and
location of all of your devices. Assign a unique label to each device to help you
distinguish them from each other in HOBOnode Manager. When you configure each
device you will enter this label.

Device Type Label Serial Number Location
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Basic Network Setup: Summary of
Tasks

This procedure is intended to help you get a receiver and one data node up and running
so you can get familiar with the hardware and software. Once you are familiar with the
basic setup tasks, you can go back and add additional nodes and perform advanced
configuration if required.

IMPORTANT: Do not install batteries until instructed to do so.
Task 1: Install HOBOware and Start HOBOnode Manager (page 256)
Task 2: Supply Power to Receiver (page 257)

Task 3: Supply Power to Data Node (page 258)

Task 4: Connect the Receiver to your Computer (page 259)

Task 5: Add Node to the Network (page 260)

Task 6: Select External Sensor Type (Optional) (page 262)

Task 7: Verify Proper Operation (page 264)

Task 8: Add More Data Nodes to the Network (page 265)

Task 9: Configure Advanced Features (page 266)
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Task 1: Install HOBOware and Run
HOBONnode Manager

If you have not already done so, install HOBOware.
A. Insert the HOBOware Installation CD into your computer's CD drive.
B. Follow the prompts to install HOBOware.

HOBOware should open automatically when installation is complete.

C. From the HOBOware main menu, select Devices > Manage HOBO Data Node
Network.

D. A message may appear asking if you wish to add permanent support for HOBO
data nodes. Click Yes to continue.

Next Task: Supply Power to the Receiver
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Task 2: Supply Power to the
Receiver

Use the supplied power adapter to connect the receiver to a wall outlet.

A. Insert the connector into the Pwr jack on the receiver.
B. Insert the power plug into a wall outlet.

C. Insert 3 AAA batteries into the receiver for backup power. See Installing
Batteries.

A. Place the receiver into the stand provided.

Next Task: Supply Power to the Node
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Task 3: Supply Power to Data Node

Onset strongly recommends that you deploy data nodes where they can be plugged
into a wall outlet, which allows them to route data from other data nodes. This
optimizes your network reliability.

What to look for: To verify that you have powered the node correctly, watch the LEDs
when you connect power. Both the RED and GREEN LEDs flash for 5 seconds, then the
RED LED blinks for 5 seconds, then both LEDs blink once, and then both LEDs go OFF.
This confirms that the data node is powered using a wall outlet and can route data.

Use the supplied power cord to connect the data node to a wall outlet.

A. Insert the power cord connector into the Pwr jack on the data node.
B. Insert the power plug into a wall outlet.

C. Insert 3 AAA batteries for backup power. See Installing Batteries.

Next Task: Connect the Receiver to your Computer
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Task 4: Connect the Receiver to
your Computer

IMPORTANT: Make sure you do not plug the receiver into a USB port that may be shut
down due to your computer’s power settings. Onset recommends that you do not
enable Power Saving options such as Turn off Hard Disks, Hibernation, or Shut Down
on your computer. If you connect the receiver to a USB port on your monitor, do not
enable the Energy Saver option on your monitor.

A. Connect the small end of the USB cable to the comm port on the receiver.
B. Plug the large end of the USB cable into a USB port on your computer.

The receiver will appear in the Device Table at the bottom of the HOBOnode Manager

window.
Seleck Label Twp= = Skabue Mes. Typ= Resdig
O Enice lobend bz s ;;. ZWATYR 23r2ama CONMECTED

|er Al |G Mors: Sansor Typa W Groups W & | Configura

Troubleshooting: If the receiver does not appear in the Device Table, make sure that
the cable is completely plugged in at both ends. Try unplugging the receiver and
plugging it back in.

A message appears indicating that a receiver has been detected and asking if you'd like
to form a network now.

C. Click the Form network now button to put the receiver in Form Network mode,
allowing you to add nodes to the network. You can also click Not yet, and click
the Form Network button when you are ready to proceed

LED Indication: When the receiver is in Form Network mode, the RED and
GREEN LEDs will alternate blinking slowly.

Next Task: Add Node to the Network
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Task 5: Add Data Node to the
Network

Before you Begin: Make sure the receiver is in Form Network mode (RED and GREEN
LEDs flashing continuously and Forming Network progress indicator appears on
screen). If not, click the Form Network button at the bottom of the HOBOnode Manager
window.

A. Ifthere are any external sensors that will be used with this node, connect them
now.

B. To activate a data node and add it to the network, use a wire paper clip to briefly
press the button located inside the small hole at the bottom of the case.

LED Indication: While the data node is searching for a receiver, the RED and GREEN
LEDs will alternate blinking.

The data node will appear in the Device Table at the bottom of the HOBOnode Manager

) :

Select Type SM Meas, Type Readng Fiot Time:

0 e ZW-RCYR 2372373 CONNECTED - - -

O & ZW-013 2431992 | actve | . -

O =@ ZW-INT-TMP1 24319921 | AcTive | Temperature 73,342 °F [0 o2fisiood:...
O —& 7W-INT-RH1 24319%2-2 L J'-\_CE\“E_ I RH 22,178 % El 021510 03:...
O elect Analog Sensor 2439923 | OFF 1 Unavailable Unavailable - Unavalable

O cSelect Anslog Sensor> 24319924 | OFF Jl Unavaiable Unayailable = Unavadable

C. Exit Form Network Mode

Once the node appears in the Device Table at the bottom of the HOBOnode
Manager window, you can exit Form Network mode. Click the X on the Form
Network Progress Indicator to exit Form Network mode.
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)

Forming network... push button on nodes to join, click X when done

D. View Data Node Popup Balloon

When you first add a data node to the network, a popup balloon appears
providing some configuration information about the node.

1. To dismiss the popup balloon, click the red X in the top right corner.

2. To disable future popups, check the Don’t show popups for new devices box.

My acdchad niods s sensors whose bype mast be selected
befiore data vill ke loggesd for therse serdans. Do one of —
e ol 1o select saremcr bype;

= ook e ey Howr bhast e
+ Alernativaly, check oo onleft and dick "Sareor Type™ button

Slect Labed :"'W ] D sbuzr pcagnced Fow oo it
Fl i RO
7 @ W05 BESESHS
T &5 CRBLE-TEMPRM (Tamp) 96585551
&= CABLE-TEMPIRH (RH) o
— RS EFF
a ) UEEESHEA OFF

Note: If you have a ZW-005 or a ZW-007 and only have an External Temp/RH sensor
installed, you do not need to select a sensor type.

E.

View Device Table

The node (1) will appear in the Device Table at the bottom of the HOBOnode
Manager window, with additional rows for each internal sensor (2) and external
sensor or sensor port (3).

The Status column for nodes and internal sensors (4) will indicate ACTIVE.

The Status column for configurable external sensors (5) will indicate OFF, and
the Type column will be grayed out, until you select a Sensor Type in Task 6. This
does not apply to the external Temp/RH sensor, which is automatically
recognized by HOBOnode Manager.

7

S

| Type 5 5 Meas, Type Reading Plat Tirne
O Enterighel heh (@ ZW-ROVR 2372373 CONNECTED -
O Enter labie IW-013 2431902 : ACTIVE | . - .
O abel b & ZW-INT-TMPL 2431902-1 | ACTIvE | Temperature 73,342 °F [0 0215003
O &8 ZW-INT-RHL 24319922 | ACTIVE | RH 22.178% [ ozispoos:..
O 7= 24319923 | OFF ) ’ . navalat
0 | 24319924 l

OFF |

Next Task: Select External Sensor Type (if applicable)
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Task 6: Select External Sensor Type

IMPORTANT: Refer to the documentation that came with your sensor for connection
information.

You must assign a sensor type for any external sensors you have connected to the node
(except for the External Temp/RH sensor).

External Sensor Ports

2.5mm Stereo Ports
for configurable external sensors

External Temp/RH Sensor Port

External Temp/RH sensor

The ZW-005 and the ZW-007 support the External Temp/RH sensor (Part #: CABLE-
TEMP/RH), which plugs into the External Temp/RH Sensor Port (#1 in the photo
above). This sensor is preconfigured and you do not have to select a sensor type.

Separate rows appear under the node for the Temperature and RH channels with
corresponding entries in the Type column.

Select Label Type SN Status Meas, Type
D <Enter label ... @ ZW-ROCYVR 2372373 COMMECTED
External 0 <Enter label ... §Qj ZW-007 2431976  ACTIVE
Temp‘i’RH dl <Enter label I_——l CABLE-TEMPfRH (Temp) 2431976-1 ACTIVE Temperakure
Sensor ' <Enter label |. ——@8 CABLE-TEMPJRH (RH) 2431976-2  ACTIVE RH
O <Enter lshel ... =/~ <Select Anslog Sensor>  2431976-3  OFF Inavailable
Fl <Enter label ... =@ <Select Analog Sensor>  2431976-4  OFF Unavailable

Configurable External Sensors

Some data nodes support up to four configurable external sensors, which plug into one
of the 2.5mm Stereo Ports (#2 in the photo above). You must select a Sensor Type in
HOBOnode Manager for these sensors.

When the data node appears in the Device Table, configurable external sensors will not
have an entry in the Type column.
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Select | Label Type SiN Status Meas, Type
El ) 2w-RCVR 2372373 COMNECTED
0 & ZW-006 2424011 ACTIVE
External Sensor | |—,,_, select Analog Sensor>  2424011-1  OFF
Ports — - slect Analog Sensor> 2424011-2  OFF
. rees . -
{if supported by node) . 2424011-3 OFF
a 24240114 OFF

Steps
Follow these steps to select a Sensor Type for configurable external sensors.
A. Double-click the row for the sensor in the Device Table.
B. Select the Sensor Type from the drop-down list.
C. Add alabel for the sensor (optional).
D. Click OK.

Once you select a sensor type, the Status will change to ACTIVE and the appropriate
measurement type will appear in the Measurement Type column.

Next Task: Verify Proper Operation
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Task 7: Verify Proper Operation

View Readings

You should see values in the Reading column for internal sensors within a few minutes
after the node is added to the network. External sensor readings may take up to 10

minutes after you select a Sensor Type.

Sadect Labad Type M Status Mass. Type Headng
] he. . g TWRCWR Ferrare) COMMECTED :

1 @ waua 3Lz ACTIVE .

'H & TR INTTHRL I ACTIVE Tampershes TIH2
C i W INT-RHY HIWSZ  ACTIE FH 21TE%
= - 3 24319923 OFF

O vl chalart Ao ' MYE4  OFF

Plot Tima

'm 21500 0.
0 oefisioos..

Troubleshooting: If you do not see readings for an external sensor, make sure it is
securely plugged into the data node and that you have selected a sensor type.

View Real-Time Data

1. Check the box in the Plot column for the sensor in the Device Table.

2. Verify that the plot appears. It may take up to 10 minutes after you add the data
node to the network for data to begin appearing in the plot.

T I de Manager
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O Rposer § oweow T CONECTED - E -
O By @ Twagr HPEN & - - - -
O Bary | Tewp 8 CABLE-TEMPRH(Tomg)  24MSTEL & Temperstre  TOZHF  ECEHIODIOIOORM
0 By 1 BH — CABLE-TERMEH (BH)  DMRED A EH ¥an  wpEshoooem [
O Byl Temp 2 —i THOH ] ACTTE Temperstore  TIPIOF GEEHI00L0300RM [
O irused — 1 A N OFF ¥
O By @ ovan MMWE ACTE -
o 8 _n S L E T Babadich s bEBRE K. - e et _

WAl fGere | dewaTipe ¥ Goap ¥ §) Cofoue [ me _| P J| G

Next Task: Add More Data Nodes to the Network
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Task 8: Add More Data Nodes to the
Network

Now that you are familiar with the procedure for adding a data node to the network,
you can add the rest of your data nodes.

A. Supply Power to Data Nodes (Task 3).

IMPORTANT: Make sure you are familiar with the power options, and the
implications of using one or the other. See Powering Data Nodes.

B. Click the Form Network button at the bottom of the HOBOnode Manager
window.

C. When all data nodes are added to the network and they appear in the Device
Table, exit Form Network mode by clicking the X on the Form Network progress
indicator.

Next Task: Configure Advanced Features (Optional)
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Task 9: Configure Advanced
Features (Optional)

This section outlines a variety of features to help you set up and monitor your network,
and to plot data to view in HOBOware or another application. You can configure these
features now or at a later time.

For details on a specific feature, click the Help button located on the window related to
the feature (if applicable), or open the entire Help by clicking the Help button at the
bottom of the HOBOnode Manager window.

Add Labels

You can enter a descriptive label for each node and sensor to help you identify them in
the Device Table when configuring alarms and when plotting/exporting data.

To label a device, double-click the Label column where it says <Enter label here> and
type in the label.

Selact Labead Typs S
E @ w-aowR bexc pee |

|_| En i |n Il &5 ZW-013 2431992
':l Ent = IW-INT-THP JFIFHE-1

Configure Alarms

There are two types of HOBOnode alarms:
e Sensor Alarms

A sensor alarm trips when a sensor goes out of a range that you configure. You
can set up to be notified by email, text message, or by an audio or visual alarm in
HOBOnode Manager.

e System Alarms

Missing Node (page 280) - The Missing Node alarm notifies you if a data node has
not connected to the receiver within a specified period of time.

Heartbeat (page 282) - The Heartbeat alarm periodically notifies you that the
receiver is active and communicating with data nodes.

Low Battery - This alarm trips when the batteries are low in nodes or routers.

To configure a Sensor Alarm in HOBOnode Manager, click the button in the Alarm
column in the Device Table. This opens the Add Sensor Alarm window. Enter alarm
values as desired. To quickly get familiar with alarms, select either a Visual or Audible
notification Action. Before you can set up alarms with Email or Text notifications, you
must set your Alarm Preferences.
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For More Information: See Adding a Sensor Alarm.

To enable a System Alarm (Missing Node, Heartbeat, or Low Battery), click the Alarms
tab at the top of the HOBOnode Manager window, click the System tab, and then click
the Enable button for the desired alarm. To quickly get familiar with alarms, select
either a Visual or Audible notification Action. Before you can set up alarms with Email
or Text notifications, you must set your Alarm Preferences.

For More Information: See Enabling a Heartbeat Alarm and Enabling a Missing Node
Alarm.

Email or Text Message Notifications

Before you can set up alarms with Email or Text Message notifications, you must set
your Alarm Preferences. At the bottom of the HOBOnode Manager window click the
Actions button and then select Edit HOBOnode Preferences.

For More Information: See Setting Alarm Preferences.

Set up Network Map

Place icons on the Network Map to help you keep track of your devices. You can expand
Information Balloons on the device to view status information and sensor readings.
You can import a custom background image, such as a floor plan.

Modify Logging and Connection Intervals

By default, data nodes record data from sensors once per minute (logging interval), and
connect to the receiver every 10 minutes (connection interval). To change the logging
interval and connection interval for a data node, double-click the row for the data node
in the Device Table and change the values in the Configure Node window.

The minimum logging interval is 1 minute. The minimum connection interval is 2
minutes and must be at least twice the logging interval. Changes to the logging interval
and connection interval will take effect the next time the data node connects to
receiver.

See Changing Logging and Connection Intervals for additional details.

NOTE: Alarm notifications are sent to HOBOnode Manager when the node connects to
the receiver. When configuring your Connection Interval, consider that less frequent
connections will result in more delay in receiving alarm notifications.

Configure External Sensor Type/Scaling (Optional)

Assign a Sensor Type to external sensors. Double-click the sensor row and select the
sensor type from the Sensor Type drop-down list.

To configure scaling for third-party sensors, click the Configure button in the Scaling
section and enter values in the Configure Scaling window. Click the View Scaling
Factors button on the Configure Scaling window for details.
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A scaling icon appears in the Sensor Type drop-down list next to sensors that support
scaling.

Sensor Type: |« CTV=C, 0 - 100 Amp split-core AC current sensor i
o CTW-C, 0 - 100 Amp split-core AC current sensor
CTV¥-D, 0 - 200 amp split-core AC current sensor
CTW-E, 0 - 600 Amp split-care AC current sensor
Scaling lcon ——— = (| CABLE-4-Z0ma, 4-20 ma cable
L CABLE-ADAPS, Voltage Divider Cable
ogging Interval: || s F_aADAPIG, Yoltage Divider Cable
L CABLE-2.5-5TERED, Yoltage Input Cable
T-CON-ACT-150, ConLab 0-150 Yalt AC Transmitter v

Label:

section Interval:

Plot/Export Data

To plot data for viewing in HOBOware Pro, or to export data to a text file for use with a
third-party application, click the Plot/Export Data button at the bottom of the
HOBOnode Manager window to open the Plot/Export Wireless Data window.

[ | Help ][h.ctms v I| Lo~ Phot{Expart Data |[ L Form Network H i Close

For More Information: See Plotting or Exporting Data window.

Use Groups to Sort Sensors

You can assign sensors to groups in the Device Table and then use the groups to sort
rows in the table, to refine a list of sensors in the Plot/Export Wireless Data window, or
to copy sensor alarms.

See Using Groups to Sort Sensors (page 321) for more information.

Modify HOBOnode Manager Preferences

Use the HOBOnode Manager Preferences to change the default behavior of HOBOnode
Manager. To go to the HOBO Data Nodes Preferences window, click Actions at the
bottom of the HOBOnode Manager window and select Edit HOBOnode Preferences. For
details see HOBOnode Manager General Preferences (page 349).

- 268 -



HOBOware User’s Guide

Powering Data Nodes

Onset strongly recommends that you deploy data nodes where they can be plugged
into an AC power source. This allows them to route data from other nodes, providing
your network maximum routing capabilities, which improves the reliability and
redundancy of your system. Using AC power also greatly reduces the frequency with
which batteries will have to be replaced.

IMPORTANT: How a data node is initially powered determines if it will be able to
route data from other nodes. If you plug the data node into a wall outlet first, it will be
able to route data. If you install batteries before you plug the data node into the wall, it
will not be able to route data.

Data Nodes Plugged into Wall Outlet

IMPORTANT: If a data node will have access to a wall outlet when deployed, do not
insert batteries until you have plugged the HOBO data node into a wall outlet. If you
install batteries before you plug it into the wall, it will not have routing capabilities.

If a data node will be plugged into a wall outlet when deployed:

1. Insertthe power cord connector into the Pwr jack on the receiver.

2. Insert the power plug into an AC wall outlet.

LED Indication: Both the RED and GREEN LEDs flash for 5 seconds, then the
RED LED blinks for 5 seconds, then both LEDs blink once, and then both LEDs go
OFF. This confirms that the data node is powered using a wall outlet and can
route data.

3. After you have plugged the data node into the wall outlet, insert 3 AAA batteries
for backup power.

If you are configuring data nodes at your desk, you can plug them into a wall outlet one
at a time, add them to the network, and then unplug them until you move them to their
deployment location.

Once you have added a data node to the network and performed setup, you can unplug
it and use the AC Power outlets for other nodes. Data nodes will run on battery power
until you are ready to deploy them.

IMPORTANT: If you initially configure a data node with AC Power connected, but at
some point it no longer has access to AC power, you must remove the node from the
network and then re-join with only batteries installed. See Switching from AC Power to
Battery Power (page 337).
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Nodes without Access to AC Power

IMPORTANT: If a data node will not have access to a wall outlet when deployed, do not
plug it into a wall outlet before installing batteries.

IMPORTANT: Data nodes that are not initially connected to a wall outlet will not have
routing capabilities.

1. Insert 3 AAA batteries.

LED Indications: Both GREEN and RED LEDs will flash for 5 seconds, then the
RED LED will flash for 5 seconds, and then both LEDs will be OFF.

IMPORTANT: If you initially configure a node with only batteries as a power source,
but at a later point it has access to AC power, you must remove the node from the
network and then re-join it. See Switching from Battery Power to AC Power (page 338).

Verify Power Source in HOBOnode Manager

When you add a data node to the network and it appears in the Device Table in
HOBOnode Manager, verify that the icon in the Type column indicates the correct node
type: router/node, or node.

& Router/Node Node can route data from other nodes.

IMPORTANT: If a node appears as a
router/node but is not plugged into a wall
outlet when deployed, the batteries will be
drained very quickly. See Switching from
AC Power to Battery Power in the
HOBOware Help for information.

) Node Node cannot route data from other nodes.

IMPORTANT: If this node is actually
plugged into wall outlet and intendadto be
a router/node, you may have installed
batteries before plugaing it into the wall.
See Switching from Battery Power to AC
Power in the HOBOware Help for
information.

-270 -



HOBOware User’s Guide

Deploying Nodes

Once you have activated all nodes and they appear in the Device Table, you can deploy
them to their locations. Make sure you have completed the Deployment Information
Table (page 254) to help you identify them later.

The range of a node is approximately 150 ft. to 300 ft., depending on the number of and
type of obstructions. Use trial and error to place nodes where you need them, and move
closer to the receiver if you cannot establish a connection. Use other nodes or routers
to establish a connection.

NOTE: For a node to act as a router, it must be powered through an electrical outlet.
See the Deployment Guide section for more information.

For wall mounting, remove the back cover from the node and mount it to the wall using
a screw or nail through the mounting holes, then attach the node to the cover.
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Viewing Wireless Data on your
Local Area Network

You can view plots and data from your HOBO data node network on your local area
network with HOBOnode Viewer. While HOBOnode Manager requires a direct
connection on a dedicated PC to monitor your network, HOBOnode Viewer gives you
the flexibility to see data node plots and network status anywhere. This allows you to:

e Look at real-time data from your local area network with any browser

e Check on the data node network remotely to make sure it is running properly
and that no devices are missing or alarms have tripped

e Share data with others by sending them a link to HOBOnode Viewer

HOBOnode Viewer is a locally hosted website easily configured within HOBOware
preferences. Once HOBOnode Viewer is enabled, HOBOware will create a link for your
own web page that displays the real-time plots and data for your data node network.
The HOBOnode Viewer web page will always be available as long as HOBOnode
Manager remains open on the computer with your HOBOnode database. For more
details, see the following topics:

Enabling & Disabling HOBOnode Viewer
Using HOBOnode Viewer
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Alarms Window

In the Alarms window you can:

Add Sensor g L - = S —
@—»

Alarm button ) [ L T CTTAT QT |
Gbact penl = Label (o) Lsbeel (Seraon) Mg Typs Drection: Uimit{e) Eruskls (L 3 Celets B
Fiter — & B bt By | T Trerperature v 000 F = ¥ x =
Configured D B e By 1 i s w.000% B [(B] =

Define sensor alarm conditions

Enable/disable system alarm conditions (missing node, heartbeat, and low
battery)

Define alarm actions (including email, text message, visual notification, and
audible alarm)

Copy sensor alarms to other sensors

View tripped alarms

Alarms : - B e By 2 Temp Tenpershirs e £0.000°F = Ll
Controls @—F Al [OiNone | J5Delsbe Copyto W Hone actions W

¥ Tripped Alarms Log L Clear Loy

Tiers L Dlele
[: : ) po| Otz CEID A EST {/Abowe 30,000 %} Sansor slarm TRIFPED for S/N 24319502 o 30,504 % »
Trlpped 01 /3001 008 3200 &M EST o 0000 *F) Sermor sl TRIFPED for 51N 2431592-1 o 71,146 % b, .4
Alarms Log
Seiext | Label Type SN St Mexs. Type  Readrg  Pet  Tme  Gropls)  Map  Alam | Soral  Banny [
O Recewsr @ IWACR ZIIITY CONNECTED - . . . . (] - —_ =
= e e e e = — - r
a (G tore v v | | | @b l Actens ¥ ] 1P hstveor: H o chose ]
1. Tabs

Alarms tab: Click the Alarms tab to go to the Alarms window
Sensor tab: Click the Sensor tab to go to the Sensor Alarms pane.

System tab: Click the System tab to go to the System Alarms pane.

Add Sensor Alarm button: Click to go to the Add Sensor Alarms window.

3. Configured Alarms: Configured sensor alarms appear here.
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Use the Filter to control what alarms shown in the sensor alarms pane.

NOTE: If an alarm you configured is not appearing in the Alarms window, make
sure the filter is set to Show all.

4. Controls - Use the controls to apply an action to multiple alarms,
including: delete, copy, enable/disable, and apply default actions.

5. Tripped Alarms Log - all tripped alarms appear here. Click the Clear Log button
to delete all tripped alarms.

NOTE: When an alarm trips, HOBOnode Manager is opened, if it is not already.
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Setting Alarm Preferences

Before you add sensor alarms, set up your Alarm Preferences for email notifications
and create default actions (notifications).

To open the Preferences window, click Actions at the bottom of the HOBOnode
Manager window and select Edit HOBO Data Node Preferences.

¥ alarms
Enter SMTP Sellings ta SMTP Sektings (for Emal and Teok Message alam actions|
Receive Email or Text LR | SANEHAMEC

Motifications [ : [ Thes: server requires & secure connection (550)
[#] This serves requires authenkication
Lisetriams; | ustrnae

Passwind wssssnas

e orignatng Fr addrass fior ol your Emal and
his address -’\-o-.-!e-:r e e dhoamasin &% your &

Send Test Email A
T @—h Test thees setfings by sending an emad to: | yourmasedisp com | Send Test Emad
(Optional) -

Diofan k. Alare Actions (add o ol aulkt

Add Default @—p . Add Defanit fiction | 7] For new sansor slams, auttmatically sdd al defaut actisns
Alarm Actions :

ol B (TRl A E

From: | yournasmsilisp.Com

l Errund L (] Perfenm o claar

1. Enter SMTP Settings for Email or Text Notifications

To receive email or text message alarm notifications, enter the Server IP Address
for your mail server, and enable SSL or authentication if required by your
network. See your Network Administrator or your Internet Service Provider for
information; see also Email Configuration for more information.

2. Send Test Email

Enter your email address and click the Send Test Email button to verify that your
settings are correct. Make sure you check your Junk Mail or Spam folder for the
email if it is not in your inbox.

3. Add Default Alarm Actions (Optional)

Entering default alarm actions simplifies alarm configuration. For example,
instead of entering the same email address for every alarm, you can select an
address from a list of drop-down entries when you add the alarm action.

For more details on alarm actions, see Adding Alarm Actions.

If you check For new sensor alarms, automatically add all default actions, when
you click the Add Sensor Alarm button, the alarm actions you configured are
automatically added, as shown below. This is helpful if you want the same actions
for every alarm.
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Alarm Actions

a7 Add New Action l l Add Defaul Action W Default Alarm Actions can be set in the Preferences

Erter an emsil address, ex, johni@doe com
w
|Email v | |John_Doe@onsetcomp.com | [[] Perfarm on dear W
Pleaze contact your mobile service provider to confirm your text message address, ex. 6175551 234@myserviceprovider com
W
[Text Message v | 508555121 2@mobik.att.net | [JPerform on dear W
Notes (will e included in Alatm Actions)
Save ] ’ Canicel ]

Related Topic
Email Configuration (page 289)
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Adding a Sensor Alarm

A sensor alarm trips when a sensor goes out of a threshold that you configure. You can
set up actions to be notified by email, text message, or by an audio or visual alarm in
HOBOnode Manager. Once you create an alarm you can copy it to multiple sensors of
the same measurement type or the same measurement type and group.

NOTE: Alarm notifications are sent to HOBOnode Manager when the node connects to
the receiver. The default Connection Interval is 10 minutes. If you change it, consider
that less frequent connections will result in more delay in receiving alarm notifications.

Opening the Add Sensor Alarm window

The first time you add an alarm for a sensor, you can double-click on the alarm icon for
the sensor in the Device Table. This will open the Add Sensor Alarm window with the
sensor already selected.

Otherwise, click the Alarms tab, then the Sensor tab, and then the Add Sensor Alarm
button. With this method you will then need to select the sensor from a drop-down list.

Add Sensor Alarm E‘

Enable sensor alarm

Alarm Condition
Sensor valuz range: -4.000 to 158.000 °F Latest value: 75.290 °F
<Ma Label For 2451994> | Temperature {<Mo Label For 2431994-13) ~ | | above w 0,000 | °F for 2 % logged data points

Sensor slarms are processed vhen node connects (every 2 minutes) and transmits data 1 minute Logging every 1 minute

Alarm Actions

o Add New Action ‘ l Add Default Action W Default Alarm Actions can be set in the Preferences

Enter an email address, ex. johnif@doe cotm
Email ~ [[] Perform on clear

Motes (il be included in Alsrm Actions)

1. Make sure the Enable sensor alarm checkbox is selected.

2. Select the sensor (if not already selected). If you accessed the Add Sensor Alarm
window by clicking on the alarm icon in the Device Table, the sensor will
automatically be populated. Otherwise, select the sensor you want to add the
alarm to.

3. Configure Alarm Parameters.
a.Select the threshold: Above, Below, or Outside Range.

a.Enter the value for the alarm.

b.Enter the Number of Data points. This is the number of readings that must
be outside of the limits for the alarm to be tripped or cleared.

4. Configure Alarm Actions (Notifications).
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See Adding Alarm Actions.
5. Click Save.

NOTE: Any time you edit an existing alarm, the alarm state is reset to untripped and
the logged data points is reset to zero.

Related Topic
Copying an Alarm to Other Sensors (page 279)
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Copying a Sensor Alarm to Other
Sensors

To copy an alarm to other sensors:
Selact Alarm(s)

@——I- & Bay 1 Bay 1 Temp

| [ Al [OjMone | &3 Delete Copyto W - @ Click Copy to
sensor(s) selected in HOBOnode Manager table

¥ Tripped Alarms Log

all sensors of same Measurement Type
all sensors of same Measurement Type and Group(s)

e Select Copy

= option

1. Select Alarm(s) - Select the alarms you want to copy. You can select alarms for
multiple measurement types and each alarm will only be copied for sensors of
that type.

2. Click the Copy to button.

3. Select Copy Option - You can copy the alarm to all sensors of the same
Measurement Type, or to Measurement Type and Group(s).

The alarms are copied to the sensors, as shown below.

Status  «  Label (Devios) Label (Sersor) Meas, Type Direction Limit{s)

= 5] Eurding | Boder Roam RH RH shave 43.000 %

] £l Buidng | Boder Room Tesp Tempersture bk 35,001 *F

Temp alarm O B Buding 1 Lab L RH shave 43,000 %
copied —— Bl mudnglls Temg Temperature below 35,001 °F
e— ] 5] Bulding 2 Office Temg Temperature bk 35,001 *F

Related Topic
Using Groups to Sort Sensors (page 321)
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Enabling a Missing Node Alarm

A Missing Node alarm trips when a data node has not connected to the receiver within
the specified timeframe.

The default period to determine that a node is missing is 10 minutes. You can change
this in the Preferences.

To enable a missing node alarm:

1. Click the Alarms tab in HOBOnode Manager.

2. Click the System tab and select the checkbox in the Enable column for Missing
Node. If alarm actions have already been configured by a previous edit, then the
Status icon for Missing Node will change to an active alarm icon as shown below.
This means the alarm is enabled. If an Edit Missing Node Alarm dialog box

appears or you wish to make additional changes to this alarm, then proceed to
next step.

'E'I HOBOnode Manager g@@'

Plots | Map | Alarms

——& Sensor @ System

. Status Enakle Exiit
Active

alarm icon L & Mlissing Mode; Trips when a nods is late by 10 minutes | | —f— Edticon

]

o Heartheat: Generates a system heartbeat every 12 hours starting at 12:00 PM il

&
0 Low Battery: Trips when a device's battery level is below 20% for L_L;- nodes only &]

3. An Edit Missing Node Alarm dialog box may open automatically. If it does not and

you wish to change the settings, then click the Edit icon for Missing Node as
shown above.
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Edit Missing Node Alarm X

Enable missing node alarm
Alarm Condition
The missing node alarm indicates that one of your nodes is late by 10 minutes.

The time to declare & node as MISSING can be zet in the Preferences

Alarm Actions

’ o7 Add Mew Action ] l Add Default Action W Default Alarm Actions can be set inthe Preferences

Enter an email address, ex. johni@doe.com

|Emai| W | |jsmith@acme.com

Mokes (will be included in Alarm Actions)

[ Cancel H Save ]

4. Make sure the Enable missing node alarm checkbox is selected.

By default, the alarm will trip after the node is missing for 10 minutes. Click the
Preferences button if you wish to change the default time period.

6. Add one or more alarm actions, which is how you will be notified when the alarm
trips. You can be notified via email or text, or by a visual cue or audible sound on
the computer where HOBOnode Manager is running.

7. Click Save. The changes you made to the missing node alarm are displayed on
the System tab.
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Enabling a Heartbeat Alarm

If you enable a Heartbeat alarm, a heartbeat is generated every 12 hours (configurable)
to let you know that the system is up and running. If you do not receive a heartbeat
notification, check the status of your receiver and restart HOBOware if necessary.

To configure a heartbeat alarm:

1. Click the Alarms tab in HOBOnode Manager.

2. Click the System tab and select the checkbox in the Enable column for Heartbeat.
If alarm actions have already been configured by a previous edit, then the Status
icon for Heartbeat will change to an active alarm icon as shown below. This
means the alarm is enabled. If an Edit Heartbeat dialog box appears or you wish
to make additional changes to this alarm, then proceed to next step.

.T HOBOnode Manager E| [E| fgl

Plots | Map | Alarms |

@ System |

——&d Sensar

Status Enable Eciit

i3] Missing Mode: Trips when a node s late by 10 minutes

=

Active

alarm icon

=1 Heartbeat Generates a system heartbeat every 12 hours starting at 07:00 PM Edit icon

M &

1 Low Batteny: Trips when a device's battery level is below 20% for [‘L; nodes only

3. An Edit Heartbeat dialog box may open automatically. If it does not and you wish
to change the settings, then click the Edit icon for Heartbeat as shown above.

Edit Heartbeat Alarm §|

Enable heartbeat alarm

Alarm Condition

The heanheat indicates that your Receiver is actively communicating with your HOBO Data Mode netwearl.
Select interval from 13 minutes up to 48 hours,

Generate heartbeat every skarting at (06:00PM 2

Alarm Actions

’ oF Added Mew Action

’ Add Default Action W ] Default Alarm Actions can be set in the Preferences

Erter an email address, ex. johni@doe com

|Emai| w | |jsmith@acme.cam |

Mates (will be included in Alarm Actions)

|Enker a noke about this alarm ke
l T_drTCET I l advE J
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Make sure the Enable heartbeat alarm checkbox is enabled.

Select how often you want to generate a heartbeat and what time you want to
start.

Add one or more alarm actions, which is how you will be notified when the alarm
trips. You can be notified via email or text, or by a visual cue or audible sound on
the computer where HOBOnode Manager is running.

Click Save. The changes you made to the heartbeat alarm are displayed on the
System tab.
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Enabling a Low Battery Alarm

You can set an alarm to trip when the battery level in a data node or a router drops
below a specific threshold. This can help you determine when it is time to change the
batteries for devices in your network. The low battery alarm is a system-wide alarm,
which means it applies to all devices (either all nodes or all nodes and routers) in the
network. You cannot set a low battery alarm for some data nodes and not others.

To configure a low battery alarm:

1. Click the Alarms tab in HOBOnode Manager.

2. Click the System tab and select the checkbox in the Enable column for Low
Battery. If alarm actions have already been configured by a previous edit, then
the Status icon for Low Battery will change to an active alarm icon as shown
below. This means the alarm is enabled. If an Edit Low Battery dialog box
appears or you wish to make additional changes to this alarm, then proceed to
next step.

121 HOBOnode Ma nager

Plots | Map | Alarms

~——@ Sensor @ System

Status Enabilz Eciit
&1 Missing Node: Trips when a nade is late by 10 minutes E]
© Heartheat Generates a system heartbeat every 12 hours starting at 12:00 PM ¥ ]
Active
alarm icon t— = Low Battery: Trips when a device's battery level is below 20% for L_k} nodes only |& | —g— Editicon

3. An Edit Low Battery dialog box may open automatically. If it does not and you
wish to change the settings, then click the Edit icon for Low Battery as shown
above.
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Edit Low Battery Alarm E

Enable low batkery alarm

Alarm Condition

Select battery level fram 10% o S0%

Trips when a device's battery level is below | 20% | for L.L;' nodes only w

Alarm Ackions

oF Ao Mew Action

[ Add Default Action W Default Alarm Actions can be 2et in the Preferences

Erter an email address, ex. johnig@doe cotm

Email * | |jsmithi@acme.com Fer

Mates (will be included in Alarm Actions)

[ Cancel ][ Save ]

4. Make sure the Enable low battery alarm checkbox is enabled.

5. Select the battery level at which you want the alarm to trip, from 10 to 50%. For
example, if you choose 20%, then the alarm will trip once the device's remaining
battery power drops below 20%.

6. Select whether the battery alarm should trip for nodes only or for both nodes
and routers. Notes: You cannot set a low battery alarm for a receiver because it
should always be powered by an AC adapter. In addition,you should not set a low
battery alarm for routers that do not have batteries installed. If your routers are
powered by AC adapters only and do not have backup batteries installed, then
you should set the battery alarm for nodes only.

7. Add one or more alarm actions, which is how you will be notified when the alarm
trips. You can be notified via email or text, or by a visual cue or audible sound on
the computer where HOBOnode Manager is running.

8. Click Save. The changes you made to the low battery alarm are displayed on the
System tab. Note: If the low battery alarm was previously configured and had
tripped, then clicking Save will clear the tripped state. If the newly saved settings
result in an alarm condition, then the alarm will trip at the next connection
interval.
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Adding Alarm Actions
(Notifications)

An alarm action is a notification when an alarm trips or and/or clears. You can
configure the alarm action to notify you in four ways:

e Via email
e Via text message
e With a visible message on your computer

e With a sound on your computer

Before you set up email or text notifications, you must configure your SMTP settings.

See Setting Alarm Preferences.

Add Sensor Alarm @
Enable sensor alarm
Alarm Condition
Sensor valug range: -4.000 to 158.000 °F Latest value: 75.290 °F
<hio Label for 2431994 | [Temperature (<No Label for 2431994-1) | [above v 0.000] °F for | 2 % | logged data points
Sensor alarms are processed when node connects (every 2 minutes) and transmits data 1 minute Logging every 1 minute
Alarm Ackions
o7 Al ey Action ‘ l Add Default Action W Default Alarm Actions can ke setin the Preterences
| Enter an email address, ex. johni@coes com
Email w [[] Perform on clear
Motes (vill b inclucledt in Alarm Actions)

1. Click the Add New Action button.

Tip: To save time, you can configure default alarm actions. See Setting Alarm
Preferences for information.

A new action is added.
2. Select the type of notification: Email, Text Message, Visible, or Audible.

3. Enter information or make a selection depending on the type of notification.

NOTE: If you add an email or text notification and you have not already setup

your SMTP settings, you will be prompted to do so.

eEmail - Enter the email address where you want the alarm notification sent.

o Text Message - enter the email address where you want the alarm
notification sent.

eVisible - no further configuration required. A pop-up window will appear in

HOBOnode Manager if the alarm trips.
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Visible Alarm on 13

= 11/03/09 10:33:55 AM EST
<( t(\'\:‘;.] >> Above alarm tripped on 13 : Temperature (Cooler 1) 72,955 °F

Mote: check coolant level

e Audible - Select the sound that you want to play when an alarm trips. Click
the Play icon to hear the alarm.

NOTE: If multiple audible alarms are set, only the most recent will play.
Any other actions configured for the alarm will be sent.

Check the Perform on clear box if you want a notification when the alarm clears.
If you only want a notification when the alarm clears and not when it is tripped,
change the drop-down selection to only.

5. Add Notes to be included in the alarm notification (optional).

To add another action, repeat the procedure.
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Using Default Alarm Actions

You can configure Default Alarm Actions in the HOBOnode Preferences. See Adding

Alarm Actions (Notifications) (page 286).

You can have the default actions automatically added to any sensor alarms you add, or
you can manually select individual default actions for each alarm.

Automatically Add Default Actions to Alarms

if this box checked ...

[ HPY TSP (I,

[ o rim s adaemss, sn pommatcaly 3 ol ded it actions
e L ] P o e
Toal M W B TR G 0 ] oo o e

el e Doawtoom. uom (] oo cochmar -

HOBOware Preferences > HOBOnode > Alarms

——  When you click Add Sensor Alarm, the Default
Alarm Actions are automatically added to the alarm.

Harm ctiors

L ik B cion Condgure defall Alem hcfions i e HOBONode Msrager Fretenenoss 2 5 Adwrma
Gty s wirehine
| | Vistie - Clretemon e :/\Jb
P GOMaCt i Peobi Sarie privider B3 S6RR Tour Yl e sagn aadnid, . ) PRSI I3y ervieps tnider o
[—— || Teut Mesrage »  Jobn_Doeiorsshoomg.iom [ reeterinn doar \AS
e
Wikl " [ Pertormon dear v«S

Add Sensor Alarm Window

Manually add Default Actions to Alarms

if this box is not checked ...

Dok s duciors g 0 e et acione]

(] P roee i sk, nfesmaticaly achd ol otk aciceni

Pz corbact o meobbe perce e 1 confem vour bl mesage sddres, ee 8175551 T4y terscopr o

Seak Meriage | Jobn DosBursannen com
e A —

[E] W et e (i [ Peeiorm on cnr f 5

HOBOware Preferences > HOBOnode > Alarms

When you click Add Default Action Alarm, the
Default Alarm Actions appear in the drop-down list.
Select an entry to add the action in to the alarm.

Alarm Actions

oF Add New Action Add Defaulk Action W | Configure detault Alsm A
Notes. (il be nctutes in [

Teat Message John_DosGonsetoomp. com
Ernal John_Dos@onsstcomp,com

Add Sensor Alarm Window
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Email Configuration

SMTP Settings

You must configure the SMTP Settings to allow email from the data node network to get
to your email recipients.

Corporate Environment

If your data node network is within a corporate network environment, you should
contact your Network Administrator (IT/MIS dept.) for this information. Also, they may
need to add the receiver to a White List to allow it to relay email through the corporate
email server.

Private Email

If you use a private mail account such as Yahoo or Google, or if you do not know your
corporate information, you can get the outgoing mail parameters from your mail
provider.

The following are links to this information for some providers. For other providers,
search on-line for “SMTP Settings for <provider name>".

e Gmail
http://mail.google.com/support/bin/answer.py?hl=en&answer=13287

e Hotmail

http://liveunplugged.spaces.live.com/blog/cns!F92775FC46A390CA!171.entry

Sending an Alarm to a Cell Phone

To send an email to your cell phone when an alarm occurs, enter the email address for
your cell phone.

Following are the formats for some cell phone providers. For others, contact your
provider. You can usually obtain this information on-line.

Alltel
[10-digit phone number]@message.alltel.com
Example: 2125551212@message.alltel.com

AT&T (formerly Cingular)
[10-digit phone number]@txt.att.net
Example: 2125551212@txt.att.net
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Boost Mobile
[10-digit phone number]@myboostmobile.com
Example: 2125551212@myboostmobile.com

Nextel (now part of Sprint Nextel)
[10-digit telephone number]@messaging.nextel.com

Example: 7035551234@messaging.nextel.com

Sprint PCS (now Sprint Nextel)
[10-digit phone number]@messaging.sprintpcs.com

Example: 2125551234@messaging.sprintpcs.com

T-Mobile
[10-digit phone number]@tmomail.net
Example: 4251234567 @tmomail.net

Verizon
[10-digit phone number]@vtext.com
Example: 5552223333@vtext.com

Virgin Mobile USA
[10-digit phone number]@vmobl.com
Example: 5551234567 @vmobl.com
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Configuring Scaling on a Sensor

To open the Configure Scaling window:

1. Double-click the sensor in the Device Table to open the Configure Sensor window
2. Select the Sensor Type if not already selected.
3. Click the Configure button.

Configure Scaling Window

Configure Scaling @

(1 f——=E e (OPuse [ View Scaling Factors... |

ot L ar 1 i genaraly used vwith an g,
ared mbru*:id‘upiktm. Thes :wo-ri:'?tlsm
analag inpat,

Sealneg Parsrrstrs

Raw Scaled
®\Q Moasurement:  Yolage Scaled Meas,
@*—\; Lnks: ¥ Scaled Links
(:] -_\'&.-!-1: 000000 5| = 0.0)%

@/_/'vmz. 2500005 = 0.0

1. Select Scaling Type (Linear or Pulse) - The Scaling Type is automatically selected
based on the type of sensor selected. Linear scaling is enabled for analog sensors;
Pulse scaling is enabled for pulse sensors.

2. Enter the Scaled Measurement type.

The Raw Measurement is the source measurement type (such as Current,
Voltage, or Counts).

3. Enter the scaled units.

The Raw Units is the type of output the sensor has; either V or mA,
corresponding to the type of sensor selected. Raw Value 1 and Raw Value 2
should be entered in these units.

4. Enter the Raw and Scaled for Value 1.

Raw - The low raw value given by the external sensor.

Scaled - The value that will appear on the graph when the sensor reports a raw
value equal to Raw Value 1. This value should be entered in the same units that
are specified in the Scaled Units box.
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5. Enter the Raw and Scaled for Value 2

Raw - The high raw value given by the external sensor.

Scaled - The value that will appear on the graph when the sensor reports a raw
value equal to Raw Value 2. This value should be entered in the same units that
are specified in the Scaled Units box.

6. Click OK when done.

Once scaling is configured on a sensor, the scaled icon will appear in the Meas. Type
column in the Device Table.
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Wattnode Scale Factors: T-WNB-3Y -
208/T-WNB-3D-240/T7T-WNB-3D-480

Use the table below to find the Kilowatt-hours per pulse for your CT Size and WattNode
model and enter it in the Scaled Value 1 box.

Example

This is example shows the values you would enter in the Configure Scaling window for
a Wattnode 3Y-208 with a 5 amp CT.

Scaling Type |[REUUEITERIEII

_ Click here to view Scaling
o Olnoar (&) Pubse [ View Scalng Factors... 44— Factors by sensor
Mote: Linear zcaling it generally uzed with snalog input,

and pulsa scaling with pulze input, This sensor measums
analog imput.

Scaling Parameters

Raw Scaled
Measurement; Yoltags Power +—® Scaled Measurement
Raw Value 1 Urits: ¥ ki -I-—@ Scaled Units
@——I‘- Vaboe 1: 1| = | 00001255 +—® Scaled Value 1
Wahue 2! =

cancel | | ok |

Scaling Type = Pulse

Scaled Measurement = Power
Scaled Units = kWh

Raw Value1=1

Scaled Value 1 = 0.000125

“i s W
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Kilowatt-hours per pulse

Kilowatt-hours per pulse

CT Size (amps)

Model #: 3Y-208 / 3D-240 |

Model #: 3D-480

| I

5 | 0.000125 | 0.0002885 |
15 | 0.000375 | 0.0008656 |
20 | 0.0005 | 0.0011541 |
30 | 0.00075 | 0.0017313 |
50 | 0.00125 | 0.0028854 |
60 | 0.0015 | 0.0034625 |
70 | 0.00175 | 0.0040396 |
100 | 0.0025 | 0.0057708 |
150 | 0.00375 | 0.0086563 |
200 | 0.005 | 0.011542 |
250 | 0.00625 | 0.014427 |
300 | 0.0075 | 0.017313 |
400 | 0.01 | 0.023083 |
600 | 0.015 | 0.034625 |
800 | 0.02 | 0.046167 |
1000 | 0.025 | 0.057708 |
1200 | 0.03 | 0.06925 |
1500 | 0.0375 | 0.086563 |
2000 | 0.05 | 0.11542 |
3000 ’ 0.075 ‘ 0.17313 '
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T-VER-8051-

300/T-VER-8053-800

The consumed energy in kilowatt-hours (kWh) per pulse for these sensors is

determined by the DIP switch setting on the transducer. The defaultis “1.00” kWh /
pulse, at which the scaling factor is 1 = 1. If you change the default DIP switch settings,

adjust your scaling factors accordingly, as shown below.

The data recorded by the data node will be the number of counts (pulses) per sampling

interval.
Cable Required/Sensor Type: CABLE- 2.5-STEREO

1 Pulse Per kWh (Default)

DIP Switch Setting

on Transducer

1.00

50
25

A0

il

NO

WValues in Configure
Scaling Window

Configure Scaling E
|

Olnear () Pubse | View Scaling Factors...
ek e
angloe input.
Scaling Parameters
Raw Scaled

Meanwement: Woltage Posser

Units: W ki

Wabee 1: 15| = 105

Value 2: =
Cancel | [ ok |
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.5 Pulse Per kWh

DIP Switch Setting Values in Configure
on Transducer Scaling Window
Configure Scaling -
-2 ——— d
(ylinear (%) Pulse | wiew Scaling Factors... |
100 » W]
i o s i Gt
s0 « [ 1 aniog et
25 & .:I Scalng Parameters
20 o ] R calod
- .:l Measurement: Voltage Power
Units: ¥ kwh
Walue 1: 15| - HE
Walue 2: | =
Ceme ) o)
.25 Pulse Per kWh
DIF Switch Setting Values in Configure
on Transducer Scaling Window
. .:l g Configure Scaling
CiUnesr (3 Puse Wiew Scaling Fackors...
100 B : ]
1 Lingar i uzsad with ingut,
50 o ] "ﬁmﬁﬁmﬁ«.m“&ﬂﬁﬂ
. = 5
25 = I:. Scaling Parameters
0 o .:l Raw Scaled
o .: Measurement: Yoltage Power
Units: ¥ kit
valoe 1: || 18] = | |
WVakps 2: =
(ot ] (o]
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.10 Pulse per kWh

DIP Switch Setting Values in Configure
on Transducer Scaling Window
- .: e Configure Scaling E
=
Li Fulse View Scaling Factors. ..
100~ M o o e
Mote: Linear sealing it gensrally uted with snalog input,
B0 e -:I WJMMMMTHWW
25 & .:I Scalng Parameters
10 e I:. Raw Scaled
Fa ) .:I Measurement: Yokage [—
Units: ¥ Icwl-.
Value 1: 18] = | 103
Vaho i | | = |
(e ] (o]
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Veris Scale Factors: T-VER-H970-
200

The T-VER-H970-200 has a selectable range for Linear Scaling: mA or Volts -> Amps.
An AC-DC power adapter with a minimum of 6W @ 35mA is required for excitation
power.

Cable Required/Sensor Type

Use the appropriate cable to connect the sensor to the data node and select the
corresponding cable in the Sensor Type drop-down when configuring the External
Sensor in HOBOnode Manager.

e For 4-20mA output, use CABLE-4-20mA.
e For 0-5vdc output, use CABLE-ADAPS.

0-50 Amps
Switch Setting on
T-VER-H970-200 Values in Configure Scaling Window
Scaling Parameters Se Brameters
Amp Ranges Caling Paramete
Raw Scaled Raw Scaled
To
Load I 050 Messurerment: Current Anngs Flaaamamant: Vckags v
@ Units:  Amps A Units: W A
ahue 1: 4.000 5 = 0.0 % Vahse 1: 0000 % = 0.0[%
0-100
Value 2! 20,000 & = 50.0 % Vala 2: 50005 = 50.0|%
4-20mA 0-5vdc
0-200

-298 -



0-100 Amps

Switch Setting on
T-VER-HS70-200

Amp Ranges

To

Load 0-50

@ I | 0-100

0-200

0-200 Amps

Switch Setting on
T-VER-H970-200

Amp Ranges
To
Load 0-50
@ 0-100
I | 0-200
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Values in Configure Scaling Window

Scaling Parameters
Raw Scaled
Mezsurement: Yoltage A
Unis: o
Value 1: 0.000 5 = 003
Yalue 2: 5.|:mcj - ||:n.o¢j
0-5vdc

Values in Configure Scaling Window

Scaling Parameters
Raw Scaled
Measursment: Current A
Urits: Amps A
vael: | 4003 = 003
Walue 2: 20,000 % | = 100.0 3
4-20mA
Scaling Parameters
Raw Scaled
Measurement: Current Amps
Unibs:  Amps a
vahae 1: | 4000 5| = 0.0 %
Vahoe 2: 20.000 % = 2000 3
4-20mA
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Veris Scale Factors: T-VER-971BP-
200

The T-VER-971BP-200 has a selectable range for Linear Scaling: mA or Volts -> Amps
for current flow in both directions.

Cable Type/Sensor Type

Use a CABLE-4-20mA to connect the sensor to the data node and select CABLE-4-20mA
in the Sensor Type drop-down when configuring the External Sensor in HOBOnode
Manager.

Notes:

e Requires 12-24VDC @ 35 to 110 mA excitation power depending on DC current
load.

e An AC-DC power adapter with a minimum of 6W @ 65mA is required.

e For currents over 120 Amps, supply voltage to CT must be atleast 15V to
maintain accuracy.

e Minimum Warm-up Time is 8-10 seconds.

Span Setting

The H971 comes preset at the maximum (0-200A) span. To adjust the H971 to a
different span, locate the potentiometer on the top of the device. This potentiometer is
a multi-turn device, taking about 23 turns to adjust the span from +20A to +200A. Use
the potentiometer to adjust the maximum amperage range used by the sensor.

The smallest amperage range (0 to £20 A) is set by turning the potentiometer fully
counterclockwise; the greatest amperage range (0 to 200 A) is set by turning the
potentiometer fully clockwise.

To determine the best amperage range for an application, first set the load to the
maximum amperage that will be used. Use the LED as a guide to adjust the
potentiometer to its optimum setting. Verify the measured output current matches the
load current using a current clamp meter.

LED Activity Potentiometer Adjustment

Steady green Turn CCW until LED blinks rapidly, then slowly turn CW just until
blink blink returns to steady rate.
gﬁgf sreen Turn CW until LED blinks at a steady rate.

For an alternate method, see the Veris Installation Manual:
http://www.veris.com/docs/Installs/h971_971SP_i0d2.pdf
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0-20mA

Scaling:
Z0rn,
1204
ey o
SENSED ANMPS

Potentiometer on
transducer

turn scraw fully
counterclockwise

* 200,
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Values in Configure
Scaling Window

Configure Scaling

@ lnear (O Pulse
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0-100mA

Potentiometer on
transducer

turm scraw fully counterclockwise, then
approximately 12 turns clockwise

0-200mA

FPotentiometer an
transducer

tum screnw fully clockwise
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Configure Scaling

(&) Lirsar () Pulse | wiew Scaling Factass. .

ot s Linder scaling i gensrally uted vtk analesg input,
ared pulie scaling with polte ingut. This sensor messunit
analeg Inga,

Scaling Parameters

Raw Scaled
Measurement:  Voltage ]
Units: ¥ A
vael: | 0000002 = [ 0003

Ve 2t 250000 % = | 100.0 &

Walues in Configure
Scaling Window

Configure Scaling

@ lnear  OPuke Wiewy Scaling Factors. .,

Hoke: Lnear scaling it generally wned with snalog inget,
s paave posling veith pulia inpat, This pencor e apanes
ancllog inget,

Scalin Parameters
Raw Scaled
Heasurement:  Wokage Aunprs
Unkts: ¥ I
Wake 1: 0.00000 % | = -200.0 %

vawe2: | 2500005 = | 2000 =

[ree ] [cemet ][]
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Veris Scaling Factors: T-VER-PXU-
L/T-VER-PXU-X

These Veris differential pressure transducers use Linear Scaling, mA or Volts -> "WC".

The analog output for these Veris sensors is determined by which screw terminals are
connected either to a CABLE-4-20mA or to CABLE-ADAPS5 or to CABLE-ADAP10. See
the documentation that came with the hardware for details.

Both models have switch-selectable ranges and scales. The examples below show the
scaling parameters you enter in the Configure Scaling window for the supported output
ranges and raw values.

0-0.1in. W.C.

Scaling Parameters
Range Setting on Sensor

Raw Scaled
A 0 P Measurement: Yoltage Diff, Pressure
© @ Mo Units: ¥ in. WLiC,
& G Yalue 1 0.00000 5 | = 003
4 Yalue 2! 5.00000 3| = 013
0=0-0.11in. W.C.
Voltage: 0 -5V
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current Ciff. Pressure Measurement: Voltage Diff . Pressure
Units:  Amps in. W.C. Units: ¥ in, W.C.
Yalue 1: 4,000 3 | = 0.0 % Value 1: 0.00000 3| = 0.0/
Yalue 2: 200000 3| = 0.1 5 Value 2: 10.00000 3 = 0.1 3

Current: 4 - 20mA Voltage: 0 - 10V
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0-0.25in. WC

Scaling Parameters
Range Setting on Sensor Raw Scaled
0 Measurement: Voltage E!lé'ifrf‘r_szur_e |
A 7 O —
Units: % i, WL,
o %] §
valuel: | 0.00000 % = 0.0 2|
& % :
4 vae2: | 5000003 = 0.25 3|
1=0-025in. W.C.
Voltage: 0 -5V
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current DIff. Pressure | Measurement: Voltage DIff. Pressure |
Units:  Amps [in. we.c. Units: v in. W.C. |
vaet: [ 40003 = | 003 vae1: | n.oo000 3| = | 0.0 3
vaez: | 200003 = | 0.25 % | vae2: | 1000000 3 = | 0258
Current: 4 - 20maA Voltage: 0 - 10 V
0-0.5in. WC
Scaling Parameters
Range Setting on Sensor Raw Scaled
0 Measurement: Voltage !_EE Pressure
A 7 S——
Units: ¥ lin. w.C. |
= ] : ) —
Value 1 000000 5| = | 003
9 CCJ } — . - 4
4 Yalue 2; s.00000 3| = | 05 2|
2=0-05in. W.C.
Voltage: 0-5 Y
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
——
Measurement: Current [fo Pressure | Measurement: Voltage Diff. Pressure
Units:  Amps lin. W.C. Units: ¥ lin. w.C.
Value 1: 4000 3] = | 003 Value 1: 000000 5| = | 003
Value 2; 20.000 3| = | 0.5%] Value 2 1000000 % | = | 0.5 8]
Current: 4 - 20ma VO“EQE: 0-10Y
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0-1.0in. WC

Scaling Parameters
Range Setting on sensor Raw Scaled
A 0 7 Measurement: Yoltage !DlFf Pressure
© ® ro Units: ¥ n W.C, |
o % Walue 1 0.00000 3| = | 002
4
Value 2! 5.00000 3| = | 1oid]
3=0-10inW.GC. o -
Voltage: 0 -5V
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current §.DiFf. Pressure Measurement: Voltage [b}p_p,esswe
Units:  Amps fin. w.c. | Uniks: ¥ o we |
vauet: | 40003 = | 00 Valel: |  0.00000 3| = | 003
vaez: | 200003 = 013 vae2: | 10.00000% = | 103
Current: 4 - 20mA Valtage: 0 - 10V
0-2.5in. WC
Scaling Parameters
Range Setting on sensor Raw Scaled
A 0 7 Measurement: Voltage E);F?_P!’ES_S!.I? I
s (:i) o Units: ¥ inwe |
© g valel: | o0.00000 3| = | 005
4 : : g 3
Value 2: 5.00000 3| = 2sg
4=0-25in. W.C.
Voltage: 0-5 W
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current |Diff. Pressure | Measurement: Voltage :-E:iFF. Pressure
Urits:  Amps lin. w.C. Units: ¥ fin, w.C.
vael: | 40003 = | 0.0% vael: | o0.00000% = | 0.03
vaez: | 200003 = | 252 vaez: | 10.00000 %] = | 258

L hs

Current: 4 - 20mA Voltage: 0 - 10V

-305-



HOBOware User’s Guide

0-5.0in. WC
Scaling Parameters
Range Setting on sensor
Raw Scaled
", 0 7 Measurement: Voltage m‘
© @ . Uniks: ¥ in, W.C. I
£ 7] Yalue 1: _ 0.00000 3. - 0.0 3_
4 valuez: | s.00000 2| = s.oj2|
5=0-50in. W.C.
Voltage: 0 -5V
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current Diff. Pressure Measurement: Voltage m
Uniks:  Amps r‘ Units: ¥ ’T
Yalue 1: 4000 2] = | 0.0 % valuel: | 000000 3| = | 0.02|
Yalue 2: 20000 3| = 502 vaue2: | 10.00000 3| = | 503
Current: 4 - 20mA Voltage: 0 - 10 V
0 - 10.0 in. WC
Scaling Parameters
Range Setting on sensor
Raw Scaled
LN 0 7 Measurement: Yolage
[1=] @ [4%] Units: ¥ in. W.C.
€, % Value 1: 0.00000 3| = | 0.03
Voue2: | 5.00000 % = | 10.0 2
6=0-10.0in. W.C.
Voltage: 0 -5V
Scaling Parameters Scaling Parameters
Raw Scaled Raw Scaled
Measurement: Current lm\ Measurement: Yoltage Diff, Pressure |
Units:  Amps in. W.C. Units: ¥ . W.C.
value 1: | 4.000%| = | 0.0 % valuei: | 0.00000 5| = 0.0 %]
vaez: | 200003 = | 100 3| value2: | 10.00000 3 | = 0.0 2
Current: 4 - 20mA Voltage: 0 - 10 V
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ION-TVOC

The ION-TVOC uses Linear Scaling, mA -> ppm.

NOTES

e Requires Loop power of 22 mA. Lamp and electronics require 65 mA.

e An AC-DC power adapter with a minimum of 6W @ 35mA is required for

excitation power.

0-10 ppm

Hardware Setting

A B C ]

pin B removed = 10 ppm

0-100 ppm
Hardware Setting

A B C b

pin C removed = 100 ppm

0-1000 ppm

Configure Scaling values

Scaling Parameters

Raw Scaled
Measurement: Current :Gas |
Units:  Amps :ppm |
value 1: | 4000 3| = | 0.0 % |
Valuez: | 20000 3| = | 10.0/%

Configure Scaling values
Scaling Parameters
Raw Scaled
Measurement: Current :Gas
Units: Amps ppen
Value 1: 40005 = | 0.0 % |

vaez: | 2000023 = | 10003
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Hardware Setting

A B C o

all pins installed = 1000 ppm

Configure Scaling values

Scaling Parameters
Raw Scaled
Measurement: Current
-
value 1: | 4000 5| = | 005
Value 2: | 20.000 3| = | 1000.0 2 |
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Adding a Device to the Network Map

For an overview of the network map, see The Network Map (page 238).

Py M S

Room 1 Room 2 Room 3

Connection
Path

™ 4—® Place node icon

Office % . .
®/ ‘—\_\—® Place receiver icon

Room 5
Add additional L :
nﬂdes :r Mo Trpe Fradyg i Toe o) :ﬁo i S B Check Map box
e ’ 3 i for receiver
Lol Check Map box
for node
1. Inthe Device Table, check the Map box for the receiver to add it to the map.
2. Move the icon to the location of the receiver and click the left mouse button.
3. Check the Map box for a node to add it to the map.
4. Move the icon to the location of the device and click the left mouse button.
5. Repeat steps 3 and 4 for each node you want to add to the map.

Related Topics
Configuring the Network Map (page 310)
Uploading a Custom Image to the Network Map (page 313)
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Configuring the Network Map

Click the Configure icon in the top left of the Network Map to open the Network Map

Configuration window.

soncor I 2= +—— Node Paths

Picks | Map | Al
- * e
EI eyt Balioer Typar {1 Splifeed
S et -——  Information
iy wird. faplimis £ -
i e Balloons
3 R L T e —————— e i
Configure icon —T| | m=—————— SR B
=
+——— Wap Image

Node Paths

Mode Paths

Show Path to Receiver Path Color: .

Show Path to Receiver
Paths are shown by default. Uncheck this box to hide connection paths between nodes.

Path Color
To change the path to a color that works better with your map background:

1. Click Choose on the Network Map Configuration window.
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I ormation Balloora.

Iribormation Balioor Typa: ) Seplfed
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= e—
] St oo oy mhory ke s b e 06 st

e Imagm

Currart Image:

Click Choose

rancon | e ) —f-———————————+ BRI
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e Select Color

FTE =

44
[

o N[ = -—@ Click OK

é Click OK

1. Inthe Choose Path Color window, select the desired color.

2. Click OK to close the Choose Path Color window.

3. Click OK to close the Network Map Configuration window.

Information Balloons

Information Balloon Type

e Simplified - shows only label and readings.

Test Ba
==y
=5

'.'II-‘-1
ik

-

L

f

e Expanded - shows all device information

==

=

Test Bay
- <

urrent Readings

SR Unknosen -
[ Unkenossn -
s Drewice InFormation

2= Ternp (Test Termpl 65.871 =F
<[] » RH [Test RH) 25,095 2&

Information Balloon Color

SE
==

Click the arrow to select a color for the Information Balloons that works best with your

Map background color.
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Information Ealloon Color: |:| s

[] Show Infarmation Ballol

Map Image

Current Image: 00

Show Information Balloon when adding new data nodes and on startup

Check this box to have balloons automatically appear when you add a data node to the
map.

Map Image

To change the map image, see Adding a Custom Image to the Network Map on page
313.
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Customizing the Network Map
Background

You can upload a custom image to the Network Map to represent your floor plan.

N Click Choose

Pota | Map | sarms Select Image
— Habwark Mag Configuratian ]

] B Fath bz Recurrer

& i
i ———=- D trparced
O = pecors [ )
Click Configure lcon e e P L
Cooe - mpns
| - o ... . B8
click Ok (5) Click Open @
1. Click the Configure icon in the top left corner of the map-.
2. Click the Choose button in the Network Map Configuration window.
3. Select the image file from the Open window.
4. Click Open.
5. Click OK to close the Network Map Configuration window and display the new

image.

To revert to the default image, click Restore.
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Custom Network Map Guidelines

If you don't have an image to upload, you can create one using any drawing program,
following these guidelines.

Image Size

There are 3 scale levels available for an image in the Network Map, depending on the
size of the image you upload. The larger the size, the more zoom levels you will have.

1,000 x 1,000 (minimum size) - 1 zoom level
2,000 x 2,000 - 2 zoom levels

3,000 x 3,000 (maximum size) - 3 zoom levels

General Image Guidelines

o All images are converted to squares in the Network Map, so for best results your
overall image should be a square.

¢ Inside the main square, add a smaller square or rectangle to roughly represent
your building.

e Add squares or rectangles to represent rooms in your building where you will
place nodes. Add descriptive labels to each room such as "Office," "Cooler,"
or "Boiler Room." Some programs will also have other images you can add to the
room such as desks and computers to help you narrow the location of the node.

o Set the properties of the image to your desired resolution. For best results enter
4,000 x 4,000 pixels.
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Viewing Real-Time Plots

In the plots window you can view sensor data in real-time plots. You can plot a
maximum of 20 sensors at once.

To view the real-time plot for sensors:
1. Select the Plot box in the Device Table for each sensor you want to view.
2. Select Sensor or Measurement view tab.

In Sensor View, there is a separate plot for each sensor.

In Measurement View, there is one plot for each Measurement Type (such as
temperature), which may contain separate entries for multiple sensors.

3. Change the time frame of the plot using the Time Frame tabs.

Use ime tabs to view
different time frameas

. Reorder
Select tab to view by
Sensor or by Measurement

Sort Plots

Plot Toolbar

T HomEIn e Manag 1

P3| o | darms

’ - Selected sensors

LLE ] R 113008 LS 1] [LE 01303 appear inthe |:;||c,.tr

EL% ] 180000 11 W0 L= 1 W00 [-ER-0 15 L]

Sen L Tore ™ Band Mest Tyt Besieg | Tma W Geel  Mm  Mew  Sew by |G
(m] [per— @ TRV Feirrir] LD - . . . (@] B -
D say b g P07 I ACTVE - . . - B O L | -
0 taritesn - A TR Temp) POTNRE] ACTRE Tespeanre GAPUF  EVIOGDIREIN 5] ! @
O Sartes AL TEMRENE)  MONIGD ACTRE P FFEE  DEVIOOEHMRM [ = g - =
By Teep 2 - e HNEPD SCTNE Tempesee TN GHZMIOGDINO00MM [
= - e . 2azITey ors E 5 = E #| Check the Plot box to
o 8 Yo S Ty g ¥ B contepan 7 e tonars ¥ | [ o e L P et 1 Ouse | add a sensor o the p-|f_'lt.

o Use the Sort Plots By drop-down list to change the order of the plots.
o Use the Reorder Plots arrow to reverse the order of plots.
o Use the Plot Toolbar to zoom in or out, pause the plot, or print the plot.

e Right-click on a plot to access a menu with the following options:
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FProperties, ..

Copy =3
Sawve as...
T T
in:o0 Prifk. .. o
B Zoom Imn > —

Zoom 2k L ]

ok Rangse Pk

Plotting Preferences

To change preferences that apply to real-time plots only, see Real-Time Plot
preferences.

Use Plotting Preferences to change the appearance of plots. To apply changes to real-
time plots, re-start HOBOnode Manager or uncheck the sensor Plot box and then re-
check. To open the Plotting Preferences, from the main HOBOware menu select File
> Preferences and then click the Plotting tab.

- 316 -



HOBOware User’s Guide

Plotting or Exporting Wireless Data

With HOBOnode Manager, you can view data and plots from your HOBO data node
wireless network in real time, but you also have the ability to plot or export previously
logged data. Using the Plot/Export Wireless Data capability, you can plot data directly
in HOBOware or you can export it to a text or .csv file to open in another program for
further analysis. You can pinpoint the exact data you wish to plot or export, allowing
you to view data from:

e Current and/or previous network deployments,

e Specific data nodes,

e A subset of certain sensors from selected data nodes,

e Groups of data nodes as configured in HOBOnode Manager, and

e A specific date range or timeframe.

In addition, you can save frequently used settings for quick plotting and exporting in
the future and for use with data delivery, which allows you to share data automatically
via email, FTP, or saved to a drive on a regular schedule.

To open the Plot/Export Wireless Data tool], click the Plot/Export Data button in
HOBOnode Manager (or from the File menu in HOBOware, select Plot/Export
Wireless Data).

| Help H atins ¥ | | - PotfeportData | [ 5 FomNetwork | [ (0 close J

To use the Plot/Export Wireless Data tool:

1. Select the deployment that contains the data you wish to plot or export.

Stepl: Deployments, select deployments whose data you want to plot/export

gn

Depl # Label Skart kime End time
2 Warehouse Building B 09/28/10 0%:54:09 AM 09/28/10 10:23:47 AM
[ First Deplayment 09/17/10 02:54:30 PM 09/26/10 0%54:09 &M

2. Select the data nodes with the sensors whose data you wish to plot or export.
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Step 2: Modes, select to show sensors
| (=] Al | | (D] Maone |
Label Serial Mumber Depl #
2431949 2 ~
2431994 2 -

3. Each sensor for the data node that you selected in Step 2 will appear in a list as
shown below. Click the down arrow icon for each sensor you wish to plot or
export, or click Include all sensors if you want to plot or export data from all
sensors in the list. Note: If you have set up groups in HOBOnode Manager, you
can also sort and select sensors within those groups. See Using Groups in the
Plot/Export window on page 324.

Step 3: Node Sensors, dick arrow to add data to plot/export

J-1 Include all sensors

Label Serial Mumber | Depl # Measurement Type | Groupls) # Samples
L 2431949-1 2 Temperature 120
4 Z2431949-2 z2 RH 120
e 2431994-1 z2 Temperature 119
- 243531994-2 2 RH 119

The sensors that you selected will move from the top half of the Step 3 pane to
the bottom half as shown below. In this example, all sensors were included and
are now shown in the "Sensors to plot/export” list. If you wish to make changes,
you can either click the up arrow icon remove a specific sensor from the list, or
click Exclude all sensors to move all the sensors back to the top (you'll then
need to select the sensors you wish to plot or export again).
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Step 3: Node Sensors, click arrow to add data to plot/export

Label Serial Mumber  Depl # Measurement Type | Groupls) # Samples
e
w
Sensors to plot/export
) Exclude all sensors Total number of samples: 475
Label Serial Mumber | Depl # Measurement Type | Groupls) # Samples
i 2431949-1 2 Ternperature 120 -
- 2431049-2 2 FH 120
i 2431994-1 z Temperature 119
T 2431994-2 zZ RH 119
L

4. Choose the time range for the data you wish to plot or export. Select Custom and
specify your own start and end time, or select Preset and choose one of several
pre-defined ranges from the drop-down list.

Step 4: Time Range, limits of plot/export

(%) Custom

Stark Time 09028010 10:00:00 AM :
End Time 09/28/10 10:15:00 AM =
) Preset

5. Once you have all the settings selected, click the Export or Plot button. Clicking
the Export button will open the Export Options dialog, where you can choose to
save the data to a single file or to multiple files. Clicking the Plot button opens the
Plot Setup dialog, where you can select the series that will appear in the graph in
HOBOware.

Use these settings as window defaulk Cancel ] [ Export ] [ Plak

Notes:
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o [fyou want the current settings to always appear in the Plot/Export Wireless
Data window, then select the Use these settings as window default checkbox.

e You can save different combinations of settings to a configuration file in the
Plot/Export Wireless Data window for future use, or for use by the data delivery
feature. Click the Save Settings button, type a name, and press Enter. Then click
the Load Settings button and choose the configuration file you wish to use for
the current plot or export.

H] Plot/Export Wireless Data - untitled*

v [ Save Settings W

!Warehnuse Zone &
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Using Groups to Sort Sensors

You can assign sensors to groups in the Device Table and then use them to sort rows in
the table, or to refine a list of sensors in the Plot/Export Wireless Data window.

LB § g AR PRGN MLV

[FBay § Tomp —&l CABLE-LIZI-002 (Temp) SES2595-1 ACTIVE T

[TBuy 1 RH & CABLE-LZI-00Z (RH)  SESEE55-2 ACTIVE RH

[ =Enter label b - et Ao Se SEEREAE-] ACTIVE

[ <Eri: - t SEERSGE-4 ACTIVE

[CRay 3 & D013 2421952 ACTIVE -

[SBuy 3 Temp - TW-INT-TVEL 2431 ACTIVE Ter

[CBay 3RH —— i TW-INT-RHl 2319922 ATTHE  RH

| ey 44 Tl oy ACTES

....ﬁ" MM ——_ @-—-_" adoh sy Drcaap W .|| I
. . -~ _[Aad sHecied sermr rtn ot ke

Megirowrd Type rtngs]

5 Mistch e SISl

Mistch ol nebected G

o

Caroel

Use Groups sort sensors in the

Apply Groups in the Device Table -
Plot/Export Data Window

Creating Groups and Adding Sensors

[F8ay 1 Tewmp —— i CABLEAIZ3-00Z (Temg) 96585951 ACTIVE

[Coay t RH - CABLEAUZI-002 (RH)  SESE095-2 ACTIVE

CErter label beve e 1 Ansiog Serser > PESESYS3 ACTIVE

Select . Erter labe — e : QESHE95-4 ACTIVE
Sensor(s) W E @ w3 MNP ACTIVE
[witay 5 Temp — & TW-INT-TMP1 24319921 ACTIVE

[Bay 2RH ——i JW-INT-RH] 2431992-2 RCTIVE

s DRI ST

[ (L] o SeosceType ¥ | roups ¥ _‘,f—H@ Click Groups
l' T 4—|—® Type group name and then
hit ENTER on your keyboard.

1. Inthe Device Table select the sensor(s) you want to add to a group.

2. Click Groups.

3. Inthe <New Group> box enter a name for the group and then click the
ENTER key on your keyboard.

The Group Name appears in the table for each sensor selected.

Adding Sensors to a Group

To add a sensor to an existing group:
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LBy L T LD

WO Ve

T

By | Terp — CABLE-(23-002 (Tewp)  9058995-1 ACTIVE
[CBar 1 R — CABEZI-002 (AH)  965A595-Z ACTIVE  RH
Select [ i bl e N R R e R R
Sensor(s)  Cemrto bl b — i cSeka PESESTS4 ACTIVE
Coay 3 @ w3 AW ACTVE -
By 3 Temp - W BT TP 243 ACTIVE T
[Ceay 374 . TW-INTRHI MIILE ACTVE  RH
s " ATIBHDA .

Select the sensor(s).

Click Groups.
Check desired groups(s).

L A

Click Apply Selected Group(s).

o - . L
A = Sersor Type ¥ ¥l

[y 1
[ Power

[#] Temg  ————

R4
_Mm&u\.-ﬁm...

Lol

oW

—@ Select Group(s)

Fovly Seecied G 17@ Click

See Using Groups in the Plot/Export Data Window.

Sorting by Group

Apply Selected Group(s)

Click the Group(s) column header to sort rows by groups.

Click the Group(s) column
header to sort rows by group.

'

Group(s)
Building 1
Building 1
Building 1, Building 1 Temp
Building 1, Building 1 Temp

Deleting or Renaming a Group

Select Manage Groups from the Groups drop-down.
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Aadd to Graup W =

=Search=

=Mew Group>

|2

Building 1
Building 1 Temp

Apply Selected Groups

The Manage Groups window appears.

Manage Groups <]
Existing Groups

Building 1

fUsed by < senso ws)

Building 1 Temp

fUsed by 2 senso =)

>
< >

e To change the name of the group click the Edit icon and enter the new name.

e To delete a group, click the X.
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Using Groups in the Plot/Export
Wireless Data Window

Once you have set up groups in the Device Table, you can use them to refine the list of
available sensors in the Plot/Export Wireless Data window.

To set up groups, see Using Groups to Sort Sensors.

Lice Grou| “OrOUP search bexts

Group(s)

5.

Check Use Groups to
filter node sensor list

Match any Group W - = ® Click Match any Group

=

=1 @ Select the group(s) that

Bulding 1, you want to include

[ Buiding 1 Temp

(%) Makch any selected Group o
4——@ Select match criteria
() Match ol selected Groups

EEIEE(5) cClckoK

CaTUpdate Groups settings |
T

Check the Use Groups to filter node sensor list box.
Click the Match any Group button.

Select Groups

Select the groups that you want to include in the list.
Select the Match Criteria

Match any selected group - Any sensors that are a member of any of the groups
selected will appear.

Match all selected group - Only sensors that are a member of all of the groups
selected will appear.

Select OK.

Only the sensors that match the group criteria will appear in the Node Sensors list.
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Step 3: Node Sensors, click arrow to add data to plot/export | Mateh all Grouns ¥

A+ Include all sensars Ise Groups ko filker lisk
Label 3/ Depl # Measurement Type Group(s) # Samples
4 Temp 2431992-1 z Temperature Building 1, Building 1 Temp 5085

4 Temp 2431976-1 2 Temperature Building 1, Building 1 Temp 5070

Viewing Current Sort Criteria

The button text indicates the
current sort criteria.

| Match all Groups ¥ |

Hover over the button to see the

Use Groups to filker(Building 1 Temp | =— groups selected.
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Enabling and Disabling HOBOnode
Viewer

To access HOBOnode Viewer, you must first enable that feature within HOBOware
preferences on the computer running a data node network. This will create a link to a
HOBOnode Viewer web page that you can use and share with others. If you have not
already set up a data node network using HOBOnode Manager, you must do that first
and then you will be able to activate HOBOnode Viewer from the same computer.

Windows note: If Windows Firewall is enabled on your computer, you may need to
adjust the security settings to allow access to HOBOware before enabling HOBOnode
Viewer. To check this, open Control Panel, go to Security, and select Allow a program
through Windows Firewall (or click Windows Firewall and click the Exceptions tab on
some versions of Windows). Make sure HOBOware is selected in the allowed
access/exceptions list.

To enable HOBOnode Viewer:
1. Open the preferences for data nodes. From HOBOnode Manager, click the
Actions button and select Edit HOBO Data Node Preferences. Or, to access

preferences within HOBOware, select File > Preferences on Windows or
HOBOware > Preferences on Macintosh and click Data Nodes.

2. Click Sharing within the Data Nodes preferences, and then click HOBOnode
Viewer.

3. Select the Enable HOBOnode Viewer checkbox.

¥  Sharing
HOBCnode Yiewer Enable HOEOnode Viewer @
Fort: 8080

Website: http: /192, 1658.1.188:8080/HOE OnodeYiewer

4. By default, the port number assigned for HOBOnode Viewer is 8080. You may use
this one or change it to any other available port. In most cases, the default 8080
port number will be available. However, if this number is already in use by
another web service application on the same computer, then you can change it to
any other available port. There are 0 to 65,535 ports. Port numbers 0 to 1023 are
restricted ports reserved for use by system services, such as FTP, Telnet, and
HTTP. You may use any other available port number from 1024 to 65,535 for
HOBOnode Viewer.

5. Click OK in preferences and then restart HOBOnode Manager (close HOBOnode
Manager and then from the Device menu in HOBOware, select Manage
HOBO Data Node Network to reopen it). HOBOnode Viewer will not be fully
enabled until you restart HOBOnode Manager.
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6. After HOBOnode Manager has restarted, return to the HOBOnode Viewer
preferences. Click the link, or URL, to go to your HOBOnode Viewer web page.

The URL has the following structure:
htttp://<IP address>:<port number>/HOBOnodeViewer

where <IP address> is the IP address for the computer where your data node network
is running and <port number> is the port assigned for the HOBOnode Viewer in
preferences.

To share the URL with others, click the link and then copy the URL from your browser
and paste it an email message to send to others who would like to view your data node
network.

Note: HOBOnode Viewer is only available while HOBOnode Manager is running. If you
close HOBOnode Manager and then attempt to access HOBOnode Viewer, the web page
will not open. Also note that the HOBOnode Viewer will not be available outside your
local area network unless you expose that computer outside of the network. Contact
your IT department if you would like to expose the HOBOnode Viewer.

To disable HOBOnode Viewer:

1. Open the preferences for data nodes. From HOBOnode Manager, click the
Actions button and select Edit HOBO Data Node Preferences. Or, to access
preferences within HOBOware, select File > Preferences on Windows or
HOBOware > Preferences on Macintosh and click Data Nodes.

2. Click Sharing within the Data Nodes preferences, and then click HOBOnode
Viewer.

3. Deselect the Enable HOBOnode Viewer checkbox.
4. Click OKin preferences and restart HOBOnode Manager.
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Setting up Data Delivery

With data delivery, you can automatically save recorded sensor data from nodes in
your network to a single .txt, .csv, or .xIs file on a regular schedule. This allows you to:

e Store data from your current data node network deployment for future reference
and analysis,

Access data remotely when you are away from the network, and

Share data with others in a file that is distributed automatically via FTP or email,
or saved to a computer or network drive.

Before you can set up data delivery, you must first select which nodes and sensors you
wish to include in the file by saving the configuration settings. To do this:

1. From HOBOnode Manager, click Plot/Export Data.

2. Select the deployment name from the list.

Stepl: Deployments, select deployments whose data you want to plot/export

Depl # Label

Start time
1 First Deployment

Tue Sep 14 13:37:40 EDT 2010

End kime
Fri Sep 17 06:50:19 EDT 2010

3. Select the individual nodes you would like to include in the file or click All to
select all nodes.
Step 2: Modes, select to show sensors
| (=] Al | | (D] Maone |
Label Serial Mumber Depl #
2431949 2 ~
2431994 2 3
4.

Select the sensors you would like to include in the file or click Include all
sensors.
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Step 2: Node Sensors, click arrow to add data to plot/export

J- ) Include all sensors

Label Serial Mumber | Depl # Measurement Type | Groupls) # Samples
e 2431949-1 z2 Temperature 120 -
A 2431949-2 2 RH 120
ol 2431994-1 2 Temperature 119
. 2431994-2 z2 RH 119
w
5. Make sure all the sensors you wish to share in your datafile appear in the
Sensors to plot/export list.
Step 3: Node Sensors, click arrow to add data to plot/export
Label Serial Mumber  Depl # Measurement Type | Groupls) # Samples
e
w
Sensors to plot/export
) Exclude all sensors Total number of samples: 475
Label Serial Mumber | Depl # Measurement Type | Groupls) # Samples
ib 2431949-1 2 Ternperature 120 -
- 2431049-2 2 FH 120
T 2431994-1 z Temperature 119
T 2431994-2 zZ RH 119
L

6. Click Save Settings and type a name, which will also be used for the data
delivery file name, and press Enter. Your configuration settings will be saved.
You do not need to set up a time range (Step 4 in the Plot/Export Wireless Data
window) at this time because those settings do not apply to data delivery. Step 4
only applies to immediate plotting and exporting.

G

H Plot/Export Wireless Data - untitled®

[ Save Settings W

!Warehnuse Zone &
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After you have selected the sensors you wish to include in the shared data file, you can
then set up data delivery within Preferences.

To do this:
1. Open HOBOnode Manager.
2. Click the Actions button and select Edit HOBO Data Node Preferences.

Actions W H = PlotfExport Daka

[ Prink Device Table. .,

-n- Edit HOBD Data Mode Preferences. ..

oo Create Mew Ceployment. ..

3. Select Sharing, and then select Data Delivery.

(- ¥  Sharing

pispo

play OBnd Vievier To use the Data Delivery Feature, please create and save a settings file in the Plak/Export Data window

Daka Delivery

r. Mote: Device Communication must be running at the time the saved settings are run

i
PN

) Sminutes s | extract wireless data using the saved settings | <Mo saved queries>
Warnings

and perform the Follawing actions with the exported file:

- [ Email file ta:
Data Nodes

Sl HES

Note: If you have not yet selected the sensors you wish to export, then you will see a
message indicating you need to create and save a settings file. You must select the
sensors in Plot/Export Wireless Data before continuing.

4. Select how often you want to save the data from your network, from 1 minute to 7
days. This will determine what schedule you use to share the data.

¥ Sharing

Mate: Dewvice Communication must be ronning at the tine the saved zettings are run

Ewery |5 minutes | extract wirgless data using the saved settings | Warehouse Zone 4w

and perform the Following actions with the exported file:

5. Select the name of the saved settings that you created in Plot/Export Wireless Data,
such as "Warehouse Zone A" in the example above.

6. Select how you would like to share the file: via email, FTP, or saved to a computer or
network location. You may select more than one method of sharing the file.

Email:

Type the email address where you want to send the file and select the checkbox if you
want to compress the file before emailing it. Note: Data delivery uses the same email
settings configured for alarm email notifications. If you have never configured an alarm
email, you must do that first, even if you don’t plan on setting any alarms.
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Ernail file ka:

Email address:  |jsmith@abccompany, com zes SMTP settings from Alarms panel abowe

_ompress file before emailing

FTP:

Enter the FTP server name, the directory name (remote folder), username, and
password for the FTP location where you want to place the file. Test the FTP
Connection to make sure it successfully delivers the file to the specified location. Select
the checkbox if you want to compress the file before delivering it via FTP.

FTF file to:
FTP server: |abccompany,com SFTP mot supparted
Remote Folder:  |warehouse
Isername: |jsmith

Password: |essesss

[ Tesk FTP Connection

Compress file before FTP-ing

Saving it to a hard drive or network:

Select the directory where you want to save the files. Choose whether you want to
overwrite the file each time a file is saved, or if you want to create a new file each time.

Place the file in the Following location on the local filesystem or network:

Zhkest files

This file can also be accessed remotely by enabling HOBOnode Yiewer &

{::' Cwerwrite File each bime  (Filemames will have no timestamp, e.g. "Warehouse_Zone_f.cav'"]

(#) Create new file each time  (Filenarmes will contain timestamps, g, "warehouse_Zone_A_2010_09_19_ 21 02_Sd.cov'")

When you are done configuring your data delivery settings, click OK in the main
Preferences window.

¥

Setup Assiskant ][ Restore Defaults ][ Cancel ][ (] 4 ]

The sensor data from your data network will then be saved and shared on the schedule
that you selected. The data will be saved as a .txt, .csv, or .xls file that you can import
into HOBOware, Microsoft Excel, and other programs for analysis. The file type is
determined by the export settings in Preferences.
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Notes:

e Data delivery will not run unless device communication is also running. This
means if you opt to stop device communication when you close HOBOnode
Manager, then data delivery will also stop. Once you restart the device
communication, then data delivery will commence again on the previously
configured schedule.

o The preferences for data delivery may include the names of settings files from
old network deployments. If you enable data delivery and use the saved settings
from an old deployment, you will see a message indicating "No data found for
selected sensors." Choose a settings file from the current deployment, or create a
new one with Plot/Export Wireless Data.

Tip: You can also share data from your HOBO data node network by enabling a
HOBOnode Viewer webpage. When data delivery is configured to save files to your
computer or a network drive, the files will also be available on the Data tab in
HOBOnode Viewer. Note that if you change the file directory used for data delivery
when HOBOnode Viewer is enabled, you will need to restart HOBOnode Manager
before you can access the files from the Data tab.
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Using HOBOnode Viewer

Many of the elements in HOBOnode Viewer are the same as HOBOnode Manager.
Specifically, you can do the following with HOBOnode Viewer just as you would with
HOBOnode Manager:

e Organize plots by sensor or by measurement type

e View plot data hourly, by day, by week, or by month (the month view must be
enabled in the preferences for real-time plots)

o Sort the plots several ways, including by serial number, current reading, and
alarm state

e View a map of your network devices
o Check the device table for details on each device in your network

e Change the device table view by sorting the columns

Plots I Map | Data |

Sensor Measurement AHr Day | Week | sort plots By: |Label (Title) + v

Warehouse Zone &

&7.50

55.00
.
I 52 50

[
50.00

47.50

T T 0 0 T 0 T T T T L 0 T T 0 0 0 T T 0 T T T T 0
IQ:DP:DD 12:30:00 01:00:00 01:30:00 DZ:DID:I]I] 02:3000 03:00:00 03:30:00
02/18/10 12:00:00 PM EDT 08/18/10 02:00:00 P EDT

Min: 46,600 , Max: 56 878

Label Tvpe S/N Status Meas. Type Reading Time Alarm Signal Battery
7 F—— 2372376  CONNECTED - - - .. —
Warehouse Zone A @ZW-UlE 2431994 ACTIVE = = = = -IlII L"ig?
Warehouse Zone A _=ZW71NT—TMP1 2431994-1 ACTIVE Temperature 79.173 °F  08/18/10 03:56:00 FM @ - -
Warehouse Zone A _=ZW71NT—RH1 2431994-2 ACTIVE RH 46,418 % 08/18/10 03:56:00 PM @ - -

onse " World Leaderin
Data Logger Solutions

There are, however, some key differences between HOBOnode Manager and
HOBOnode Viewer.

e HOBOnode Viewer, as its name implies, is a viewer only. Any changes you wish to
make to your network, including updates to alarms or modifications to the map,
need to be done directly in HOBOnode Manager.
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o With HOBOnode Manager, you can see all available sensor channels on all
devices, including those without a sensor type selected. HOBOnode Viewer
displays enabled sensor channels only. If a device in HOBOnode Manager has a
channel listed as “OFF,” then that channel will not appear in HOBOnode viewer.

e There may be some minor differences in plot appearance if you are comparing
the plots in HOBOnode Viewer to HOBOnode Manager. In general, plots are
nearly identical, but there could be slight differences in scaling.

o I[fyou set up data delivery and chose to have files saved to yourcomputer or a
network drive, then a Data tab will be visible in HOBOnode Viewer with a list of
all files delivered through that service as shown below. Click a file name to open
or save the file.

09/27¢/10 12:40:25 PM
09/27/1
aaf2741

08/27/10 12

09/2741

i & & 3
3 T 9

09/27¢1

cuse_Zone A _2010_0%_27_12_10_34.xls oafaviL

- . - - F27/10
cuge_Fone_A 2010 09 27 12 05 Jd.xls o8
jze_Zone_A_20L0_09_27_12 D0_24.xls 08/a7iL

P @ Do
-

09/27¢1

ouse Zone & 2010 05 27 11 55 J4.xls

0972741
09727410
08/27/1

09/27/1

deEfddgsrdgaada:d

Note: If you change the file directory location in the data delivery settings, then you
must restart HOBOnode Manager before you can access the files from the Data tab in
HOBOnode Viewer.

Any changes you make to your network with HOBOnode Manager will be reflected in

the HOBOnode Viewer upon the next refresh, or update. HOBOnode Viewer refreshes

every 30 seconds. You can also use your browser’s refresh feature if you want to see a
change immediately.

Important: HOBOnode Viewer is only available while HOBOnode Manager is running.
If you close HOBOnode Manager and then attempt to access HOBOnode Viewer, the
web page will not open. Always keep HOBOnode Manager running to ensure anyone
accessing HOBOnode Viewer can see the real-time plots and data.
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Installing Batteries

1. Twist the battery cover on the back of the data node counterclockwise to
remove.

2. Insert 3 AAA batteries.

3. Replace the cover, aligning the threaded hole on the cover (a) just above the hole
on the case (b).

4. Twist cover clockwise to secure. The mounting holes should be at the top and
bottom of the case and the threaded screw hole should be aligned with the hole
in the case.
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Moving or Removing a Data Node

Deactivating a Data Node

If you will not be using a data node for an extended period of time you may want to
deactivate it to stop measurements and save batteries.

To deactivate a data node, use a paper clip to press the Activate button for 5 seconds
until the red LED starts flashing.

To later reactivate the data node, select Form Network from HOBOnode Manager and
briefly depress the Activate button on the node.

Removing a Data Node from HOBOnode Manager

If you do not want a data node to appear in HOBOnode Manager, double-click the
device row in the Device Table and then click Remove Node in the Configure Node
window.

Moving a Node

If you move a data node to a new location, make sure the green LED is still blinking
once per 10 seconds to indicate that the node still has a connection to the receiver. If
the red LED is blinking, indicating that the connection path is broken, try adjusting the
orientation of the data node or moving it closer to the receiver to minimize
obstructions. You may need to add a ZW-ROUTER to re-establish a connection.

If moving a data node changes the primary power source, see the following:
Switching from AC Power to Battery Power (page 337)
Switching from Battery Power to AC Power (page 338)
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Switching from AC Power to Battery
Power

If you initially power up a node using AC power, but then cannot provide AC power at
deployment, you must follow this procedure.

1.

© N s W N

Deactivate the data node by pressing the activation button for 5 seconds until the
red LED starts flashing repeatedly.

Disconnect the data node from AC power.

If batteries are installed, remove them.

Wait at least 30 seconds to clear the memory.

Re-install the batteries.

Click Form Network in HOBOnode Manager.

Reactivate the data node by briefly tapping the Activate button.

Verify that the data node appears in the HOBOnode Manager table and is
identified as a Node (no routing capabilities). See Determining Data Node Type
on page 343.
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Switching from Battery Power to
AC Power

If you initially powered a data node using batteries, but are switching it to AC Power,
you must perform the following steps so that HOBOnode Manager recognizes the data
node as having routing capabilities.

1.

@ N oA W N

Deactivate the data node by pressing the activation button for 5 seconds until the
red LED starts flashing repeatedly.

Remove the batteries from the data node.

Wait at least 30 seconds to clear the memory.

Plug the data node into an AC power outlet.

Re-install the batteries.

Click Form Network in HOBOnode Manager.

Reactivate the data node by briefly tapping the Activate button.

Verify that the data node appears in the HOBOnode Manager table and is
identified as a router. See Determining Data Node Type on page 343.
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Changing Logging and Connection
Intervals

There are two types of intervals associated with data nodes:

o the logging interval, which is how often the node records data; and

e the connection interval, which is how often the node transmits data to the
receiver.

When a data node joins a network, it uses the default logging and connection intervals
that are set within the general preferences (upon installation of the software, the
default logging interval is 1 minute and the default connection interval is 10 minutes).
However, you can also define logging and connection intervals on a per-node basis,
which gives you the flexibility of having data nodes logging and transmitting data at
different rates.

Changing Default Values in Preferences

To change the default logging and connection intervals, click the Actions button in
HOBOnode Manager and select Edit HOBO Data Node Preferences. Or, within
HOBOware, select File > Preferences on Windows or HOBOware > Preferences on
Macintosh and click Data Nodes.. The default logging and connection intervals are
under the General category of the data node preferences.

Select a preset value or set a custom interval. The minimum logging interval is 1
minute, and the minimum connection interval is 2 minutes.

¥  General

Presets Custom

Default Logging Interval: (3) |1 Minute v | ()

Default Connection Interval: (3) |10 Minutes v | ()

These default values will only be used for new data nodes that join the network.
Changes to these default intervals will not affect data nodes that are already logging or
that have been previously configured with their own individual logging or connection
interval.

Changing Intervals for Individual Data Nodes
To change the logging and connection intervals on an individual data node:

1. Double-click the data node entry in the Device Table to open the Configure
Device window.
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Configure Node

%)

Serial Mumber: 2424015
Firrmwate Version; 44

Device Tvpe:  ZW-006 (Mode/Rouker)

Label: |'-.-'-.-'arehu:-use Zone A |

Presets Custom

Logging Interval: Q}|1Minute 1"~f"| C‘| | | | | |

Zonnection Interval: l@}|2 Minuktes V| 'C}| | | | | |

Crefault l2gging and connection intervals can be sat in Preferences

(=) (]

2. Change the logging interval and connection interval as required.

3. Click OK.

The changes will take effect the next time the data node connects to the receiver; they
will only apply to that particular data node and its sensors. All other data nodes in the
network will continue logging and connecting at their current intervals.
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Changing External Sensor Type

Many types of HOBO data nodes can be configured with external sensors. One of the
benefits of using external sensors is that you can swap them out when necessary for
different ones if you want to modify your wireless network. Or, you can disable the
external sensor channel if you don't need it for your current network deployment.

To change the type of external sensor associated with a data node:

1. Double-click the external sensor you wish to change in the HOBOnode Manager
device table.

2. Select the sensor from the Sensor Type drop-down list.

Configure Sensor, E

Pork Type:  Analog (A1)
Serial Mumber: 2431949-3
Firmware Yersion: 44
Device Type:  ZW-005 (Mode)

Sensor Types |« TMCE-H, Airfwater)Soil Temp Sensor A
o TMCx-Hi, airfw'ater/Soil Temp Sensor A
CTw-A, 0 - 20 Amp split-core AC current sensor

CTW-B, 0 - 50 Amp split-core AC current sensar

CTW-1C, 0 - 100 Amp split-core 8C current sensor

CTw-D, 0 - 200 Amp split-core 8C current sensor

CTW-E, 0 - 600 Amp split-core &C current sensor

L. CABLE-4-20mé, 4-20 mé cable

Logging Interval: || g £ ADAPS, Yoltage Divider Cable v

Label:

Connection Interval: (&) |10 Minutes s | ()

Changing the intervals applies to all sensors on this nods

Drefault logging and connection intervals can be sat in Preferences

Cancel ] [ 0K l

3. Make any other changes as necessary and click OK.

Note: While the HOBOnode Manager device table will display the change to the sensor
type immediately, data for the new sensor will not display until the next connection
interval .

To deselect, or turn off, an external sensor:

1. Double-click the external sensor you wish to change in the HOBOnode Manager
device table.
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2. Scroll to the end of the Sensor Type drop-down list and select <No sensor
attached>.

Configure Sensor §|

Port Type:  Analog {al)
Serial Murmber:  2431949-3
Firmware Mersion: 44
Device Type:  ZW-005 (Mode)

Sensor Type: |« TMCE-H, AirfWater) 3ol Temp Sensor L
TEL-7001, Telaire 7001 COZ Sensar L
T-YER-G044-100, YWeris 430, 100 Amp Kilowatt Trans., .,
T-A3H-G2-100, Ashcraft Gauge Pressure Sensor 100 psig
T-A35H-G2-200, Ashcraft Gauge Pressure Sensor 200 psig
T-A3H-G2-500, Ashcraft Gauge Pressure Sensor S00 psig
T-CDI-5200-1035, Compressed Air Flow Sensor
T-CDI-5400-203, Compressed Air Flow Sensor

Mo sensor attached=

Label:

Logging Interwval;

Connection Interval: (&) |10 Minutes s | ()

Changing the intervals applies to all sensors on this nods

Drefault logging and connection intervals can be sat in Preferences

Cancel ] [ 0K l

3. Make any other changes as necessary and click OK.

The HOBOnode Manager device table will then change the status for that external
sensor to OFF as shown below. Any plots and alarms associated with that sensor will
also be removed from HOBOnode Manager.

Type =114 Status
@ ZW-FCWR. 2A723TE COMMECTED
I 2-005 2431949 ACTIVE

——&d CABLE-TEMP/RH (Temp) 2431949-1 ACTIVE
——&d CABLE-TEMP/RH(RH)  2431949-2 LCTIVE
=@l =Select Analog Sensor = 2431949-3 OFF

Shortcut: In the device table, click the checkbox next to the external sensor, then click
the Sensor Type button and select the sensor from the list. This can be done for many
sensors at once by selecting more than one sensor at a time in the device table.

For details on setting up a HOBO data node with an external sensor for the first time,
see Selecting External Sensor Type.

- 342 -



HOBOware User’s Guide

Determining Data Node Type

There are four types of devices displayed within HOBOnode Manager: data receiver,
data node, data node/router, and router. Use the icons in the device table to identify
data node types. This is particularly helpful if you need to verify whether a device is
acting as a data node only or if it also has routing abilities (a data node can only
function as a router when it is plugged into an outlet with an AC adapter).

Receiver
Mode

ModeRouter ——

Type S Skatus
@' ZW-RCVR 2372376 ZOMMECTED
I 2w-005 2431949 BICTIVE
——&d CABLE-TEMP/RH (Temp) 2431949-1 ACTIVE
& CABLE-TEMP/RH (RH)  2431949-2 BICTIVE
=@l <5elect Analog Sensor= 2431949-3 OFF
=/~ <Seleck Pulse Sensor>  2431949-4 OFF
ket 2006 2424015 ACTIVE
= TMZx-H= 2424015-1 BICTIVE
—ad TMZ=-H= 2424015-2 ACTIVE

For another way to see whether the device is a data node only or a data node/router,
double-click the device to open the Configure Node dialog. Check the Device Type for
the device part number and description. In the example below, the device is operating
as a both a data node and a router so the Device Type is listed as "ZW-006
(Node/Router)." If this device was powered by batteries only, then it would be
operating as a data node and not a router, and listed as "ZW-006 (Node)."

Configure Node
Serial Mumber:
Firrnware Yersion:
Device Type:

Label:

Logging Inkerval:

Connection Interval;

2424015
44
Zi-006 {Mode/Router)

Warehouse Zone &

Presets Custom
@ [1Mnute | (O
) [2Minutes | ()

[refault logging and connection intervals can be set in Preferences

%]

Cancel ]

Lo |
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Database Backup and Restore

Onset recommends that you periodically back up your database to secure your data in
case of a database failure. You can back up your database to an external hard drive or
network server using third-party backup software.

If you should ever need to restore your database, simply replace the primary database
with the backup.

The database is stored at the following location:
e Windows 7.0 and Vista
c:\Users\<user name>\AppData\Local\OnsetComputerCorporation\cosmos\db
e Windows XP

c:\Documents and Settings\<user name>\Application
Data\\Local\OnsetComputerCorporation\cosmos\db

e Mac0S10.5and 10.6

/Users/<user name>/Documents/OnsetComputerCorporation/cosmos/db

To rename the database, modify the name of the db folder by adding the deployment
location or the date (example: "db-11-10"). Note: HOBOnode Manager will be empty
after renaming the database. You will need to form a new network.
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Creating a New Deployment

The first time you form a HOBO data node wireless network, the initial deployment, or
network configuration, is created automatically for you. This first deployment can
continue indefinitely. However, you also have the option to create a new deployment if
you need to move your current network to a new location or if you'd like to configure a
different set of sensors in a new network, for example. This allows you to more easily
distinguish between two separate networks or deployments of nodes when they are
plotted or exported from HOBOware.

You have the option of either creating a new deployment that is an exact copy of the
previous one (all devices, alarms, and settings will be copied as currently configured)
or consists of a new network (only system alarms and alarm logs are copied).

Note: Creating a new deployment does not create a new database. All data recorded in
the previous deployment is saved and can be accessed through Plot/Export Data.

To create a new deployment:

1. Click the Actions button in HOBOnode Manager and select Create New
Deployment.

Actions W | | L PlotfExport Data

[ Print Device Table. ..

t02 Edit HOBD Data Mode Preferences. ..

-I- Create Mew Deplovment. ..

2. Type a name for the new deployment. Select the Copy the current network to
the new deployment checkbox if you want to use the current deployment as the
basis for the new deployment (HOBOnode Manager will automatically be filled in
with your current network devices, alarms, and settings). If you do not copy the
current network, then you will need to form a new network (only system alarms
and alarm logs will appear in HOBOnode Manager). Click OK.

r

Create New Deployment

Copy the current netwaork o the new deployment

*Mame: |‘Warehouse Building B

*Denotes required fields Cancel ] [ als

3. A message appears indicating that the current network deployment will end and
a new deployment will be started. Click Yes to continue, or click No to return to
the Create New Deployment dialog.

4. From the Device menu in HOBOware, select Manage HOBO Data Node
Network to restart HOBOnode Manager.
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5. Ifyou chose to copy the current network to the new deployment, then
HOBOnode Manager opens with all devices listed. Plots will begin displaying the
new network data at the next scheduled connection interval. If you did not copy
the old network, then you will be prompted to form a new network.

Both the newly created deployment and the previous deployment are listed in the
Plot/Export Wireless Data window. Click the Plot/Export button in HOBOnode
Manager to see the deployment list as shown in the example below.

Stepl: Deployments, select deployments whose data you want to plot/export

5
Depl # Label Start time End time

z ‘Warehouse Building B 09/ 28/10 0%:54:09 AM 09/26/10 10:23:47 AM

1 First Deplayment 09/17/10 02:54:30 PM 09/28/10 0%:54:09 AM

Deployments are listed from newest to oldest. The initial deployment is labeled "First
Deployment” by default. Any subsequent deployments are listed with the name you
entered in the Create New Deployment dialog.

The start time for the current deployment (the deployment at the top of the list) is the
time the new deployment was created, which is also the end time for the previous
deployment on the list. The end time for the current deployment is the current time.
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Troubleshooting

General Network Connection Issues

If you are having problems connecting data nodes to the receiver, or they are losing a
connection after they have been joined to the network, you may be experiencing issues
with a conflicting wireless device. To reset the radio channel, double-click the receiver
row in the Device Table and in the Configure Receiver window click the Reset button.

Receiver Will Not Connect to HOBOnode Manager

Make sure the USB plug is secure on both ends. Try unplugging and plugging the
receiver back in.

Data Node Cannot Join Network

Positioning: If you are having trouble getting a data node to join the network, try
repositioning the node within the space. Move the data node away from any obstacles
(such as metal walls, stairwells, elevator shafts) that may exist between it and the
receiver.

Distance: The data node may be too far from the receiver to obtain a signal. Try moving
the data node closer to the receiver, or add a router or router/node between the data
node and the receiver.

Make sure the receiver is in Form Network mode (RED and GREEN LEDs alternating)

Make sure you have pressed the button on the bottom of the node and that the RED and
GREEN LEDs are alternating. Try pressing the button again.

Debugging

There are a number of debugging and logging options in HOBOnode Manager. If you are
working with Onset Technical Support on an issue, you may be asked to enable
debugging options and send a log file to Onset.

No readings for a sensor

For external sensors, make sure the connection to the data node is secure and that you
have assigned a Sensor Type (does not apply to the External Temp/RH Sensor).

No Plot Appears for a Sensor

Make sure you have checked the Plot box in the Device Table for the sensor.
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Extreme Sensor Readings

If you are seeing extreme sensor readings, make sure that the sensor cable is securely
plugged into the node.

Alarms

If an alarm you configured is not appearing in the Alarms window, make sure the filter
is set to Show all.

Security Connection Messages on Macintosh

If the firewall setting is enabled in the security system preferences on a Macintosh, you
may encounter a security warning message every time you open HOBOnode Manager.
To turn off this message, go to System Preferences, select Security, and turn off the
firewall. Note: Keeping the firewall turned on and adjusting the advanced settings to
allow all incoming connections for HOBOware does not resolve the problem.

Firewall Messages on Windows

Windows Firewall must allow access to HOBOware.exe for HOBOnode Viewer to run
properly. To allow HOBOware access, open Control Panel, go to Security, and select
Allow a program through Windows Firewall (or click Windows Firewall and click the
Exceptions tab on some versions of Windows). Make sure HOBOware is selected in the
allowed access/exceptions list.

Changing Locale

The language in use at the time the original HOBO data node network database was
created is the only language that can be used for that database. You cannot switch to
another language. If you need to change the locale on the computer that contains your
HOBO data node network database, you will need to:

1. Back up and then move or rename the database.
2. Change the locale on the computer.

3. Form a new network to create a database that operates in the new locale.

- 348 -



HOBOware User’s Guide

HOBONnode Manager General
Preferences

Use the HOBOnode Manager General Preferences to change the default behavior of
HOBOnode Manager.

You can access the HOBOnode Manager Preferences the following ways:

In HOBOware, select File > Preferences > on Windows or HOBOware >
Preferences on Macintosh and click Data Nodes.

At the bottom of the HOBOnode Manager window, click the Actions button and
select Edit HOBO Data Node Preferences.

¥ General

Timeout when Forming network:

Presets Custom

Default Logging Interval: (&) |1 Minuke % | (O
Default Connection Interval:  (3) |10 Minutes w | ()
® O

Mo Timeout

A node is MISSING when it is late by:  (3) |10 Minutes ~ | ()

‘when the HOBOnode Manager is closed, keep device communication running

[] start the HOBECnode Manager and device communication automatically when HOBOware starts

Highlight row in table when clicking on a sensor plot or node in the map

Show inFarmational popups in the device table when new nodes are added

Default Logging Interval - This is how often data nodes will log data.

Default Connection Interval - This is how often data nodes will send data to the
Device Communication component, which will send the data to the receiver.

Timeout When Forming Network - This is the amount of time that you can add a
data node to the network after you click the Form Network button. By default,
Form Network mode will remain active until you click the X on the Form
Network progress indicator.

A node is MISSING when it is late by - This is how long a node must go without
sending data to HOBOnode Manager for it to be marked as missing. When a data
node is missing its status in the Device Table will be MISSING, and a

MISSING NODE alarm will be tripped (if configured).

Enable/Disable

Check or uncheck the boxes to enable or disable the action.

When the HOBOnode Manager is closed, keep device communication running

Start the HOBOnode Manager and device communication automatically when
HOBOware starts.

Highlight row in table when clicking on a sensor or data node in the map.
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Setting Preferences for Real-Time
Plots

You can customize the plots that appear in HOBOnode Manager by increasing the
number of sensors you can plot at one time, adding the ability to view monthly data,
displaying alarm thresholds, and more.

To access the preferences for real-time plots within HOBOnode Manager, click the
Actions button and select Edit HOBO Data Node Preferences. To access them from
HOBOware, select File > Preferences on Windows or HOBOware > Preferences on
Macintosh and click Data Nodes.

These preferences are specific to real-time plots only. See Plotting Preferences for
details on how to change general plot appearance, such as changing font type and size,
adding gridlines, or modifying axis details.

¥ Real-Time Plots

Maximum number of sensors bo plok| 20 3
Enable MOMTH wisw in real-time plots &

Maximum number of days of observations ko plat| 7 5

Show alarm thresholds on real-time sensor ploks &

(%) Show alarm threshold as line

() Show alarm threshold as inkeryval

Maximum number of sensors to plot: Select how many data node sensors you want
to be able to plot at one time within HOBOnode Manager. You can select from 1 sensor
to 100, with a default of 20.

Enable MONTH view in real-time plots: Select this checkbox to add a Month button
to the Plots tab in HOBOnode Manager. You can then plot data by hour (4 hours), day,
week, or month. The Month view is disabled by default.

131 HOBOnode Ma nager

Plats | Map | Alarms

Sensor Measurement | qHr Day |Week

Maximum number of days of observations to plot: Select how many days worth of
data you want to view in the plot, up to 31. The default is 7 days.

Maonth |

Show Alarms on real-time sensor plots: Select this checkbox to add a visual
indicator, or reference point, when a sensor alarm has tripped.

e Select Show Alarm reference point as line to display the alarm threshold on
the real time plots as a horizontal line. An example of this type of reference point
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is the red line in the following plot where an alarm was configured to trip at
above 95 degrees Fahrenheit.

Floor 1B
110.00 |
100.00 |
80.00
B0.00 1
oo T T T e T T T
11:3000  12:00:00  12:30:00 01:00:00 01:30:00 02:00:00 02:30:00  03:00:00
07/22/10 12:00:00 PM EOT 07/22/10 02:00:00 PM EOT
Select Show Alarm reference point as interval to display the alarm threshold
as a shaded area: red when the alarm is above the specified threshold and blue
when it is below. Using the same example, there is a red shaded area from above
95 degrees on the following plot instead of a single red line.
Flaar 1B
110.00
100.00 -
90.00
B0.00

1 I 1 1 1 I 1 1 1 I 1 1 1 I 1 1 1 I 1 1 1 I 1 1 1 I 1 1 1 I 1 1
11:30:00 12:I:III:I 00 12:30:00  O1:00:0 01:30:00 I]E:[I!]:I]I:I 02:30:00  03:00:0
07/22/10 12:00:00 PM EDT 0722710 02:00:00 Pn EDT
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The

Device Table

This topic describes the columns in the Device Table, located at the bottom of the
HOBOnode Manager window.

10.
11.

12.

13.
14.

€0 $97999 7 999

i TR SR AL P 3 ==
- Te-INT-THF] HRE ] Tempaesbae 74954 %7 COT10 3L | oD P Bary &, Semp - -

- TESNT A AR AL Lyl 0T e Lol L ETHER T L =H
= I OFF .

—_ AIRTA OFF

Select - Select devices you want to apply an action to. After you select a device or
devices, click Action and select the desired action, such as assigning groups, or
configuration.

Label - This is a name you assign to a node or sensor. To enter a label, double-
click the cell and type in the label.

Type - This column is automatically populated with the device type.
S/N - The Serial Number of the device.
Status - This column indicates the status of the device.

Active - Device is communicating with the receiver.

Missing - Node has not reported to the receiver within the Missing threshold.
Meas. Type - The Measurement Type of the sensor.

Reading - The latest reading from the sensor.

Time - The time the latest reading was taken.

Plot - Check the box for the device to have the device readings appear in the real-
time plots.

Group(s) - The group(s) you have assigned this sensor too.

Map - Check the box for the device to place the device on the Network Map. Drag
the icon the desired location on the map and click the mouse button.

Alarms - Icons appear in the Alarms column indicating the alarm status for the
device.

Signal - Indicates the signal strength for the device.

Battery Strength
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LED Pattern > Indication

Refer to this table to interpret an LED pattern on a device.

LED Pattern

Indication

Green blinks every 5 seconds

Data node is on the network

Red blinks every 5 seconds

Data node is off the network

Alternating Red and Green

Device is in Form Network mode or is
joining the network

Alternating Red and Green twice,
then blink Red continuously

Data node cannot find network

Alternate Red and Green for 2
minutes, then blink Red continuously

Data node could not join network because
the receiver is out of range, or there is
interference.

Green blinks rapidly 10 times, then
Red blinks rapidly 10 times, then both
stay OFF.

You pressed the button to add the data
node to the network, but the node did not
enter Join Network mode. Try pressing the
button again.

RED and GREEN blink simultaneously
for 5 seconds, then RED for 5 seconds,
then both blink once, then both go
OFF

Powering a data node using a wall outlet.
NOTE: If you unplug the node and then plug
it back in within 30 seconds, there will be
no LED indication.

GREEN blinks for 5 seconds, then RED
blinks for 5 seconds, then both go OFF

Powering a data node using batteries only

Random

Dead Battery

Red and Green at the same time twice

Transmitting Data

Action > LED Pattern

Use this table to verify actions that you are performing.
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Action LED Pattern
Powering a data node Red and Green simultaneously for 5 seconds, then Red for
using a wall outlet 5 seconds, then Green once, then OFF

Powering a data node

. X Green for 5 seconds, then Red for 5 seconds, then OFF
using batteries only

Receiver: Alternating Red and Green continuously

Router or Router/Node: Alternating Red and Green
continuously, then blink Green twice, then resume

Forming a network .
& alternating.

Node: Alternating Red and Green continuously, then
Green every 5 seconds.

Removing a data node Red 10 times, then Red and Green on for several seconds,
from the network then off

Device Status

Use this table to determine what status a device is in.

Status LED Pattern
Data node is ACTIVE Green every 5 seconds
Data node is off the network Red every 5 seconds
Data node is transmitting data Red and Green twice simultaneously
Data node is in Form Network mode Alternating Red and Green continuously
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Index

2 C
21 CFR Part 11 Conformance, 145 Channels, 184
Channels to Log
A Series Loggers, 51

Alarm Notifications Station Loggers, 47

HOBOnodes, 286

Alarms

Checking logger status, 63, 185
Clock, 169

for Temp,/Alarm logger, 61 Communication preferences, 207, 216

HOBOnodes, 273
Alarms Dialog, 59

Configure Channel Dialog, 158
Connecting

Alarms, configuring, 58 Base Station, 33

Analog Module/Port
Configuring, 156

Coupler, 33
Multiple Devices, 35

Awaiting Button/Coupler Start (Device Connecting a USB device, 32

Details), 64 Connecting Devices, 31
Awaiting Delayed Start (Device Details), Connecting Serial Devices, 34
65

Connection Interval, 339
Axis Properties, setting, 85 Copy a series, 144

B Copying Points Data, 140
Copyright, 2

Barometric Compensation Assistant, 109 Corrupted header, 53

Base station, connecting, 33 Coupler, connecting, 33

Battery Crosshair tool, 201
Excitation Power, 159 Current Status (Device Details), 64
Battery Level Custom Units, 161
Device Details, 64
Blink device light, 35 D
Box Car, use default settings, 212 Data Assistants, 109
BoxCar Format Using, 110

Exporting Data in, 139 Data Delivery, 328

Button start, 46 Data Types, 72
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Data verification, 73
Date format, 135
Date/Time, 224
Deleting, a series, 108
Deployment, new, 345
Details pane, 18, 93
Device Speeds, 216
Disconnecting a Device, 32
Disconnecting a logger, 34
DSEC files, 145

Security Mode Issues, 147

E-mail, 2

Help menu; Submit Technical Support,
198

Events, internal logger events, 72
Excitation Power, 159
Configuring, 162
Excitation, and Battery Life, 162
Export
Settings, 212
Export Details Pane, 141
Export Options window, 137
Export Points, 137
Exporting
BoxCar Format, 139
Exporting Data, HOBOnodes, 317

F

Fast Logging Intervals, 39
Features, Advanced HOBOware Pro, 12
Files
Opening, 73
Filter

a series, 103
Filtering, 176
FlexSmart modules, 184
Load Configuration, 165
FlexSmart Modules
Configure Channel, 158
Font, size in plots, 218
Formatting, 135

G

General preferences, 207
Grains per Pound Assistant, 109
Graph
Overview, 16
Gridlines, 220
Growing Degree Days Assistant, 109

H

Hand Tool, 205

HOBO files, 73

HOBOnode Viewer, 272

HPRO] files, 73

HSEC files, 73

HSEC files, Security Mode Issues, 147

I

Import text files, 131
Requirements, 133

Installing, HOBOware Pro, 23

Intervals, multiple logging, 38

K

kWh Assistant, 109
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Setting Properties, 89
Launch
Shuttle, 171
Time-Saving Options, 40
Launch Options, 49
Launch Parameters, 44
Launch Window
Station Loggers, 42, 177
U-Series Loggers, 48, 179
Launching
Overview, 36
Legend, 17
Light (LED), 46
Linear scaling, 55
Linear Scaling Assistant, 109
Load Configuration Dialog, 165
Location, 184
Location, hiding sensor location, 95
Lock axis scaling, 86
Logger status, 63, 185
Logging Duration, 43, 48,178, 179
Logging Interval, 339
Logging Intervals
Fast, 39
Logging intervals, multiple, 38
Low Battery Alarm, 284

M

Mailing Address, 2

Map, 310

Mabp, configuring, 310

Memory Used, Device Details, 64
Monitoring - HOBOnodes, 236
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Multiple loggers, repeating action on, 54

Multiple logging intervals, 38

N

Network Map
Adding a Node to, 309
Customizing Image, 314
Upload Image, 313

Network Map, configuring, 310

0

Opening Data Files, 73

Order, changing series order, 95

Padlock icon, 145
Panning, 91, 205

Paste, points data into another
application, 140

Pasting a Series, 144

Phone Number, 2

Plot Setup Dialog, 22, 183

Plot, setting up, 71

Plotting Data, HOBOnodes, 317

Points Data, copying data into another
application, 140

Points Table, 20
Points, exporting as Excel text, 137
Preferences, 207

Communication, 216

Preferences, HOBOnode Manager, 349,
350

Printing a Graph, 93
Pulse Scaling Assistant, 109
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R Shuttles

Deleting Files, 175
Signal Level, 66
Signed files, 73, 145

Raw, scaling parameters, 160

Read Header Failed message, 53

Readout
Time-Saving Options, 69 Smart scaling, 91
Real-time plots, 240 Startup Preferences, 211
Relay, controlling on HOBO U30 Station, Statistical Analysis, 176
150 Statistics, viewing subset statistics, 97
Restore preferences, 207 Status
Routing - Enable HOBOnode with, 338 Device, 62
RSSI (Signal Level), 66 Status Window, 63, 185
Subset statistics, 97
S System Alarms
Sampling Interval, 43, 178 HOBOnodes, 282, 284
Scaled, units, 160
Scaling, 55, 86 T
HOBOnodes, 187, 291 Task, Basic, 29
setting parameters, 160 Text files
Screen Refresh Interval, 66 Export Details to, 141
Secure files, 73 Importing Requirements, 133
Secure mode, 145, 147 Text files, exporting points as, 137
Sensor Alarms Text files, importing, 131
Adding for HOBOnodes, 277 Tick marks, 85
Sensor location, 184 Tilt Meters, 66
Sensor location, hiding, 95 Time, 135,170
Sensor Readings, 66 Time Format, in Excel, 135
Serial Port Setting, 34 Toolbar, 199
Serial ports, 216 Trademark, 2
Setup Assistant (HOBOware Pro), 25 Trigger start, 46, 50
Shuttle with Fast Logging Interval, 39
Launching, 171
Offloading Files, 172 U
Saving Files, 173 U30 Station, working with, 148
Working with, 168 Undo & Redo, 92
Shuttle Management Dialog, 169 Units, 224
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Converting, 96 Waterproof shuttle
Upgrading, to HOBOware Pro, 24 Deleting Files, 175
USB WattNode Scaling Factors
Connecting a USB Device, 32 Energy, 293
U-Series Loggers Web Site, 2
Launch Window, 48, 179 Wrap Around When Full (Device Details),
U-Shuttle 64
Deleting Files, 175 Wrap Count, Device Details, 64

U-Shuttle, Firmware updates, 168

w Zooming, 91, 203

Warnings, Preferences, 226
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